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Description
This manual is issued for reference only, at the convenience of Arbiter Systems. Reasonable
effort was made to verify that all contents were accurate as of the time of publication. Check
with Arbiter Systems at the address below for any revisions made since the original date
of publication.

Contact Information

Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446
(805) 237-3831
Website: www.arbiter.com
mailto:techsupport@arbiter.com
mailto:sales@arbiter.com

What This Manual Covers
This manual describes the set up and operation of the Model 1133A Power Sentinel.

ROM Dates
This version of the manual is written a Power Sentinel having a ROM date of 07 Sep-

tember 2006 or later. Any changes made in subsequent revisions which affect operation or
specifications will be noted with either (a) a new manual or (b) a revised version of this
manual. To display the ROM date for your instrument, press and hold down the STATUS
key after power-on for three seconds; a second set of menus will be available. The ROM
date (software version) will be displayed.

Firmware Updates
Firmware updates are available to customers by download from the Arbiter web site.

Where applicable, this update may include new documentation, such as a new version of
this manual.

For the latest firmware, see <http://www.arbiter.com/pscsv/index.php>.
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LIMITED WARRANTY
Arbiter Systems makes no warranty, expressed or implied, on any product manufactured

or sold by Arbiter Systems except for the following limited warranty against defects in
materials and workmanship on products manufactured by Arbiter Systems.
Products manufactured by Arbiter Systems are guaranteed against defective materials and
workmanship under normal use and service from the date of delivery for the period listed
below. The responsibility of Arbiter Systems under this warranty is limited to repair or
replacement, at Arbiter Systems’ option, of any product found to be defective. Arbiter
Systems shall have no liability under this warranty unless it receives written notice of any
claimed defect, within two years.

For warranty service or repair, products must be returned to a service facility designated
by Arbiter Systems. Buyer shall prepay all shipping charges to Arbiter Systems, and
Arbiter Systems shall pay shipping charges incurred in returning the product to Buyer.
However, Buyer shall pay all shipping charges, duties and taxes for products returned to
Buyer in a country other than the United States of America.

THE WARRANTY SET FORTH HEREIN CONSTITUTES THE ONLY WARRANTY
OBLIGATIONS OF ARBITER SYSTEMS, EXPRESSED OR IMPLIED, STATUTORY,
BY OPERATION OF LAW, OR OTHERWISE. ARBITER SYSTEMS DISCLAIMS ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PUR-
POSE, AND BUYER EXPRESSLY WAIVES ALL OTHER WARRANTIES.

This limited warranty does not extend to any product, which has been subject to

1. Improper use or application, abuse, or operation beyond its rated capacity, or con-
trary to the instructions in the operation and maintenance manuals (if any);

2. Accident;

3. Repair or maintenance performed by Buyer, except in accordance with the operation
and maintenance manuals, if any, and any special instructions of Arbiter Systems;

4. Modification without the prior written authorization of Arbiter Systems (whether by
the substitution of non-approved parts or otherwise). The remedies provided herein
are Buyer’s sole and exclusive remedies. In no event shall Arbiter Systems be liable
for direct, indirect, incidental or consequential damages (including loss of profits),
whether based on contract, tort, or other legal theory.
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FOR THE FASTEST POSSIBLE SERVICE, PLEASE PROCEED AS
FOLLOWS:

1. Notify Arbiter Systems, Inc., specifying the instrument model number and serial
number and giving full details of the difficulty. Service data or instrument-return
authorization will be provided upon receipt of this information.

2. If instrument return is authorized, forward prepaid to the manufacturer. If it is
determined that the instrument is not covered by this warranty, an estimate will be
made before the repair work begins, if requested.

See Contact Information on page ii.
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Chapter 1

Unpacking the 1133A

1.1 Introduction

This section will assist you with unpacking the 1133A from its shipping container; other
parts and accessories shipped with the 1133A include:

� 1133A Power Sentinel (includes internal power supply)
� Antenna Cable, 50 feet with connectors (N/A with Option 07)
� GPS Antenna (N/A with Option 07)
� Rack-Mount Ears, 2 ea.
� Instrument Manual
� Connector–1 ea., four-terminal for input voltage
� Connector–1 ea., six-terminal for input current
� Connectors–4 ea., three-terminal for contact outputs
� Connectors–5 ea., two-terminal for event inputs and IRIG-B output

1.2 Precautions

Mechanical Shock Note that the GPS antenna is small and smooth, and can be damaged
if dropped. Use care when handling. Remember to store the antenna in a safe place before
the final installation.

Static Discharge Note that the Model 1133A is an electronic device and uses static-
sensitive components in its operation. Use care when handling against static discharges.
Generally, these components are protected in their normal situation, however they are
accessible when the cover is removed.

CAUTION Timing Input Connector (GPS or IRIG-B) - Connect only the cable coming
from the timing source. The timing–input connector leads to static–sensitive components,
which could be damaged from high voltage or a static discharge.
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1.3 Unpacking and Locating Accessories

The Model 1133A and included accessories are packed between two closed-cell foam shells.
Carefully pull apart the two shells to extract the 1133A and accessories. Some of the acces-
sories (i.e. antenna and rack-mount ears) are located in one of these shells for protection.
In the diagram below, you can see how the GPS antenna and rack-mount ears are located
in the closed-cell foam marked with the label that reads,

ADDITIONAL PARTS INSIDE

Figure 1.1: Packaging of Accessories

Antenna cable, 1133A and setup guide are located between the two pieces of closed-cell
foam. The rack-mount ears and antenna are embedded in the packing foam side labeled
ADDITIONAL PARTS INSIDE.

1.4 Attaching Rack-Mount Ears to 1133A

Each Model 1133A comes with two rack-mount ears suitable for mounting in a 19-inch
system rack. These ears have four mounting holes, two of which are used to attach them
to the sides of the 1133A. Since it is required to remove the M25 screws which attach the
cover to the chassis, it may be good to attach the ears after first making any configuration
inside the 1133A. You will want to return to this section after making these changes.
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1.4.1 Mounting Instructions

1. Using a Torx T25 driver or large slot screwdriver, remove the four M25 screws at-
taching the 1133A cover to the chassis. Use either a T-25 or large slot screwdriver.

2. With the ear facing out from the front panel (see Figure 1.2), match the lower set of
holes of the ear to the cover/chassis and remount the M25 screws.

3. Repeat this procedure with the other side of the chassis and other ear.

Figure 1.2: Attaching Rack-Mount Ears

NOTE: Before installing the rack-mount ears, you might want to determine if you need
to configure anything inside the 1133A (e.g. Event Inputs). To install the rack-mount ears
requires removal of the top cover, which would be a good time to make any changes. See
Chapter 14, Event Input Voltage Settings, for information on making changes to any of
the Event Input modules.



4 Unpacking the 1133A



Chapter 2

Front and Rear Panels

2.1 Introduction

This section identifies the connectors, controls, and displays found on the front and rear
panels of the Model 1133A. Take care to review all of these items prior to connecting cables
to and configuring the Model 1133A.

2.2 Front Panel Controls and Indicators

The Model 1133A front panel has a two-line by 20-character, back lit Liquid Crystal Dis-
play (LCD), four annunciator LED’s, and an eight-button keypad. All of the keys are
informational only and cannot be used for configuration. In the figure below are illustrated
the displays and controls used to determine and configure the operating state of the 1133A.

Figure 2.1: Model 1133A Front Panel Description

Brief definitions for the annunciator LEDs are found in Table 2.1, and definitions for
keys in Table 2.2. Accept for the STATUS key on the upper-right position, all of the
keys switch the display to read the named electrical parameter(s). For example, press
VOLTAGE/CURRENT to view all configured voltages and currents, including sequence
components. The Status key is used to view all of the main 1133A system details, like
Receiver Status, Time and Date.
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2.2.1 Annunciator LED Definitions

The four Annunciator LED’s provide a quick reference to the Model 1133A operating
status. These LED’s should give you a basic idea if the 1133A is operating correctly.

Annunciator LED Color Purpose

OPERATE Green 1133A is Powered ON

TIMESET Green Time is Stabilized when ON

UNLOCKED Red 1133A Not Synchronized when ON

FAULT Red Internal Fault when ON

Table 2.1: Annunciator LED Definitions

The Operate and Stabilized LED’s are green and the Out-of-Lock and Fault LED’s
are red. For normal operation, with the internal clock of the Model 1133A locked and
accurate, both green LED’s should be ON and both red LED’s should be OFF. The
following definitions apply to these indicators:

� OPERATE: Indicates that power is being supplied to the Model 1133A.

� TIME SET: When ON, indicates that the Model 1133A is locked, that the internal
clock is synchronized to the GPS or IRIG-B signal and that the time is at maximum
accuracy.

� OUT OF LOCK: Illuminates when the Model 1133A has not yet synchronized, or
has lost synchronization, with the GPS or IRIG-B signal.

� FAULT: Illuminates when an internal fault occurs. Faults are listed below.

Fault Indication Definition

Out-of-Lock GPS Receiver is not receiving satellite signals

Receiver Failure 1133A not communicating with GPS receiver

System Failure Some System Faults

Table 2.2: Fault Indications and Definitions
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2.2.2 Command Key Definitions

All command keys provide multiple messages; press the specific key repeatedly to scroll
through the various displays. For example, press the Voltage/Current key (upper left) to
scroll through the configured voltages and currents, including sequence components. Note
that these keys DO NOT allow you to configure any of the internal functions of the 1133A.
Always configure the 1133A through the software application, PSCSV.

Key Function

VOLTAGE/ CURRENT View all Voltages and Currents

FREQ./TIME DEV. View Frequency, Frequency Deviation and
Time Deviation

EVENT LOG View Recorded Events, sequentially

STATUS/TIME Primary: View GPS or IRIG-B Info, Posi-
tion, Time and Date, System Configuration
and Memory Status
Secondary: Serial No., Firmware Dates,
Ethernet Settings and Parameters, Internal
Hardware Address, Serial Port Parameters

POWER View all Power Related Parameters

ENERGY View all Energy-Related Parameters

HARMONICS View Harmonic-Related Parameters

FLICKER View all Flicker-Related Parameters

Table 2.3: Command Key Definitions

2.3 Rear Panel Connectors and Identification

This section contains information to assist you in identifying where to connect inlet power,
the GPS antenna, or IRIG-B, cable and all of the input and output cables on the Model
1133A.

2.3.1 Power Inlet

To cover all of the possible inlet power conditions, the Model 1133A has two optional
power supplies. Please examine the paperwork you received with the Model 1133A, to
make sure you have correctly identified the inlet connection. Supply types are listed
below:
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Figure 2.2: Model 1133A Rear Panel Description

Option 03, IEC-320 supply with a range of 86 to 264 Vac, 50 to 60 Hz and 110 to 275
Vdc (illustrated in Figure 2.3)

Figure 2.3: High Voltage Power Inlet

Option 04, 10 to 60 Vdc ONLY, Terminal Power Strip with Surge Withstand Protect
Circuitry (SWC) power (illustrated in Figure 2.4)

Figure 2.4: Low Voltage Power Inlet

2.3.2 Antenna or IRIG-B Input

The Model 1133A provides a Type-F, GPS antenna input connector not only as the connec-

Figure 2.5: Antenna
Connector

tion point for GPS signal, but also supplies 5 volts to energize the antenna. It is equipped
with a threaded, type-F female connector. For models with the Option 07, IRIG-B decoder,
it will have a BNC female connector.

Figure 2.5 illustrates the antenna connector. For further information concerning the oper-
ation, mounting or troubleshooting antenna problems, see Chapter 4, Antenna and Cable
Information.

2.3.3 AC Voltage Inputs

The Model 1133A has a single, Phoenix-style, connector block that connects up to four
different phase voltage inputs to the measurement section. Wires are anchored by set
screws in the connector plug, and the connector plug is inserted into the connector block
on the rear panel. Figure 2.6 illustrates the connector block on the rear panel.
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Figure 2.6: Voltage Input Connector

2.3.4 AC Current Inputs

The Model 1133A has a single, Phoenix-style, connector block that connects up to three
different phase current inputs to the measurement section. Wires are anchored by set
screws in the connector plug, and the connector plug is inserted into the connector block
on the rear panel. Figure 2.7 illustrates the connector block on the rear panel.

Figure 2.7: Current Input Connector

2.3.5 Event Inputs

The Model 1133A has four terminal-style connectors (illustrated in Figure 2.8) for timing
external events based on the GPS-synchronized time, of from an IRIG-B signal. Since
events can range widely in voltage level, inputs may be configured for different ranges.
See Chapter 14 for additional information on setting the event input voltage level.

Figure 2.8: Event Input Connector

2.3.6 Communication Ports

The Model 1133A has two identical communication ports with your choice of RS-232,
RS-485 or modem, and one Ethernet port (illustrated in Figure 2.9). The RS-232
port does not use flow control and the RS-485 is transmit only (uses Transmit A and
Transmit B, no Receive A and Receive B). Generally, for RS-232 communications, you
will only need pins 2, 3 and 5 using a null-modem cable. For more information, see Chap-
ter 3, Section 3.6.1 on the serial interface. See also Chapter 6, connecting basics on page 47.

Figure 2.9: Communication Ports
Connectors
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2.3.7 Form C Contacts

The Model 1133A has four sets of Form C relay contacts (illustrated in Figure 2.10) that
have three contact points: Normally Open (NO), Normally Closed (NC) and Common
(C). For information on how to connect to them and their specifications, see Chapter 3,
Section 3.3, Relay Contact Outputs.

Figure 2.10: Relay Contact Connector

2.3.8 IRIG-B Timing Output

The Model 1133A has one high-drive, unmodulated IRIG-B, timing output that uses
a terminal connector as seen in Figure 2.11. This output may also be “Tee’ed” for
parallel-connected loads. For more information concerning how to connect any timing
output in parallel, for distribution, see Section 3.5 and Appendix C.

Figure 2.11: IRIG-B Connector
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Connecting Inlet Power, Input and
Output Signals

3.1 Introduction

This section should assist you with connecting all of the input and output wiring except
for the GPS antenna and cables. For antenna and cable information, please see Chapter
4. For connecting inlet power and any input voltage or current, please refer to the
appropriate section in this chapter.

3.1.1 Connecting Inlet Power

To provide for a wide range of inlet power sources, the 1133A can be ordered with either of
two different power inlet modules. Each of the power inlet module connectors are illustrated
here and also in Chapter 2. Take time to examine the power inlet module connection on
your Model 1133A to verify that it is correct according to your order. Make sure to check
the inlet module before connecting power to the 1133A.

3.1.2 Option 03, 110 to 275 Vdc Terminal Power Strip, Surge Withstand

The power inlet connector for Option 03 is a 3-pole terminal strip and provides input surge
protection for compliance with ANSI C37.90-1 and IEC 801-4. Input voltages are: 85 to
264 Vac, 47 to 440 Hz, or 110 to 275 Vdc, 3 VA typical.

Option 03, Connecting Inlet Power

When wiring this power supply, make sure to first connect an earth ground wire to the
terminal strip connector labeled “G” (for ground). Positive and negative terminals are
marked on the terminals as “+” and “–”. After connecting a ground wire, connect the
positive and negative leads from the station batteries to the corresponding Option 03
terminals. See Figure 3.1.



12 Connecting Inlet Power, Input and Output Signals

Figure 3.1: Option 03 Power Supply Inlet Connector

3.1.3 Option 04, 10 to 60 Vdc ONLY With Terminal Power Strip and
Surge Withstand

The power inlet connector for Option 04 is a 3-pole terminal strip and provides input surge
protection for compliance with ANSI C37.90-1 and IEC 801-4. Option 04 operates from
common low-voltage battery systems, including 12, 24, and 48 Vdc.

Figure 3.2: Option 04 Power Supply Inlet Connector

Option 04, Connecting Inlet Power

When wiring station batteries to this power supply, make sure to first connect an earth
ground wire to the terminal strip connector labeled “G” (for ground). Positive and negative
terminals are marked on the terminals as “+” and “–”. After connecting a ground wire,
connect the positive and negative leads from the station batteries to the corresponding
Option 04 terminals. See Figure 3.2.

3.1.4 Fuse Locations and Types

Use the fusing table below for identifying the correct fuse for your option power supply.
Note that the fuse is located adjacent to the terminals as depicted in Figures 3.1 and 3.2.

Replacing Fuses

With an Option 03 or 04 Power Inlet Module, the input power module includes
separate fuse holder adjacent to the terminal power strip. See the fuse chart in Table 3.1
for the correct fuse configured for your option.
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PS Option Arbiter PN Fuse ID Size, mm

03 FU0001816 F1AL250V 5 x 20

04 FU0001416 T1AL250V 5 x 20

Table 3.1: Fuse Chart

Option 03 and 04 fuses are located in a separate threaded compartment (see Figures 3.1
and 3.2). To check the fuse, use a small flat-bladed screwdriver and turn the cover counter-
clockwise. The cover and fuse should pop out. CAUTION: Replace fuse only with another
of the same type and rating. See Table 3.1 for the correct fuse configured for your option.

To replace the fuse, first disconnect inlet power from the 1133A. Using a small flat-blade
screwdriver, turn the fuse cover counter-clockwise (CCW) and it should pop outward.
Replace fuse with the same size and type.

3.2 Connecting Voltage and Current Signals

The following pages contain various diagrams that describe how to connect the 1133A
to several common types of power system configurations. Please refer to this section for
connecting any input signal wires, including main currents and voltages.

3.2.1 AC Voltage Inputs

Do not exceed maximum voltage limit of 600 Vrms. Use extreme caution when working
with high voltages. Attach voltage signal wires to the supplied 4-pin, female connector-plug
using the compression screws. Insert the connector-plug into the male connector (shown
at right) on the 1133A and tighten the safety locking screws.

Prior to applying the voltages to the AC Voltage Inputs, use DSP Mode to set up the input
range of the 1133A. DSP Mode is found under “Configuring Measurement Parameters” in
Section 7.4.

3.2.2 AC Current Inputs

Do not exceed the maximum current limit of 20 Arms. Use extreme caution when
working with high voltages. Attach current signal wires to the supplied 6-pin, female
connector-plug using the compression screws. Insert the connector-plug into the male
connector on the 1133A and tighten the safety locking screws.

Prior to applying currents to the AC Currents Inputs, use DSP Mode to set up the input
range of the 1133A. DSP Mode is found under “Configuring Measurement Parameters” in



14 Connecting Inlet Power, Input and Output Signals

Section 7.

3.2.3 Electrical System Connection Diagrams

Listed on the following pages are six common electrical system connection diagrams that
should provide additional assistance with connecting system wiring to the main electrical
inputs on the Model 1133A.
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1133A Single-Phase, Two-Wire, One-Element Circuits with Current and
Potential Transformers

Figure 3.3: Connection Diagram - DSP Notation, 1Ph2W1E
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1133A Single-Phase, Two-Wire, One and One Half Element Circuits with
Current and Potential Transformers

Figure 3.4: Connection Diagram - DSP Notation, 1Ph2W1.5E
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1133A Single-Phase, Three-Wire, Two Element Circuits with Current and
Potential Transformers

Figure 3.5: Connection Diagram - DSP Notation, 1Ph3W2E
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1133A Three-Phase, Three-Wire, Two-Element Delta Circuits with Current
and Potential Transformers

Figure 3.6: Connection Diagram - DSP Notation, 3Ph3W2E
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1133A Three-Phase, Four-Wire, Two and One Half-Element Circuits with
Current and Potential Transformers

Figure 3.7: Connection Diagram - DSP Notation, 3Ph4W2.5E
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1133A Three-Phase, Four-Wire, Three-Element Circuits with Current and
Potential Transformers

Figure 3.8: Connection Diagram - DSP Notation, 3Ph4W3E
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3.3 Relay Contact Outputs

Do not exceed the maximum contact output ratings. For mechanical relays (standard),
250 Vac/125 Vdc, 8A, 2 kVA/150 W max. For solid state relays (optional, KYZ) 350
Vac/Vdc, 0.12 A continuous, 0.36 A peak (100ms).

Use extreme caution when working with high voltages. Each set of contact outputs
is marked with a normally closed and normally open symbol as shown on the right.
Use care to select the appropriate side of these contacts for correct indication. Attach
contact output wires to the supplied 3-pin, female connector-plugs using the compression
screws. One, 3-pin female connector block is used for each contact output. Insert the
connector-plug into the male connector on the 1133A. The contact output connectors lock
in position, but do not have safety-locking screws to anchor the connector.

3.4 Event Inputs

Do not exceed the maximum Event Input ratings of 24-240 Vdc max. Event Inputs may
be configured for 5 V logic level, and require a bias resistor change on the main board. See
Appendix B for details on configuring the input voltages to 5 Vdc. Use extreme caution
when working with high voltages.

Attach event-input wires to the supplied 2-pin, female connector-plugs using the
compression screws according to the configuration diagram. Observe polarity markings.
One, 2-pin female connector block is used for each event input. Insert the connector-plug
into the male connector on the 1133A. The Event-Input connectors lock in position, but
do not have safety locking screws to anchor the connector.

3.5 IRIG-B Output

IRIG-B outputs are 5-V, CMOS-level voltages used to synchronize any equipment that
requires IRIG-B specific data format. Output circuitry can supply up to 1000 mA to
TTL IRIG-B loads. The IRIG-B output is marked with polarity markings for correct
connection. Attach IRIG-B output wires to the supplied 2-pin, female connector-plug
according to the polarity markings shown at right. Use a BNC breakout to convert to coax.

For additional details on connecting and distributing IRIG-B, please see the material on
IRIG-B located in the Appendix C of this manual, and documents on the Arbiter web
site[3].
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3.6 Data Connections

Table 3.2 gives the electrical connections for the two serial ports on the Model 1133A. The
section below describes the Ethernet connection.

3.6.1 Serial Interface Connections

The 1133A has three standard communication ports. Two RJ-11 serial interface connectors
may be optionally configured for RS-232C, RS-485, or V.34bis Modem. Choose the serial
port option at the time of order. Standard serial cable connectors are (normally) a DB-9F

Figure 3.9: Serial and
Ethernet Connectors

at the computer and RJ-11M at the 1133A. A standard phone cord and RJ-11 to DB-9F
adapter work well connecting the 1133A to a computer. Modem connections may be a
standard phone cable. Pin connections are shown below.

RJ-11
Pins

RS232C
Functions

DB-9F
Pins

RS-485
Functions

Modem
Functions

1

2 Ground

3 Transmit
(Ring)

2 A A

4 Receive
(Tip)

3 B B

5 Ground 5

Table 3.2: Serial Interface Connector Description

3.6.2 Ethernet Interface Connections

One IEEE 10Base-T interface connector (see Figure 3.9) allows connection of the 1133A
directly to a network (Conforms to the IEEE 802.3i) using one RJ-45 connector. To
configure the IEEE 10Base-T Interface, see Configure Ports - Ethernet in Section 7.3 on
page 58.
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GPS Antenna and Cable
Information

The Model 1133A comes complete with the necessary hardware to be able to receive GPS
signals: 50-feet of RG-6 cable and a GPS antenna. The antenna cable is connected to the
female F connector at the rear panel.

This section should help you with installing the GPS antenna and antenna cabling to the
1133A. It should also be a source of information if you should need to trouble shoot the
antenna cable system. The Model 1133A achieves its accuracy by comparing the internal
clock signal of the Model 1133A to the incoming GPS or IRIG-B signal, and making the
necessary corrections.

4.1 GPS Antenna Installation

To properly receive GPS signals, the GPS antenna needs to be mounted clear of buildings
and surrounding elements that would block the GPS signals being transmitted by the
satellites. For complete coverage, the antenna needs to have a clear view of the sky from
15 degrees above the horizon to directly overhead for all points of the compass. Minimal
installations, where the antenna is mounted in a less favorable location, may work however
reception may be somewhat limited during certain hours of the day.

4.1.1 Mounting the Antenna

To mount the antenna, you will need a short piece of grey, 3/4” plastic pipe nipple that
can be attached to a solid fixture. The piece of pipe nipple should be threaded up into the
antenna receptacle after connecting the antenna cable to the antenna. Arbiter Systems sells
an antenna mounting kit (part no. AS0044600) that simplifies installation for a variety of
locations. Figures 4.1, 4.2 and 4.3 illustrate several components for a suggested mounting
method.
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Figure 4.1: Antenna Assembly for Mounting

Antenna mounting procedure:

1. Thread the RG-6 antenna cable through the plastic pipe

2. Tighten the Type F male connector to the antenna connector

3. Thread the plastic pipe into the antenna

4. Mount the plastic pipe and antenna/cable assembly to a fixture

4.1.2 Optional Antenna Mounting Bracket,
kit part no. AS0044600

The AS0044600 Antenna Mounting Kit is designed specifically for use with antennas
shipped with the Model 1133A, Power Sentinel�. The hardware included with the bracket
allows installation of the antenna on a mast or pipe up to about 2” in diameter, and a
different clamp may be substituted for use with a larger diameter pipe. Also, the bracket
can be mounted to a wall, a roof, or any other flat surface.

For complete details on this product request Installation Instructions for Arbiter Systems
GPS Antenna Mounting Bracket on document number PD0024700A. All metallic hardware
is stainless steel.

Qty Description ASI P/N

1 GPS antenna mounting bracket HD0052700

1 U-bolt, 1-1/8”, with 2 hex nuts HP0014700

1 3/4” x 4” threaded pipe, PVC, schedule 80 HP0014800

1 Hose clamp, worm drive HP0014900

1 Mounting bracket stabilizer HD0054200

Table 4.1: Antenna Mounting Bracket Parts List
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Figure 4.2: Antenna Mounting Bracket

Figure 4.3: Antenna Mounting with AS0044600
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4.2 Antenna and Cable Testing

The antenna and cable assembly can easily be tested prior to or after installation. All that
is required is a basic multimeter that measures DC volts and resistance.

4.2.1 Checking the Antenna Voltage

The Model 1133A provides a +5 Vdc signal at 30 mA maximum, carried through the
antenna cable to the GPS receiver. Without the signal, the Model 1133A will not synchro-
nize with the Global Positioning System and it will generate an out-of-lock alarm. You
can verify this signal by setting your voltmeter to DC volts and measuring from the center
pin to the threads at the antenna connector on the rear panel of the 1133A. This signal
should be between +4.9 and +5.1 Vdc.

4.2.2 Power Supply Check

The Antenna Voltage test (as described in Section 4.2.1) actually tests the main power
supply voltage for the Model 1133A.

4.2.3 Checking the Antenna Resistance

In special cases, it may be necessary to check the antenna resistance. The current antenna
is a Trimble Bullet 3 and has a nominal internal resistance of about 270 ohms. Measure this
with the antenna cable disconnected from the Model 1133A and connected to the antenna.
This way you will know if you have a good connection. Change your multimeter to read
resistance and measure from the center pin of the cable connector to the threads (shield).
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4.3 Antenna Surge Suppressor

If you have ordered the GPS Surge Suppressor kit, you should mount it in line with the
antenna cable. Additional information on grounding GPS antennas, and grounding in
general, are available from Arbiter (Kit Part No. AS0049000).

Figure 4.4: GPS Surge Suppressor

4.3.1 Using the Antenna Surge Suppressor

Please follow the instructions below for mounting and using the GPS Surge Suppressor.
Additional technical specifications for the surge suppressor are found in Appendix B, on
page 181

Installation Instructions

� Please do not install the surge protector during a thunderstorm.

� Connect a coaxial cable (50 or 75 ohms) that will properly fit the F-type connector
of the surge protector. It will not matter which side of the protector you connect
the cable to because the connectors are non-polarized. This particular unit is bi-
directional.

� The two bolts extending from the case are good tie points for a earth-ground con-
nection. The two bolts allow the unit to be mounted on either side of the bulkhead
grounding system.

� Finally, tighten the F-type connectors until they are securely in place and weather-
proof the unit to prevent direct rain exposure if used outdoors.
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4.4 Technical Details on GPS, Antennas and Cables

4.4.1 Antenna Cable

Length and Loss Considerations

Standard Antenna Cable
The standard antenna cable assembly included with the Model 1133A is constructed using
a 15-meter (50-foot) length of RG-6 type low-loss coaxial cable, terminated with male Type
F connectors. Optional lengths of RG-6 coax are separately available for longer runs; see
Table 4.2, Cable Data and Accessory Information.

Effects of Cable Parameters

To receive GPS signals and properly operate the 1133A, the type and length of the
cable are important. Due to their effect on specific parameters described in the following
paragraphs, any changes to the length and/or type of antenna cable should be made
carefully. Damaged cables may also affect performance.

Cable Delay

Cable delay is the time required for the GPS signal to travel from the GPS antenna to the
GPS receiver inside the Model 1133A. The velocity factor, the length and type of cable
determine the cable delay. In very precise laboratory applications it may be necessary to
compensate for this delay. However in the Model 1133A, used for phasor and frequency
measurement of power systems, it is not significant enough to require compensation as long
as you stay within the cables mentioned in Table 4.2.

Attenuation

Attenuation depends upon the cable length, and the loss per unit length. The total
attenuation must be limited to 21 dB (maximum) at the GPS L1 frequency of 1575.42
MHz. Loss up to 42 dB can be accommodated with the separately available 21-dB in-line
preamplifier (AS0044700).

DC Resistance

The cross-sectional area and length of the conductors in the cable determine the dc
resistance. Since power to the RF preamplifier in the antenna is supplied via the antenna
cable, excessive dc resistance will degrade performance.
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Available Antenna Cables and Accessories for Longer Runs

Arbiter Systems offers longer antenna cables for use with the Model 1133A Power
Sentinel� when the standard 15-meter (50-foot) cable is inadequate. For RG-6 cable
runs greater than 250 feet, up to 500 feet, Arbiter offers a 21-dB in-line amplifier, P/N
AS0044700. A larger RG-11 style cable is available (P/N WC0004900, 305-m / 1000-ft
roll), that can be used for runs to 120 meters (400 feet) without the in-line preamplifier,
or 240 meters (800 feet) with the AS0044700 amplifier.

Part No. Description Delay, ns Loss

CA0021315 15-m (50-ft) cable, RG-6 60 ns -5 dB

CA0021330 30-m (100-ft) cable, RG-6 119 ns -9 dB

CA0021345 45-m (150-ft) cable, RG-6 177 ns -13 dB

CA0021360 60-m (200-ft) cable, RG-6 236 ns -17 dB

CA0021375 75-m (250-ft) cable, RG-6 295 ns -21 dB

WC0004900 305-m (1000-ft) roll RG-11 3.92 ns/m -17.5 dB/100m

AS0044600 Kit, crimp tool and 25 connectors, RG-11 N/A N/A

AS0044700 21-dB in-line amplifier 1 ns +21 dB

Table 4.2: GPS Cable Data and Accessory Information

Physical Protection

When routing the antenna cable, protect it from physical damage, which may result from
closing doors, falling objects, foot traffic, etc. Also, when routing around corners, allow
for sufficient bend radius to prevent kinks. Extra length should be allowed at both ends
of the cable to prevent tension on the connectors, which could cause damage or failure.
Extra length is useful as a service loop, in the event that a connector needs replacement.

Do not stretch the cable mid-air over any appreciable distance without support. Cable
degradation or failure could result. Always leave a drip loop wherever the cable enters a
structure, to prevent water from entering the structure via the cable jacket. The maximum
temperature rating for the type of cable provided with the 1133A is 60oC (140oF). Exercise
care when routing the cable near sources of heat to avoid cable damage.
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Adjacent Signals

Although the standard RG-6 style cable is triple-shielded and has excellent shielding
properties, be cautious when routing near high power RF sources or alongside cables
carrying high power RF, such as transmitter cables. In these applications, consider
using RG-11 style cable (P/N WC0004900). Its quad-shielded design provides even more
isolation.

Antenna Power

The RF preamplifier within the antenna requires 5 Vdc at 30 mA maximum for operation.
A power supply within the Model 1133A generates this voltage, which is applied to
the antenna via the two conductors of the coaxial antenna cable. Avoid shorting the
center conductor to the shield of the coaxial cable as it may damage the preamplifier.
Conversely, a high-resistance connection or open circuit would deprive the preamplifier
of power. Either a short- or open-circuit condition in the antenna cable will render the
1133A inoperable.

Prior to initial operation or if problems are suspected, perform the Antenna/Cable
Operational Test described above in Section 4.2.

Connecting to the Antenna and the Model 1133A

The male Type F connector on one end of the antenna cable mates with the female
Type F connector on the antenna. Avoid placing mechanical stress on the cable
attachment to the antenna. The male Type F connector on the opposite end of the an-
tenna cable connects to the female Type F connector on the rear panel of the Model 1133A.

User-Supplied Antenna Cables

Any RF cable meeting the requirements described above for loss (<21 dB at 1575 MHz)
and dc resistance (<15 ohms total loop resistance) may be used with the Model 1133A.
However, prior to using a non-standard antenna cable, verify proper installation by
performing the Power Supply Test and Antenna Resistance Test described in Section Sec-
tion 4.2.

For additional technical details concerning the GPS, GPS antennas and antenna cabling
see Appendix 1, Technical Details and Specifications.



Chapter 5

Startup Operation and Indication

5.1 Startup

This chapter address the startup and initial operation immediately following the ap-
plication of inlet power to the Model 1133A. It addresses the activity of the specific
annunciator LED’s and Display indications, so that you will know what to expect when
applying power. When you apply power to the Model 1133A, startup should begin with
the Annunciator LED’s flashing briefly and the LCD display indicating some initial
startup information as illustrated below.

5.1.1 Startup Display Indications

After applying inlet power to the 1133A, you should see the three specific LCD display
indications shown below in sequence. Each should persist for several seconds before
changing to the next. There should be no change after the third display indication
until the GPS begins tracking satellites and it will indicate that number. Normally, the
Tracking number will begin changing from zero to one and up to twelve satellites total.

Figure 5.1: Initial Startup Screen

Figure 5.2: Copyright Startup Screen

Figure 5.3: GPS Status Screen
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5.1.2 Locked Indication

Sometime after the 1133A indicates that it is tracking four satellites, at initial startup,
the word “STARTUP” will change to “LOCKED.” This number of satellites is required to
establish a new geographical position for the 1133A. After the 1133A has initially found
its position, a subsequent startup may produce a LOCKED indication after tracking only
one or two satellites.

Figure 5.4: GPS Locked Screen

5.1.3 Annunciator LED Startup Indications

Initially, the annunciator LED’s should all flash, and then the Operate and Unlocked LED
should be ON; the Timeset and Fault LED’s should be OFF. After about 30 minutes of
internal clock stabilization, the Unlocked LED should go OFF, and about five minutes
later the Timeset LED should go ON. The Timeset LED serves to indicate that the
internal clock is locked to the GPS and the time is accurate to within the guaranteed
specification (see Chapter 12).

5.1.4 Viewing Electrical Parameters

By pressing any of the command keys you should be able to view any of the measured
electrical parameters. Details of these parameters and what you should see are explained
in the next section, Overview of Command Keys.

5.2 Overview of Command Keys

The command keys enable you to view the various electrical parameters measured and
processed by the Model 1133A, and the Status key gives you a more detailed view of its
operation status. Command keys are not used to configure the Model 1133A.

5.2.1 Voltage/Current Key

Press the VOLTAGE/CURRENT key successively to view magnitude and phase angle for
each measured line voltage and current. Phase voltages and currents are listed as “A”,
“B”, “C”, “0”, “1” and “2.” “A”, “B”, and “C” label each of the voltage and current
phases, and “0”, “1” and “2” are labels for each of the sequence voltages and currents.
The first illustration below shows the “A” phase voltage and current, magnitude and
phase angle. The second shows the 0 Sequence values.
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Figure 5.5: Voltage/Current Display

5.2.2 Frequency/Time Deviation Key

Press the FREQ./TIME DEV key twice: once to view the measured line frequency and
GPS time; a second time to view the signed error in system frequency from 50 or 60
Hz, and the integrated total time deviation. Resolution of time deviation is in milliseconds.

Figure 5.6: Freq./Time Dev. Display

5.2.3 Event Log Key

Press the EVENT LOG key successively to sequence through the events logged into the
1133A flash memory. Events are numbered and labeled according to type of event (e.g.
over voltage) and “date and time stamped.”

Figure 5.7: Event Log Display

5.2.4 Status/Time Keys – Primary Functions

Press the STATUS/TIME key to view any one of five, primary instrument status menus,
which are given here in sequential order. Continue pressing this key to cycle to a previous
Status/Time view. Press and hold the STATUS/TIME key for approximately three
seconds to access either the primary or secondary instrument status menus.
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Status, Receiver Condition

Status, Receiver Condition - GPS: Locked or Unlocked with number of satellites Visible
and Tracked. IRIG-B: (Option 7) Locked or Unlocked with time quality indicator.

Figure 5.8: Status, Locked Display: GPS or IRIG-B

Status, Location; Latitude and Longitude

Status, Location; Longitude and Latitude (no elevation) - Gives GPS antenna position.
Not present with IRIG-B (Option 7) - no position indication without GPS.

Figure 5.9: Status, Location: Latitude
and Longitude

Status, Date and Time - UTC or Local

Pressing the STATUS/TIME key will display the date and time in UTC or Local time
format. It also indicates the Julian Day. Use PSCSV to configure the time format for either
UTC or Local. Time and Date information, in both UTC and Local format, accompanies
all data, whether broadcast or recorded in Flash through an internal trigger or a data
register.

Figure 5.10: Status, Date and Time

Status, Mode, Range and Electrical Configuration

This status display includes the electrical configuration (e.g. 3 phase, 4-wire, 3-element),
system frequency and input signal ranges.

Figure 5.11: Status, 1133A
Configuration
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Status, Flash Memory

Indicates memory available in recording time, percent available and ROM error status.

Figure 5.12: Status, 1133A Flash
Memory

5.2.5 Status/Time Keys - Secondary Functions

To view any of the secondary status functions, press and hold the STATUS/TIME key for
three seconds. It should shift to the second set of status functions. To return to primary
status functions, press and hold the STATUS/TIME key for three seconds.

Press the STATUS/TIME key to view any one of five, secondary instrument status menus,
which are given here in sequential order. Continue pressing this key to return to a previous
Status/Time view.

Status, Program ROM Information

Press the Status/Time key to view the program ROM Serial Number and Date, and the
DSP ROM Identification Date. To access this screen, see Section 5.2.5 notes.

Figure 5.13: Status, Program
Information

Status, Calibration Information

Press the Status/Time key to view the Calibration Information - Last calibration and
calibration due date. To access this screen, see Section 5.2.5 notes.

Figure 5.14: Status, Calibration
Information

Status, Ethernet; IP Address and Subnet Mask

Press the Status/Time key to view the IP Address and Net MASK. To access this screen,
see Section 5.2.5 notes. Within the menu, the existing (or default) IP Address and Mask
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may be verified. To change any communications parameter, see “Configuring the 1133A,
Configuring an 1133A Communications Port.” Once the IP Address is changed, the 1133A
must be power cycled for the new address to take effect.

Figure 5.15: Status, Ethernet; Address
and Subnet Mask

Status, Ethernet; TCP/UDP Port and Physical Address

Press the Status/Time key to view the TCP/UDP values and Physical Address. To access
this screen, see Section 5.2.5 notes. Configure TCP and UDP values only from PSCSV�
- for details, see “Configuring an 1133A Communications Port.” After changing the TCP
or UDP values, power cycle the 1133A for the new values to take effect. In this exam-
ple, BC-61-4E is the unit serial number in hexadecimal notation (in decimal it is 12345678).

Figure 5.16: Status, Ethernet;
TCP/UDP Port and Physical Address

Status, Serial Port Parameters

Press the Status/Time key to view the Serial Port Communication Settings for SERIAL
1 and SERIAL 2. To access this screen, see Section 5.2.5 notes. To configure serial port
settings, see “Configuring an 1133A Communications Port” in Section 7.2.

Figure 5.17: Status, Serial Port
Parameters

5.2.6 Power Key

Press the POWER key successively to view the four power screens. Each screen lists all
of the available power information (kW, PF, kVA and kVAR) for one of the three phases
and total (e.g. A, B, C and T).

Figure 5.18: Power Key
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5.2.7 Energy Key

Press the ENERGY key successively to view the four Energy screens. Each screen lists all
of the available energy information (kWh, kVAh, and kVARh) for one of three phases and
total (A, B, C and T).

Figure 5.19: Energy Key

5.2.8 Harmonics Key

Press the HARMONICS key successively to view the harmonics data that applies to the
measured electrical system. Each screen lists the total harmonic voltage and current, and
THD for each of the measured phases.

Figure 5.20: Harmonics Key

5.2.9 Flicker Key

Press the FLICKER key once to view voltage and current flicker measurements for all of
the three phases.

Figure 5.21: Flicker Key

5.3 Unlocked and System Fault Indication

Should there be a System Fault with the operation of the 1133A, the Unlocked and/or
Fault Annunciator LED may switch ON. A System Fault alarm occurs with hard-
ware/firmware failures with the 1133A itself; it is not a generated fault from the measured
electrical system. When the Unlocked LED switches ON, it indicates that the 1133A has
lost synchronization with the GPS satellites.

5.3.1 Unlocked Indication

Normally, throughout the day you should see the TRACK number change as satellites pass
across the “visible” sky, in and out of view of the GPS antenna. If there is a problem with
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the satellites, antenna, cable or GPS receiver, there may be a time when it will indicate zero
satellites tracked and the Unlocked LED will turn ON. It is very remote possibility that
there would be a problem with the satellites, however more likely that there is a problem
with the antenna/cable combination. Most likely problems are installation problems, such
as a bad cable/antenna connection, or that the antenna or cable was damaged or has failed.

If at startup the Unlocked LED should not switch OFF after the normal amount of time, it
may indicate that there is a problem with the antenna/cable connection. To troubleshoot
the antenna/cable system, please refer to Chapter 4, especially Section 4.2, Antenna and
Cable Testing.

5.3.2 Fault Indication

If the Fault LED should switch ON, you may be able to view the reason for the fault
directly on the display. These faults are hardware-related faults that could occur due to
problems with memory overruns. If the fault is severe enough, it may not be possible for
the display to provide a reason for the fault. Listed below are some of the possible reasons
for a Fault LED switching ON.

Fault Listed Indication, LEDs ON

Non-maskable interrupt error Fault LED only

Stack overflow Fault and Operate LED’s

Stack underflow Fault and Timeset LED’s

Class B hardware error Fault and Unlock LED’s
includes:
- Undefined Opcode
- Protected Instruction Fault
- Illegal Word Operand Access
- Illegal Instruction Access
- Illegal External Bus Access

Table 5.1: Fault Indications

If the fault is not severe enough to lock out use of the LCD display or keypad, the display
will indicate one of the faults listed in Table 5.1. These faults can normally be cleared by
recycling power to the Model 1133A. A severe fault, that cannot be cleared by recycling
power, should be immediately reported to Arbiter Systems technical support. If you do not
see your fault listed here, call the factory for assistance. See page ii for contact information.



Chapter 6

PSCSV Basics - Starting,
Connecting and Logging In

6.1 Introduction

6.1.1 Getting Started

This chapter was written to assist you in setting up and operating the 1133A Power
Sentinel� using PSCSV� software. PSCSV� provides direct and complete control
over all of the features of the 1133A. No other tool is available to configure the 1133A,
however other software applications may be used to collect data, especially with the new
synchrophasor specification, C37.118.

Topics covered in this chapter include:

� Buttons, Windows, Toolbars and Menus

� Connecting with the 1133A

� Logging In

Opening a connection is the first step in successfully operating the 1133A. Prior to
operation, however, determine what type of connection you need to configure. The 1133A
provides several types of connection options: RS-232, RS-485, Modem and Ethernet
(RJ-45). For more information on connections, see Connecting with the 1133A.

Additionally, the 1133A Security feature provides administrative control over users and
allows administrators to set up various levels of access. For more information on Security,
see 1133A Security.
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6.1.2 Triggering from the DSP, Power Quality, and from I/O Connec-
tions

Several methods are available for triggering including various DSP parameters, power
quality conditions and the four event inputs connectors on the rear panel. For details on
configuring triggers, see Working with Triggers and Downloading Event Data.

6.1.3 C37.118 Phasor Broadcast

Newly installed phasor broadcast algorithms are ready to be configured for use according
to the IEEE Std C37.118. For details, see Configure Ports - C37.118 Synchrophasor
Protocol in Section 7.8.

6.1.4 Power Quality, DNP and Modbus

Communicate with the 1133A using other software packages that interpret DNP 3.0 and
Modbus protocols to access Scheduled data. To configure any port for DNP or Modbus
protocol, see Configuring DNP and Modbus. For DNP 3.0 and Modbus Codes, see
Chapter 13, DNP and Modbus Data Structures.

6.1.5 Scheduled Data, Relays and KYZ Pulses

The 1133A comes configured with four SPDT Form C, multi-function relays. For KYZ
pulse metering, order the optional solid-state relays. For configuring relays to signal
triggered conditions or for KYZ pulse metering, see Configuring Multi-Mode Relays in
Section 7.10.
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6.2 Menus, Toolbars, Buttons and Windows

The PSCSV� Main Screen shown in Figure 6.1 provides access to its many features by
assembling them together according to functional groups called Menus, Toolbars, Function
Buttons and Windows. Most of the functions are not available until a user is connected to
a specific port and logged on using a specific user account. For information on connecting,
see Connecting with the 1133A in Section 6.4, for logging on and user accounts, see
Section 6.4.12 and for 1133A Security see Section 7.14.

Figure 6.1: PSCSV�Main Window

6.2.1 Moving and Viewing Features

Move any Toolbar and dock it around the Main Window by selecting and holding one of
the Toolbar handles and dragging the Toolbar to a preferred location. Use View on the
Main Menu to switch Toolbars ON or OFF depending on need and available space.
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6.3 Toolbar and Button Definitions

6.3.1 Main Toolbar

Figure 6.2: Main Toolbar

Main Toolbar Items: (in order) Open a PSCSV file, Export to CSV File, Create a
Snapshot, Copy, PSCSV Home page.

Open: Opens a specific 1133A file - has browse features.

Export to CSV File: Exports selected .1133 file records to .csv for use with spreadsheets.
Select current data or records in opened files.

Create a Snap Shot: Opens the Save As window for saving current data to a separate
file.

Copy: Copies selected records in a file under review in the main window of PSCSV.

PSCSV Home Page: Connects user to the PSCSV homepage at www.arbiter.com.

6.3.2 Connection Toolbar

Figure 6.3: Connection Toolbar

Connection Toolbar Items: (in order) Open a connection, Close a connection, Login
As, Connection window.

Open a Connection: Opens a window that allows users to open a connection between
the 1133A and a computer.

Close Connection: Immediately closes the current open connection (shown in the Con-
nection Window) between the 1133A and a computer.

Login As: Opens the Login Window for entering user names and passwords.

Connection Window: Displays the current open connection by name.
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6.3.3 Broadcast Toolbar

Clicking on one of the items in the Broadcast toolbar opens the specific Save As window
for saving the chosen broadcast data. Select OK if you agree to the supplied file name or
type in your own filename, and the broadcast should start.

Figure 6.4: Broadcast Toolbar

Broadcast Toolbar Items: (in order) Stop All, Stop This, Pause, Basic, Energy,
Harmonic, Harmonic Summary, Waveform, PMU-1, PMU-2, Relative Phase.

Stop All: Stops all broadcast data streaming from the 1133A.

Stop This: Stops the current broadcast data and leaves others alone.

Pause: Pauses the data from flowing into Main Window.

Basic Data: Initiates the flow of Basic data into the Main Window.

Energy Data: Initiates the flow of Energy data into the Main Window.

Harmonic Data: Initiates the flow of Harmonic data into the Main Window.

Harmonic Summary: Initiates the flow of Harmonic Summary data into the Main Win-
dow.

Waveform Data: Initiates the flow of Waveform data into the Main Window.

PMU-1 Data: Initiates the flow of PMU-1 data into the Main Window.

PMU-2 Data: Initiates the flow of PMU-2 data into the Main Window.

Phase Data: Initiates the flow of Relative Phase Data into the Main Window.

6.3.4 Configuration Toolbar

Figure 6.5: Configuration Toolbar

Configuration Toolbar Items: (in order) Unit Information, Configuration Ports Info,
Configure Measurement, Configure Scheduled, Configure Trigger Parameters, Configure
Kp Scaling, Configure Relays, Configure UDP.
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Unit Information: Provides specific information of the 1133A, e.g. serial number, IP
Address, firmware version, calibration.

Configure Ports Info: Opens the Configure Ports window. configuration includes all
data ports in the 1133A.

Configure Measurement: Opens Measurement Parameters window Configuration in-
cludes DSP Parameters mode, CT/PT cal, XFMR loss and Anti-Creep.

Configure Scheduled: Opens the Configure Scheduled Storage window. Includes all
Scheduled storage choices and frequency.

Configure Trigger Parameters: Opens Trigger Configuration window. Provides access
into the various triggering setup functions and Event Notification.

Configure Kp: Configures Kp (KYZ) Register Scaling for selected measured quantities.

Configure Relays: Opens Configure Relays window. Provides access to the relay setup
mode: Triggers, Pulse-per-Hour and KYZ pulse metering.

Configure UDP: Opens the UDP Broadcasting window. Selects data to be broadcast
over the Ethernet and broadcasts when clicking the Apply button.

6.3.5 Flash Toolbar

The Flash Toolbar provides a place for you to manage the flash memory module, and
stored records in the flash module. The memory module is divided up into two sections:
memory allocated for scheduled records and memory allocated for event records.

Figure 6.6: Flash Toolbar

Flash Toolbar Items: (in order) Flash Memory Status, Configure Flash, Erase Flash,
Download Scheduled, Erase Scheduled, Download Event, Erase Event.

Flash Memory Status: Opens Flash Memory Status window. Provides a flash memory
status summary, for Scheduled and Event data.

Configure Flash: Opens the Configure Flash window. Controls the partition size of
available flash memory devoted to Scheduled or Event records.

Erase Flash: Opens the Erase Flash Memory window. Selects records for erasure from
flash memory.
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Download Scheduled: Opens the Download Scheduled window. Specifies Scheduled
records for downloading.

Erase Scheduled: Opens the Erase Scheduled window. Selects Scheduled records for
erasure from the flash memory module.

Download Event: Opens the Download Event window. Selects Scheduled records for
erasure from flash memory.

Erase Event: Opens the Erase Event window. Selects event records for erasure from flash
memory.

6.3.6 Input Toolbar

Figure 6.7: Input Toolbar

Input Toolbar Items: (in order) Channel A Voltage (also B and C), Channel A Current
(also B and C), Channel N (Neutral) Current, Increase Scale, Decrease Scale.

Channel A Voltage: Channel Input buttons turn ON or OFF (in the PSCSV� window)
the specific signal when Broadcast Waveform, or Broadcast Phasor data are presemt. Same
for B and C phases(in the PSCSV� window).

Channel A Current: Channel Current Input buttons turn ON or OFF (in the PSCSV�
window) the specific signal when Broadcast Waveform or Broadcast Phasor data are
present. Same for B and C phases.

Increase Vertical Scale: Increase vertical scale resolution when viewing phasor data.

Decrease Vertical Scale: Decrease vertical scale resolution when viewing phasor data.
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6.3.7 Records Toolbar

The Records toolbar allows you to move forward and backward through a PSCSV� file
for specific records. Records are noted with a date and time stamp shown in the window.

Figure 6.8: Records Toolbar

6.3.8 View Menu

Use the View Menu to control the appearance of data streaming from the Model 1133A.
Items that can be controlled are:

Time Format - allows the time format accompanying data in either Local or UTC.

Data Filters - controls the data being viewed on the screen.

Waveform Smoothing - reduces discontinuities in waveform data.

Time Interval - changes the time scale for waveform and phasor data - similar to an
oscilloscope - to expand or compress the horizontal scale. Certain values are only available
under preset viewing conditions.

View As - allows you to view most data in real time or spreadsheet, harmonics also as
vertical bars and phasors as a vector or frequency plot.

Toolbars - switch any (or all) of the toolbars ON or OFF.

6.3.9 Edit Menu

Copy - Copies the selected data to the clipboard

Select All - Selects all of the data in the Data Window.

Preferences - Allows you to select the Time as either Local or UTC, Daylight Saving
Time changeovers, colors of the data (graphical or tabular), and font style and size.
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6.4 Connecting with the 1133A

6.4.1 Introduction

There are two basic steps to connecting with the 1133A:

1. Make sure to make a physical connection between an 1133A Port and a computer.1

2. Open a specific Communication Port using PSCSV�.

6.4.2 Communication Ports

Connection options are (1) for SERIAL 1 and 2 including RS-232, RS-485 and Modem,
and (2) IEEE 802.3I 10Base-T, Ethernet. Available protocols include TCP/IP, Modbus,
DNP 3.0 and IEEE Std C37.118.

Making a Physical Connection

Connectors for communications are at the left side on the rear panel. Three connectors
are visible and identified as SERIAL 1, SERIAL 2 and 802.3I 10Base-T as seen in Figure 6.9.

Figure 6.9: Rear Panel Description

1. Identify the specific serial port to be used. If necessary, recheck documentation with
your purchase order. Serial ports are located on the left side of the rear panel diagram.

2. Verify the serial port option. Identification boxes adjacent to the port labels are
marked RS-232, RS-485, or Modem. Every 1133A has an IEEE 802.3I, 10Base-T
port as shown to the right of the two serial ports.

3. RS-232: Connect a phone cable to serial port 1 or 2 on the 1133A, depending on
options. If necessary, connect the other end of the phone cable into a DB-9F to
RJ-11 Adapter. Connect the Adapter into the chosen COM port on the computer.
See Table 5-1 in the Operation Manual for a list of wire connections.

1A physical connection could be an RS-232/485 cable between the 1133A and a computer, a 10Base-T
cable connection to a network, or a telephone line. Once the appropriate cable is in place, you can go to
the next step of selecting an existing port configuration to open. After connecting, 1133A ports may be
reconfigured for different purposes.
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4. RS-485: Connect the RS-485 cable (with RJ-11 connector) to serial port 1 or 2
depending on the options. See Table 5-1 in the Operation Manual for a list of wire
connections.

5. Modem: Connect the phone cord from the telephone outlet to serial port 1 or 2
depending on the installed options. See Table 5-1 in the Operation Manual for a list
of wire connections.

6. IEEE 802.3I: Connect the Ethernet cable from a hub into the RJ-45 connector (IEEE
802.3I port) at the rear of the 1133A. If you encounter problems see Appendix A,
Working with Ethernet Connections, on page 177.

Serial Connection Summary

Connector Communication Standard Direction

SERIAL-1 RS-232, RS-485, Modem, DNP 3.0, Modbus Trans/Rec

SERIAL-2 RS-232, RS-485, Modem, DNP 3.0, Modbus Trans/Rec

IEEE 802.3I TCP/IP, DNP 3.0, Modbus Trans/Rec

IEEE 802.3I UDP Broadcast Trans

IRIG-B IRIG-B000, Unmodulated Trans

Contact Outputs KYZ (SPDT, Form A/ Form B solid-state contact) Trans

Table 6.1: Types and Uses of 1133A Serial Connections

6.4.3 Starting PSCSV�

1. Verify that PSCSV� is installed on the computer. If necessary download from
www.arbiter.com/pscsv/index.php.

2. Start PSCSV�. Select the shortcut on the desktop, or use the Windows desktop Start
menu: Start > Programs > Power Sentinel CSV > Power Sentinel CSV.

3. Check the buttons on the Main and the Connection Toolbars. Several of the buttons
should be active, including the Folder, Question Mark and Open Connection.

6.4.4 Checking Communication Parameters on the 1133A

1. Press and hold the STATUS/TIME button on the 1133A for about three seconds and
release when you see the display change to another set of menus.
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2. Keep pressing the STATUS/TIME button until you view the desired communications
port menu. To see a list of the various menus on the 1133A, see Status / Time Button
Secondary Functions in Section 5.2.5.

6.4.5 Opening a Connection

To configure the 1133A and access any stored data on it, you must open a serial connection
between your pc and the Model 1133A. The connection type can be RS-232, RS-485,
internal modem and Ethernet. An open connection is signified by a connection name
appearing in the Connection Window.

Figure 6.10: Connection List - shows
Ethernet selected

Before attempting to make the software connection, make sure to connect a cable between
the your pc and the 1133A. For RS-232, RS-485 and modem, the connector is RJ-11 us-
ing a common phone cable. For Ethernet, the connector is RJ-45 and using a CAT-5 cable.

1. Prior to connecting, the Main Toolbar and the Connection Toolbar should appear
with several icon buttons active: Open a File, PSCSV Homepage and Open a Con-
nection.

2. First-time users can open communications with the 1133A by selecting Connection
> Open or by clicking the Open a Connection button.

3. Select a connection from the list as shown in the left pane of the Connection Window.
Expand the connection type from the list shown in the left pane by selecting the +
sign. This should expand the list to a specific COM port or IP Address.

RS–232 and RS–485

Select the desired COM port that appears in the left pane (either RS-232 or 485), and
the communication parameters should appear in the right pane of the Communication
window. Note that these communication parameters refer to the computer connected to
the 1133A.
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Figure 6.11: Connection List - shows RS-232 selected

Modem

Select Modem on COM1 or COM2 and the selection window should provide the phone
number and Initialization String. Parameters refer to the computer / modem connected
to the 1133A.

Ethernet

1. Select the + next to Ethernet. If connecting for the first time, choose Default, and
the parameters should be similar to those shown in Figure 6.10. Those listed are the
default values installed at the factory. The IP Address is for the 1133A connected to
the network.

2. Select OK and the port should open.

3. Later, you can Add, Remove or Rename any of these connections. See Section 7.3
on page 58 for more information.

4. If successful, and a specific port is opened, then many more of the menu buttons
will become active on the toolbars. These include all of the Broadcast Data Toolbar,
the Close Connection button, the Login Key symbol and some of the flash memory
buttons.

5. When the connection opens, you should be logged in with the Login Name anon.
This account provides Basic Permissions. For advanced permissions, log in using a
Login Name with these permissions. To configure the 1133A permissions, see 1133A
Security in Section 7.14 on page 79.

6.4.6 Adding a TCP or UDP Connection

You may add an Ethernet TCP or UDP connection to the to PSCSV in order to connector
to additional 1133A devices To add another Ethernet connection,
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1. Click Connection > Open or click the Open Connection button.

2. Expand the Ethernet TCP or UDP tree (by clicking the plus sign next to Ethernet
TCP or Ethernet UDP.

3. Select the Default connection name and click the Add button. A new Default name
should appear in the Connection window.

4. Select the new Default name and click the Rename button and edit the name.

5. Type in the new Ethernet IP address and Port number in the spaces.

6. Click OK to accept and open the new connection.

6.4.7 Renaming a TCP or UDP Connection

From the Connection window, select an Ethernet TCP or UDP connection name and click
the Rename button. Type in the new name and select OK to open the connection.

6.4.8 Removing a TCP or UDP Connection

From the Connection window, select an Ethernet TCP or UDP connection name and click
the Remove button.

6.4.9 Closing a Connection

To close an open connection, select Connection > Close or select the Close connection
button and the port should close. Closing a communication port may deactivate certain
Toolbar buttons as an indication of the port being closed.

6.4.10 Automatic Connection Closure

An open port that is inactive for 10 minutes will be closed automatically.

6.4.11 Special Note on 115200 Baud Rates

The default Win32 serial drivers are not capable of reliably sustaining baud rates of
115200. If PSCSV� detects any hardware and or serial driver communication errors,
a warning dialog will pop up and indicate Read and Write Errors. For more reliable
communication, its best to choose a slower baud rate. Downloading Scheduled data may
be slower, however reliability will improve.
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6.4.12 Logging In to the 1133A

Use the Login feature to increase the functionality in PSCSV�. Initially, PSCSV� opens
with the Login Name “anon”. This allows anyone access to download Broadcast Data.
If security is disabled, then all functions are available. The admin account provides
permission to configure everything in the 1133A using PSCSV�. The admin password
may be changed but the Login Name admin is permanent.

Figure 6.12: Security Features, Login
Window

1. Select Connection > Login As or select the Login As button on the Connection
Toolbar to open the Login Window.

2. Type in the new Login Name and Password. Click Login, or press ENTER, and the
new functions should be visible with additional buttons becoming active.

3. PSCSV� will issue a warning that the attempted login failed if either the Login
Name or Password was entered incorrectly.

6.4.13 Logging In Using admin

For complete control over user permissions, log in with the Log In name “admin”.
Normally, this procedure would be performed by a system administrator, who would set
up user names with specific passwords. Initially, the 1133A gives this control by the
default Login Name “admin” and the password “801n60”, which is case sensitive.

Notice that the permissions window is broken up into two sections: Basic Permissions
and Advanced Permissions. For more information on 1133A Security and assigning user
permissions, see Section 7.14 on page 79.
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Figure 6.13: Security, User Permissions
Window
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Chapter 7

Configuring the Model 1133A

7.1 Introduction

Use PSCSV� software that accompanies the 1133A to configure its various options.
It is not possible to configure the 1133A from the front panel. After configuring the
1133A, data may be downloaded using PSCSV� or another software tools that work with
C37.118, DNP 3.0 or Modbus protocols. Other third-party software may also be available.

7.1.1 1133A Configuration Options by Section

Listed below are the sections covered in this chapter.

• Communication Port Settings • Position and Time
• C37.118 Synchrophasors • DNP 3.0 and Modbus
• Measurement Parameters • Scheduled Data Storage
• 1133A Security • Set Time Deviation
• Kp Register Scale Factors • Relays or Contact Outputs
• UDP Broadcasting • Flash Memory Management

7.1.2 Basic Configuration Requirements

1. An open connection between the 1133A and a computer. If necessary, see Section 6.4
for basic information on connecting.

2. Being logged on to the 1133A with permission to configure

Any time you want to configure the 1133A, make sure to meet these two requirements.
For information on opening a connection with the 1133A, see Chapter 6. If you do not
have permission to configure, you will need to see 1133A Security in Chapter 7, or see the
system administrator to set up permission.
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7.2 Configuring an 1133A Communication Port

Configuring a Port, in this section, means setting up the specific communication parame-
ters of a given communication port in the Model 1133A. Ports may only be configured
using PSCSV�.

WARNING: Do not change the communication port parameters of the same port being
used to communicate with the 1133A; an Invalid Data window will appear, and communi-
cations will be terminated.

1. Make certain that there is an open connection with the 1133A and that you are logged
on with permission to configure. If you are not, see Basic Configuration Requirements
in the introduction of this section.

2. Select the communications port you wish to configure in the left panel of the window.
Ethernet is selected in the margin screen shot

3. In the right panel, select the item for each port that needs to be configured by
choosing the adjacent drop-down button. When finished configuring, select OK and
the current value(s) will immediately be updated on the 1133A.

4. TO VIEW NEW COM PORT SETTINGS ON THE 1133A: Press and hold the
STATUS/TIME button for at least three seconds and release when menu item changes
(it should indicate the Serial Number, ROM date and DSP date). Then, continue
pressing the STATUS/TIME button until the port settings are in view. See Section
5.2.5 for details on the display indications.

7.2.1 Configure Ports - Communication Ports 1 and 2

Configure Communication Ports 1 and 2 in the same way; they are both identical in
structure in PSCSV� , except that each port may be RS-232, RS-485 or Modem. When
you configure a port on the 1133A, you are changing the port attributes, or settings.
Therefore, do not change the port settings on the same port that you are connected.

1. Make sure that you have permission to configure. If you are not sure, see Section 7.14.

2. Select Connection > Configure > Communication Ports (Shift + Ctrl + C) or click
the Configure Ports button. Select Communication Port 1 or 2 on the left panel and
you should see a list of port setting Descriptions and Values. See Figure 7.1.

3. Make sure to check the Protocol when first setting up the port settings. In this
example, the Protocol is set to C37.118. Other Protocol selections are None, DNP,
Modbus and Vorne.

4. If you are planning to collect Broadcast data using PSCSV� , then it would be
acceptable to select None for Protocol.
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Figure 7.1: Configuring COM1 Settings

5. Make any other setting changes based on the type of Protocol as the values change
with chosen protocol.

(a) For C37.118 on Communication Port 1 or 2, make sure to check down to switch
it to ON under C37.118 Phasor (at the bottom of the list on the left panel).

(b) For DNP Protocol, make sure to check all of the settings under DNP Settings.

(c) For Modbus, make sure to select the Modbus RTU Mode below.

(d) For Vorne Output, make sure to check the Vorne Output selection.

6. Click the OK button if you are finished configuring, otherwise continue configuring
other options.
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7.3 Configure Ports - Ethernet

This section describes setting up the basic values for the 1133A Ethernet port. This
includes the IP address, subnet mask and Port Number. All of the different protocols are
available except Vorne, which is not defined for Ethernet.

1. Begin configuring the Ethernet port by opening the Configure Ports window and
selecting Ethernet on the left panel.
NOTE: It is necessary to power cycle the 1133A after configuring the IP Address,
Subnet Mask, and Port Number or they will not be activated. Prior to power-cycling,
the front panel will reflect the new IP address, but the new connection parameters
will not be activated on the 1133A.

Figure 7.2: Configuring Ethernet Settings

2. It is best to use this window for two things: (1) viewing the Ethernet connection
and (2) making Protocol changes. If you want to change the port settings on the
active connection, you will still be connected at the previous settings. Only after
power-cycling the 1133A will the new settings become active.

3. If the connection protocol is Modbus, choose ON of OFF for the desired action and
then click the OK button.

4. If the connection protocol is DNP, choose ON or OFF for the desired action and
choose a value for Max App Frag Size (see Section 7.6). Values range from 1 to 2048.

5. If the desired connection protocol is C37.118, then you will need to decide if you want
to use PMU-1, PMU-2 or both.

7.3.1 Additional Information on Ethernet Connections

Setting up an Ethernet connection may require some additional diagnostics. Listed below
are System tools that may provide assistance. Generally, if there is a connection problem,
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it will either be a hardware problem, such as a bad or unconnected cable, or a setup
problem in either the PC or 1133A. For extra help with configuring Ethernet settings, see
Appendix A.

7.3.2 Check the Computer Network Settings with ipconfig

In Windows 2000 or XP, type “ipconfig” at the command prompt. It should list the DNS
information, IP address, Subnet Mask and Default Gateway.

7.3.3 Ping the 1133A Port

One method of checking to see if a device has a valid connection through a network is to
ping it to see if it responds. Below is an example of “pinging” an 1133A at IP address
192.168.000.232, on the same network as the computer.

C:\ping 192.168.0.232

Pinging 192.168.0.232 with 32 bytes of data:

Reply from 192.168.0.232 bytes = 32 time = 15ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 4ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 9ms TTL=64
Reply from 192.168.0.232 bytes = 32 time = 12ms TTL=64

Ping Statistics
Packets sent = 4, Received = 4, Lost = 0 (0% lost)
Approximate round trip times in milliseconds:
Minimum = 4 ms, Maximum = 15 ms, Average = 9 ms

If there is no connection, then the ping test will time out, four times. Other connection
issues may be present, and results returned from the test. There must be a valid response
from “pinging” the 1133A for it to communicate using PSCSV�.

Additional information on trouble shooting Ethernet connections is given in Appendix A:
Working with Ethernet Connections.

7.4 Configuring Measurement Parameters

Measurement Parameters include all of the values stored in 1133A for defining the
measured electrical system, for calibration, to compensate for measuring the primary
currents and voltages, and many other constants. These are depicted in Figure 7.3, which
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has a number of selection tabs described below.

� DSP Mode - Sets the measured electrical system values (e.g. voltage, current,
system phase(s) and nominal frequency. See also Figure 5.11 on page 34 for display
examples.

� CTPT - sets calibration points for Current Transformers and Potential Transformers
� Loss Compensation - Compensates for copper loss and hysteresis in transformers.
� Anti-Creep thresholds set the minimum value at which the meter begins to “turn.”
� Internal Calibration - Sets the 1133A internal calibration constants; set by the

factory.
� Voltage Linearity Correction - Helps compensate for non-linear variations in

calibrated values.

Figure 7.3: Measurement Parameters Configuration Screen

1. Make certain that there is an open connection with the 1133A and that you are
logged on with permission to configure. If you are not, see “Basic Configuration
Requirements” in the introduction of this section

2. Select Connection > Configure > Measurement Parameters or click the Measurement
Parameters button.

3. From the PSCSV� , select Connection > Configure > Measurement Parameters, or
click the Measurement Parameters button. Choose DSP Mode to select the type
of electrical system being measured. Allowed electrical systems are listed in each
category drop-down list. See also Section 3.2.3 for additional details on electrical
connections.

4. Select the CTPT tab to reveal the installation area and type in the required values.
These values should only be added after CT’s and PT’s are accurately characterized.

5. Select Loss Compensation to install transformer constants for transformer secondary-
side metering, if it is used.

6. Select Anti-creep to set the minimum meter recognition values; select one for each
phase.
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7. Do not select Internal Calibration - These are factory-installed, internal calibration
values used to standardize the 1133A accuracy.

8. Click Apply to install these values and OK to close the window.

7.5 Configure Ports - IRIG-B

To configure the IRIG-B output from the 1133A requires only two settings be configured:
Time Mode set to UTC or Local, and select the 1344 Mode turned ON or OFF. The
screen shot in Figure 7.4 illustrates where to adjust these settings. The 1344 Mode refers
to the IEEE 1344 specification for Phasors.

Click the Time Mode arrow and choose either UTC or Local. UTC stands for Universal
Time Coordinated and is based on the Prime Meridian that passes through Greenwich,
England.

Figure 7.4: Configure IRIG-B Settings

IEEE-1344 MODE ON

Click the 1344 Mode arrow and select either Disable or Enable. When enabled, the
IEEE-1344 turns on the CF (Control Function) portion of the IRIG-B code, which
includes the following items:

� Year - two digits
� Leap Second Pending (LSP) - 1 bit
� Leap Second (LS) - 1 bit
� Daylight Saving Pending (DSP) - 1 bit
� Daylight Saving Time (DST) - 1 bit
� Time offset sign - 1 bit
� Time offset - 4 bits
� Time Quality - 4 bits
� Parity - 1 bit
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IEEE-1344 MODE OFF

When Disabled the IRIG-B time code is sent without the extra values in the Control Func-
tion group. Only the BCD (Binary Coded Decimal) and SBS (Straight Binary Seconds)
are transmitted.

7.6 Configure Ports - DNP 3.0 Protocol

DNP3 (Distributed Network Protocol) is a set of communications protocols used between
components in process automation systems. It is mainly used by utilities such as electric
and water companies. When configured, the 1133A will respond to commands for data
using DNP 3.0 protocol. Appropriate application software is required (i.e not PSCSV�)
to send commands and respond to data being sent by the 1133A.

Configure DNP 3.0 through the Configure Ports window shown below. DNP data can be
accessed through SERIAL 1, SERIAL 2, and the Ethernet port. The PSCSV� interface
allows you to configure all of the settings necessary for using your DNP 3.0 utility.

1. Make certain that there is an open connection with the 1133A and that you are logged
on with permission to configure. If you are not, see Basic Configuration Requirements
in the introduction of this section.

2. Select Connection > Configure > Communication Ports or click the Communication
Ports button. In the left panel, select the port that you wish to configure. In
the selection below (see Figure 7.5), Communications Port 1 was selected and the
Protocol drop down list revealed.

3. Configure DNP scaling values from the same (Configure Ports) window, however
move down the list on the left panel and select DNP. This will open another panel
for DNP Settings. See Figure 7.6 for details on DNP Settings. Choose appropriate
values and click OK.

Max App Frag Size refers to the size in bytes of application messages packaged into frag-
ments, and may be up to 2048 bytes.
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Figure 7.5: Selecting DNP in COM Port 1 Setting

Figure 7.6: Configuring DNP Settings

7.7 Configure Ports - Modbus

Modbus is a serial communications protocol published by Modicon in 1979 for use with its
programmable logic controllers (PLC’s), and is now the most commonly available means
of connecting industrial electronic devices. To configure the 1133A to communication
using Modbus protocol, you will need to configure the desired port to use it and then set
some simple configuration options.

To receive data from the 1133A using Modbus protocol, you will need to be using a specific
application software tool that is designed to communicate using Modbus. PSCSV� does
not communicate using Modbus.

1. Open the Configure Ports window and select the port you wish to use on the left
panel. On the right panel choose Modbus protocol. The configuration screens for
Communication Ports 1 and 2 differ somewhat from Ethernet. In Figure 7.7 below,
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Communication Port 1 is selected. For Communication Port 1 and 2, select Protocol
Modbus. For Ethernet, select Modbus ON.

Figure 7.7: Selecting MODBUS in COM 1 Settings

2. After selecting the protocol for the port, select the Modbus item on the left panel.
Choose the Address value (See Figure 7.8) and click OK.

3. Notice that in Figure 7.7 that RTU Mode is selected. The other choice is ASCII
Mode.

Figure 7.8: Configuring MODBUS Settings
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7.8 Configure Ports - C37.118 Synchrophasor Protocol

Purpose and Background

The purpose of this section is to provide the details of how to configure the 1133A to
use the C37.118 specification for synchrophasors. Do not try to use PSCSV� as an
application for receiving or recording actual C37.118 data. Use a specific application for
that. PSCSV� can be used to view C37.118 type phasor data, however certain elements
are missing or added that support PSCSV� protocol that do not comply with the C37.118
specification.

7.8.1 Setup

To set up the 1133A to communicate using C37.118, you will need to configure the port
being used for C37.118, and set up some values used by C37.118. This will normally take
two or three steps, which are outlined below.

Basic Steps in Configuring C37.118 Synchrophasors

� Use PSCSV� to configure the desired 1133A port for C37.118 protocol

� Use PSCSV� to configure PMU-1, PMU-2 (or both)

� Start your PDC application, or C37.118 software

Details

1. Connect to the 1133A using PSCSV� software and make sure you have permission
to configure.

2. From the left panel in the Configure Ports window, select the desired port with
which you wish to communicate - Communications Port 1, 2 or Ethernet. Select the
Protocol as C37.118.

3. In the left panel, under PMU-1 C37.118, Protocol, choose TCP, UDP or Disabled.
Also, if desired choose the port number.

4. Next, you will need to configure each of the PMUs. These are listed as PMU-1,
C37.118 and PMU-2 C37.118. There are various items that need consideration in
this section and will take a little more time explaining.

7.8.2 PMU Setup Terms and Definitions

The definitions for the terms found in the PMU-1 and PMU-2 setup window are shown
in Figure 7.9. Open the window by selecting Connection > Configure > Communication
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Ports, or by clicking the Configure Ports button and selecting PMU-1 or PMU-2.

Figure 7.9: PMU-1 Configuration

Active means that PMU-1 or PMU-2 is poised and ready to send data - set to ON if you
want it to be active. Set to OFF if you want it to be inactive (or unresponsive).

Station (or STN) is the station name, in 16 bytes in ASCII format, given to either of the
two virtual PMUs.This field helps to identify the location of the equipment.

ID (or IDCODE) is the 16-bit integer, assigned by the user that uniquely identifies the
device sending and receiving messages (like the 1133A). No two devices can have the same
ID on the same network.

Header contains additional information on any subject concerning the PMU, of 64 bytes
in ASCII format. Type in the information and press the Enter key. This field could be
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used to identify the type of equipment.

Input allows you to select the type of signals you want to include in the C37.118 report
or broadcast. This includes all phase voltages and currents, Positive Sequence, Negative
Sequence, Zero Sequence components and Digital DSP Triggers. Turn them ON or OFF.

Analog allows you to select all of the power-related parameters (Watts, VARs, and VA)
that you wish to view and turn them either ON or OFF.

Window Length sets the integer number of measurements averaged for stability; if you
choose 1 for example, the values will update quicker, however appear less stable; values
range from 1 to 24.

Estimated Rate, Hz is the integer number of samples per second. Rate values are
different for 50 Hz and 60 Hz.

Cycles Used is a calculated value based on multiplying the Estimated Rate (R) times
the number of cycles, or Window Length, (W) times the Number of Channels (N). R x W
x N. For example in the screen shot from the previous page, this value is 20 x 10 x 6 =
1200, where N equals three voltage and three current channels. Maximum values are 6000
for 60 Hz and 5000 for 50 Hz.

Data Format allows you to set up the computation resolution and speed of which the
1133A processor can send data

Nominal Frequency – choose either 50 Hz or 60 Hz nominal

Adaptive Tuning is used to help eliminate the possibility of losing the signal due to filter
rolloff effects by continuously adjusting the receiver center frequency. Adaptive tuning is
disabled if the error exceeds the limit. Set to 2, 5 or 10 Hz.

7.8.3 Window Functions

The Model 1133A offers a wide range of of window functions, which may be optimized for
individual applications. Specifically two items in the setup window combine to provide
windowing function: Estimator Algorithm and Window Length in cycles.

Window functions all serve the same purpose (as a low pass filter) and work in the same
basic way to filter higher frequency components. The main difference is the magnitude of
the sideband lobes,which are peaks in the rejection band.

Window functions are also called weighting functions because they work by multiplying
the input signal time record by an equal-length sequence of constants, or weighting factors.
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Estimator Algorithms include nine types, as listed below.

Raised Cosine Hann Hamming Blackman Triangular

Rectangular Flat Top Kaiser Nutall 4 Term

To better evaluate the Window Functions, use the Window Function application1 to test
and view the different Estimator Algorithms and Window Lengths in cycles. Shown in
Figure 7.10 are two plots from the Window Function application. Window Function allows
you to select Window Length and Estimator Algorithm.

Figure 7.10: 8-Cycle, Raised Cosine Rejection Plot and 6-Cycle Rolloff

For additional information on the different window functions please see the C37.118
Synchrophasor Specification and the WindowFunction.exe software tool.

Digital Channels assigns the specific DSP Trigger information to be sent along with
phasor data as seen in the configuration window shown in Figure 7.11. Check boxes allow
the user to select for two values:

Normal State tells whether the specific trigger is normally Active (checked) or Inac-
tive (unchecked). Triggered State tells whether to show the Trigger (checked) or not
(unchecked).

PSCSV� is a Configuration Tool

It is worth restating that PSCSV� is a tool used to configure the C37.118 phasor
broadcast features in the 1133A. To download synchrophasor data in C37.118 protocol,
you will need a separate software application designed for that purpose.

1Log on to the Arbiter ftp site (http://www.arbiter.com/ftp/software/) to download WindowFunc-
tion.exe
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Figure 7.11: Selecting Digital Channels in C37.118

7.8.4 Setup Example - Ethernet

The following example should illustrate how to set up the 1133A using PSCSV� for specific
synchrophasor data type, using the data found in Figure 7.9. Before actually setting up
the synchrophasor window, make sure to first configure the Nominal Frequency on the form.

1. Click Ethernet on the left panel of the form.

2. Check the port parameters, including protocol and port number. The available
choices for protocol are UDP, TCP or Disabled.

3. On the left side of the Configure Ports form, select either PMU-1 or PMU-2.

4. PMU-1 was selected (see Figure 7.9) and start at the top

5. Make sure to select ON for Active. Otherwise, you will not see any data.

6. Give a name for Station, such as 1133A PMU-1

7. For Station ID (IDCODE) give a unique number to the 1133A, from 1 to 65535. This
is the actual code that identifies this specific equipment.

8. Though not required, you can type in some additional information in the Header field
to further explain this particular equipment, location, situation, etc.

9. Under Input, enable all of the data types that you wish to see in the output; include
Analog values as well. Set these values to either ON or OFF.

10. Window Length is an important setting, as it will control the stability of the reading.
If you select a small value (e.g. 1) the readings may tend to jump around and appear
unstable.

11. Set Estimated Rate to tell the 1133A to send the desired number of phasors samples
per second. It is set to 30. In all cases, the rate is always an even multiple of the
nominal frequency.
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12. Cycles Used (calculated by PSCSV) is a product of the Window Length times the
Estimated Rate times the configured number of input signals (e.g. three currents and
three voltages). This gives 6 x 30 x 6 = 720.

13. Choose the data format as either 32-bit floating point or 16-bit fixed point.

14. Choose Adaptive Tuning if needed to 2 Hz, 5 Hz or 10 Hz. Otherwise leave OFF.

15. Set the Estimator Algorithm according to the desired window filtering features of
each filter type. See Window Functions on the previous pages for more information.
To view the actual filter bandwidth, use the Window Function graphical software
tool to plot out the specific Estimator Algorithm.

7.9 Configuring UDP Broadcasting

UDP Broadcast mode configures the 1133A to transmit selected data items over the
1133A Ethernet port at the following rates: (1) Waveform data are broadcast at 20 times
per second (2) C37.118 Synchrophasor Data is broadcast according to Estimated Rate in
PMU-1 or PMU-2 setup (see Figure 7.9), (3) all the others are sent out once per second.
Once set up through PSCSV� , the 1133A will broadcast data until it receives a stop
transmit command (for certain modes) or reconfigured to stop broadcasting. The UDP
setup window shows the available selections for UDP Broadcast.

7.9.1 UDP Output Types for C37.118

In the 1133A, UDP is designed for transmitting data only, not receiving. To configure
UDP, or to start/stop UDP broadcast types, use a TCP connection. Listed in Table 7.1
below are the types of valid Ethernet connections and UDP output types for C37.118
Synchrophasor data. Autonomous mode means that the 1133A will always send C37.118
UDP data unless configured otherwise. The start/stop transmit commands will be ignored.

Figure 7.12: Shows C37.118 PMU-1 set to broadcast UDP
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Connection Type UDP Output Type

TCP to TCP UDP Off

TCP to TCP UDP Broadcast

TCP to TCP UDP Multicast

TCP to TCP UDP Unicast

TCP to TCP UDP Broadcast Autonomous mode

TCP to TCP UDP Multicast Autonomous mode

TCP to TCP UDP Unicast Autonomous mode

Table 7.1: C37.118 Connection and UDP Output Types

7.9.2 Procedure

1. Make certain that there is an open connection with the 1133A and that you are
logged on with permission to configure. If you are not, see “Basic Configuration
Requirements” in the introduction of this section.

2. Select Connection > Configure > UDP Broadcast or click the Configure UDP Broad-
casting button.

3. Select the desired broadcast data type. Click the Apply button and OK to close.

4. The specific data are now being broadcast from the 1133A Ethernet port for an
unlimited number of users.

5. Data may be viewed in various ways, including Spreadsheet, Real time, Phasor Vector
or Frequency Plot, depending on the data type.

7.10 Configuring Multi-Mode Relays

Configure the four multi-mode relays using the Configure Relay Parameters window.
Connect to these relays at the rear panel of the 1133A at the location labeled “Contact
Outputs.” For additional detail on relays, see Chapters 3 and 12.
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There are seven configuration choices available: Inactive (default); User Schedule, No
Override; User Schedule, Override; Communications; One Pulse Per Hour; Trigger; KYZ.

To open the Configure Relays window, click the Configure Relays button or select Connec-
tion > Configure > Relay Parameters. Select one of the four Relays to select the mode.
In Figure 7.13, Relay 1 Mode is selected as “User Schedule, No Override.”

Figure 7.13: Configure Relay Parameters

7.10.1 Configuring User Schedule Mode

1. In the User Schedule mode, relays are activated by timed events that are defined by
first selecting the User Schedule button for the specific relay and then selecting “User
Schedule” to specify the times, date, and ON / OFF conditions.

2. Select a relay (e.g. Relay 1 Mode) and select one of the User Schedule modes.

3. Select User Schedule from the left panel at the bottom; if nothing is scheduled, the
right panel will be blank.

4. Click the Add button to add a new schedule to the relay. Click the UTC Date to
open a selection calendar. Select the relay to which it applies and specify whether
the relay is scheduled ON or OFF.

5. Repeat the previous step to add new or remove unnecessary scheduled relay events.

6. When finished scheduling relays, click Apply and OK to close the window.

7.10.2 Configuring Pulse-Per-Hour Mode

1. Select Pulse Per Hour mode by first selecting the relay and checking “One Pulse Per
Hour” in the right panel. See Figure 7.13

2. Now, click the + sign to the left of the desired relay and choose “Pulse Per Hour” in
the tree below the relay. On the right panel, adjust the offset if desired. Click OK
when finished. See Figure 7.14.
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Figure 7.14: Configure Pulse-Per-Hour Mode

7.10.3 Configuring KYZ Pulse Metering

1. Select KYZ mode by selecting the specific relay and choosing “KYZ Only.” See Fig-
ure 7.15. Click the + sign to expand the sub-tree to reveal the modes. Select “KYZ
Output” under the relay and then select the energy value for recording.

Figure 7.15: Configure KYZ Mode

2. Click OK to install KYZ Outputs and close the configuration window.

3. To scale the KYZ Register Scale Factors, select Connection > Configure > Kp Reg-
ister Scale Factors or click the Kp button. Kp register scaling is explained below
under Kp Register Scale Factors.

4. Under “Value,” select the (Scheduled) Value corresponding to the Description and
type in the scaling constant (see Kp Register Scale Factors below for details).

5. Click Apply to install the value(s) and click OK to close.

CAUTION: Solid-State KYZ relays (Option 06) should be ordered and installed prior to
configuring KYZ outputs. Standard mechanical relays are not rated for KYZ operation.
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7.10.4 Kp Register Scale Factors

Correct Kp register scale factors are necessary for accurate KYZ pulse metering. Use the
“Configure Kp Register Scale Factor” interface shown in Figure 7.16 to set these.

Figure 7.16: Configure KYZ Scale Factors

Kp Register Scale Factors are expressed in basic units (e.g. Watt Hours per Pulse) and
should be set up not to exceed 20 pulses per second, the limit of the 1133A. To arrive at
the minimum Scale Factor value so not to exceed this threshold, take the maximum value
of the basic unit being measured and divide by 72,000. This should give you the absolute
limit (minimum value) for a Kp scale factor. Practical scale factors should exceed this
minimum value so not to unnecessarily lose information.

For example, if the maximum input value (including CT-PT ratios) is 240 kWh, then the
minimum scale factor for Watt Hours should be greater than 3.3333333 (240,000 ÷ 72,000
= 3.333...). The value produced is the Kp Register Scale Factor (e.g. 3.333 Wh per pulse).
Scale Factors will be directly proportional to the value measured. Therefore, the greater
the measured value, the greater will be the minimum Scale Factor.

Kp Over-Range Condition: An over range input condition will exceed the 20/second
output capability of 1133A, causing KYZ pulses to stabilize at that rate. If this is the
case, for momentary periods, the accumulator in the 1133A will store these counts and
not degrade the Model 1133A 0.025% accuracy. If data has accumulated in the 1133A,
then when the signal has dropped below 100% (by Kp Scale Factor) the output will put
out the additional pulses until the accumulated overage equals zero.
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7.10.5 Configuring Relays for Trigger Mode

Trigger Mode is chosen in the same manner as KYZ mode except that the Relay Mode
must be selected as shown in Figure 7.13, and the triggered values must be selected from
the Configure Triggers Parameters menu as shown in Figure 7.17. Triggers may be User
(DSP), Power Quality or System Triggers.

Figure 7.17: Configure Relays for Trigger Mode

7.10.6 Configuring and Using Communication Mode

1. Select a relay and select Communications Mode button on the right panel.

2. When ready to manually switch the relay, select Manual Override Relay at the bottom
of the left panel and click either Open or Close to switch the relay as shown in
Figure 7.18.

Figure 7.18: Configure Relays for Manual Override Mode
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7.11 Configuring Position and Time

Use the Position and Time window to set up Time Preferences, and to assist the GPS
receiver during initial start up. See Figure 7.19. Time preferences are for the 1133A front
panel display only. All timing of measured data (whether exported or stored) is according
to UTC.

1. Make certain that there is an open connection with the 1133A and that you are
logged on with permission to configure. If you are not, see “Basic Configuration
Requirements” in Section 7.1.2.

2. Select Connection > Configure > Initial Position and Time and a window will appear
holding the position settings and time references. No menu button exists for this
function.

3. For first time startup only, select in the Latitude or Longitude window to enter
approximate geographical positions. For example (as latitude) N:035:00:00:000.

(a) Latitude values are specified as North or South:Degrees(0 - 90):Minutes(0 -
59):Seconds(0 -59) milliseconds(0 - 999).

(b) Longitude values are specified as East or West:Degrees(0 - 180):Minutes(0 -
59):Seconds(0 -59) milliseconds(0 - 999).

Figure 7.19: Configure Position and Time

4. Select in the Local Time Offset window to select the time difference between UTC
and the Local time zone. For example, Pacific Standard Time is normally set to
-8:00; Eastern Standard Time is normally set to -5:00.

5. Select the Time Display radio buttons for either UTC or Local; this sets the display
on the 1133A to either UTC or Local.
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6. Select the drop-down button for Daylight Saving Mode and set to either ON or OFF.
Currently, the “Auto” mode does not correctly adjust the time due to the recent
government changes in DST. To view the correct local time on the front panel of the
1133A, you will need to adjust the daylight saving setting manually ON or OFF.

7. Change Over sets the time when Daylight Saving is automatically implemented. It
is not effective without using the Auto setting (see notes above).

8. Click Apply to install preferences and then OK to close the window.

7.12 Configuring Scheduled Data

Use this function to define the types of scheduled data to be saved to flash memory. This
menu also includes the measurement interval. See “Working with Scheduled Data” in
Chapter 10 for a complete list of scheduled values.

1. Make certain that there is an open connection with the 1133A and that you are
logged on with permission to configure. If you are not, see “Basic Configuration
Requirements” in Chapter 6.

2. From the main menu, select Connection > Configure > scheduled Data or click the
Configure scheduled button to access the configuration window shown in Figure 7.20.

Figure 7.20: Configuring Scheduled Data Screen

3. Select from the list of values, the items to be stored as “scheduled” in flash memory.
Access the five scheduled categories using the buttons at the top of the configuration
window.

4. For each set of items (e.g. Energy) select the measurement interval window, which is
the recording rate. Choices include 1, 5, 10, 15, 30 and 60 minutes. Do this for each
category.
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5. Click Apply and a new template will be created in flash memory for storing scheduled
records.

6. Click Apply and OK to close the Configure Scheduled window.

NOTE: After selecting OK, a message will inform you that the flash partition used to
store Scheduled records will be erased.

7.13 Configuring Time Deviation

The 1133A calculates the electrical system time deviation, in seconds, by comparing it to
GPS time. It also displays the electrical system frequency and compares it to a reference
60 Hz signal within the 1133A. These are all displayed on the front panel using the
FREQ./TIME DEV. button. If it is necessary to offset the system time with a value equal
to a known deviation, configure it using this function.

Figure 7.21: Configuring Time Deviation Screen

Select Connection > Configure > Set Time Deviation to access the Time Deviation
window, shown in Figure 7.21. Type in the required value in seconds and click Apply and
then OK.

For information on Frequency and Time Deviation, see “Frequency / Time Deviation Key”
in Section 5.2.2. To view the time deviation from the front panel, press the FREQ./TIME
DEV. key.
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7.14 1133A Security – Setting Up User Accounts and Per-
missions

7.14.1 Introduction

Read this section to understand and use the various aspects of 1133A Security. This
includes setting up and managing User Accounts and granting permissions. Security
information is divided into two parts: Overview of Security, and Using Security.

7.14.2 Security Features

� Up to 14 user login names can be added
� Up to 8 character, case-sensitive login names and passwords
� Each login name can have any combination of permissions listed below
� PSCSV� automatically logs in connections using a special login name anon

7.14.3 An Overview of 1133A Security

In order to protect the operating performance of the 1133A and the proprietary nature
of data stored within the 1133A, PSCSV� provides users with several security features.
1133A Security allows the administration of up to 14 separate user accounts, and provides
oversight in configuring them on the 1133A Power Sentinel.

Since the Model 1133A allows access to its various features based assigned permissions,
a system administrator can make sure each user has the appropriate access necessary to
perform each task. There are two components that grant the user access to the various
features in the 1133A; these are a Login Name, and a Password. To grant specific privileges
to each user, Permissions are granted within a protected configuration interface. Any user
with Administer Permission can set up user accounts. PSCSV� does not automatically
open a connection with the Model 1133A when it starts. It is up to the user to choose and
open a specific communication channel. Once PSCSV� has started, you must attempt to
open one of several connection types for the 1133A to operate correctly. If PSCSV� is
successful in opening a connection, it initially logs on to provide basic functionality with
the 1133A. It is then up to the user to log in with another user name and password, which
provides the required functionality.

Initially, PSCSV� logs in to the 1133A under the Login Name “anon,” which allows only
the downloading of Basic Data. At the other extreme, you can administer new permissions
and gain full access, using the Login name, “admin.” admin allows the highest level of
security. Details of these two permanent accounts follow. Once logged in under user name
“admin” the user can set up new, edit or delete user accounts.

If Security is not an issue, please see “How to Disable Security” in Section 7.14.9 for
information on how to edit security settings so that everything is available upon initial
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connection. Thus, when initially logging on, all functions are available.

7.14.4 Security Specifications

Function Permission Allowed Operation

Login Take up a communication channel. If this is not set,
none of the others are relevant.

Receive Data Receive all broadcast messages and query messages

Download Scheduled Download all or specified Scheduled

Erase Scheduled Erase all Scheduled

Configure All configurations that are not security related

Administer Add/Edit/Delete users - all other functions

Table 7.2: Security Definitions

Login Name Default Operations Default Password

admin Everything 801n60 (can be changed)

anon Log in, Receive Data ******** (can be changed, but only
recognizes this password when ini-
tially logging on).

Table 7.3: Permanent Login Information

7.14.5 Using Power Sentinel Security

When connecting to the 1133A, PSCSV� always logs in initially to the 1133A under
the user name, anon. anon allows the most basic level of operation, giving permission to
download any of the Broadcast Data items listed. If other functions are needed, then the
user must log in under another Login Name and Password that grant permission to use
them.

7.14.6 Changing the admin Password

1. Select Connection > Login As, or select the Login As button (key symbol) on the
Connection Toolbar to open the Login Window.
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Figure 7.22: Security, User Permissions
Window

2. Type the word admin in the Login Name window. Tab to the Password and type
801n60 - note that all of the values in 1133A security are case sensitive. Click Login.
All permissions are now granted, including Administer.

3. Select the Connection > Configure > User Logins to open the Configure User Logins
window. Tab to the Password window and type in the new password, up to eight
characters. Remember that passwords are case sensitive.

4. When finished, select Apply to install the new admin password, and OK to close the
Edit User window.

7.14.7 Setting Up New User Accounts

To set up user accounts and permissions, you will need permission to administer. To get
permission to administer, you will need to open the Configure User Logins screen.

1. Select Connection > Login As, or select Login As (the key symbol) on the Connection
Toolbar to open the Login window. Type in the Login Name, admin (or other Login
Name with Administer permission).

2. Tab to the Password window and type in 801n60 (or the new Login Name and
Password with permission to administer) - note that all values in 1133A security
are case sensitive.

3. Select OK, and the desired functions should be available, seen by the buttons acti-
vating (changing color). Select Connection > Configure > User Logins to activate
the Configure User Logins window seen in Figure 7.22.
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4. Select New to start a new user account. PSCSV� will supply a default Login Name
that may be changed. Type in the new Login Name and Password in the windows
provided. Check the appropriate boxes to enable / disable the desired permissions.
Repeat this step to add any other accounts.

5. Select Apply to install these new accounts, and click OK when finished to close
the Edit User window. All of the new Login Names and Passwords should now be
installed into the 1133A with which you were communicating.

KEEP AN ACCURATE RECORD OF THE NEW USER NAMES AND
PASSWORDS.

7.14.8 Deleting User Accounts

1. Select Connection > Login As, or click the Key symbol, to activate the Login window.
Log in with an account that grants permission to administer. (All of the icons in the
PSCSV� window should appear.)

2. Select Connections > Configure > User Logins to activate the Configure User Logins
window. Select the drop-down window under Login Name. Select the user account-
name to be deleted, and click Delete. In the same manner, delete any other accounts
if needed. The user name(s) will be deleted.

3. Click the Apply button to update the 1133A account list and click OK to close the
Configure User Logins window.

7.14.9 How to Disable 1133A Security So That Everything is Available

If security is not an issue, the 1133A can be configured to allow total accessibility.

1. Open a connection between the 1133A and a computer. Login with an account that
grants permission to administer.

2. Select Connection > Configure > User Logins, and select the Login Name anon.

3. Under Advance Permissions, select Administer (all other permissions will be selected).
Click the Apply button and PSCSV� will update the 1133A, then update itself with
the new security information from the 1133A. Click OK to close the Configure User
Login window.

4. Test out the new login name by logging in under the user name, anon; everything
should be available.
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7.15 Flash Memory Management

7.15.1 Introduction

In this section of the Tutorial you should find basic information on how to work with
various aspects of flash memory in the 1133A or direct you to other sections in which
they apply. Each 1133A has 16 Mbytes standard, or 32 Mbytes optional, of flash memory
set up to store Scheduled Data and Event Data records. Flash memory in the 1133A is
contiguous, but the user may determine the partition sizes for each of two categories. One
reason for this approach is so that pure Scheduled data (that is regularly downloaded for
billing) is not mixed with event data.

7.15.2 Flash Memory Functions

Listed below are all of the Flash-Related functions in the Model 1133A that are controlled
through PSCSV� . The details of working with each of these specific flash-related functions
are listed below or referred to elsewhere in this chapter.

� Flash Memory Security
� Configuring Flash Memory for Scheduled and Event Storage
� Checking Flash Memory Status
� Erasing Flash Memory
� Downloading Scheduled Data
� Erasing Scheduled Data
� Downloading Event Data
� Erasing Event Data

7.15.3 Flash Memory Security

To access 1133A flash memory features, permission must first be granted through 1133A
security. Security features protect the integrity of and guard access to records stored within
the 1133A flash memory module. It also guards against the inadvertent reprogramming
of the 1133A. Administrators can setup various security levels to limit users access to
memory and the 1133A configuration. Since records can readily be erased, it is important
to understand and set policies for the usage of flash memory in the 1133A. For more
information on granting permissions, see “1133A Security.”

7.15.4 Configuring Flash Memory

The Configure Flash window is only available with permission to configure; it is otherwise
unavailable from the Connection menu or from the User Login button.
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Figure 7.23: Configure Flash Window

1. Open connection between the 1133A and computer using PSCSV� . Log on to the
1133A with permission to configure. If necessary, see “1133A Security.”

2. Select Connection > Flash Memory > Configure from the main menu or click the
Configure Flash Memory button to open the Configure Flash menu.

3. Click and hold the sliding pointer to increase or decrease the percentage of memory
allocated for Scheduled and Event data. Actual percentages are given above the
pointer.

NOTE: Even though the available memory is given as a percentage of the total
flash module, it is incremented in discrete, 64-Kbyte steps.

4. Select the desired procedure in the event that Flash Memory is full - for either
partition. PSCSV� allows you two options when the section of flash memory is full.
Make this choice in the radio buttons at this time.

� to overwrite existing data, or
� to stop writing data

5. Click Apply and OK when finished configuring flash.

NOTE: Anytime flash memory is configured the contents are erased.

7.15.5 Checking Flash Memory Status

Check the Flash Memory Status prior to configuring Scheduled data in case data being
stored there may need to be saved. It may be advisable to download existing data prior to
configuring flash for any reason, as configuring flash memory will erase any existing data.
See Figure 7.24.
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Figure 7.24: Flash Status Window

1. Open a connection between the 1133A and computer using PSCSV�.

2. Make certain that no downloading of Scheduled or event data is in process.

3. Click the Flash Memory Status button on the Flash Toolbar or Select Connection >
Flash Memory > View Status from the main menu.

4. Scheduled and Event Data share the Flash Status window. This window will indicate
the amount of memory already occupied by scheduled and event data and the amount
of memory that is left open for additional storage. The amount is given in percentage
of the total available memory for each category and in numerical days.

5. If viewing for an extended period of time, click the Refresh button to update the
data in the Status window. Data statistics in the status window will change based
on the settings made for recording both Event and Scheduled data.

6. After viewing Flash Status, click the OK button to close the Flash Status window.

7.15.6 Erasing Flash Memory

To erase the entire contents of flash memory in the 1133A, click the Erase Flash button
or select Connection > Flash Memory > Erase ALL. The erasing process should normally
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take a few minutes with a full memory module. No partial erasures are allowed.

Figure 7.25: Erase Flash Window

7.15.7 Downloading Scheduled Data

To download scheduled data, click the Download Scheduled button, or select Connection >
Flash Memory > Download Scheduled. Download time depends on the type and quantity
of records, and the type of serial connection. For more information see “Downloading
Scheduled Data” under “Working with Scheduled Data” in Chapter 10.

7.15.8 Erasing Scheduled Data

To erase the contents of flash memory allocated to scheduled data, click the Erase
Scheduled button or select Connection > Flash Memory > Erase Scheduled. The process
should normally take of few minutes with a full memory module. For more information,
see “Erasing Scheduled Data” under “Working with Scheduled Data in Chapter 10.”

7.15.9 Downloading Event Data

Downloading Event Data involves the same process as downloading Scheduled Data
mentioned above. During this process, records first collect under their assigned category.
Then, each group is accessed from the primary window for saving to a separate file. For
more information, see “Working with Triggers and Downloading Event Data” in Chapter 8.

7.15.10 Erasing Event Data

To erase the section of flash memory allocated to event data, or select Connection > Flash
Memory > Erase Event. The process should normally take a few minutes with a full
memory module. For more information, see “Erasing Scheduled Data.” The information
for erasing Event Data is very similar to erasing scheduled data and the window dialog is
the same.
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Working with Triggers and
Downloading Event Records

8.1 Introduction to Triggers and Events

Triggering is one of the most useful features in the Model 1133A because it allows you to
capture and store transient conditions of the measured signal. Besides recording the exact
time and date of a power-line disturbance, all of the measured data parameters may also
be recorded. Thus, you have a complete record of the conditions surrounding the recorded
event. Trigger records are normally stored in flash memory but may also be transmitted
over one of the data connections as they occur.

NOTE: If you are configuring any triggers for the first time, please read through this
entire section, and make sure that some flash memory has been partitioned for event data.
Any time you change the trigger configuration, the entire flash memory partition devoted
to Triggers will be erased.

1. Make certain that there is an open connection with the 1133A and that you are
logged on with permission to configure. If you are not, see “Basic Configuration
Requirements” in Section 7.1.2.

2. To partition flash, click the Configure Flash Memory button and move the slider to
set the partition size. Click OK to accept or Cancel to decline.

3. From the main menu of PSCSV�select Connection > Configure > Trigger Parameters
or click the Configure Trigger Parameters button.

The Model 1133A subdivides triggers into two main groups: User Triggers and Power
Quality Triggers. Another group of triggers, called “System Triggers,” gives you a method
to monitor the 1133A systems themselves.
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8.2 Configuring User (DSP) Triggers

Configuring triggers in the Model 1133A involves setting up the triggering conditions
and the type of data you want recorded when the event occurs. When a triggering event
occurs, the selected electrical parameter meets the triggering conditions and the trigger is
considered Active. When the triggering event no longer meets the conditions, the trigger
is considered Inactive. Use the Configure Triggers window to set up all of these conditions.

8.2.1 User Trigger Parameter Definitions

Input Signal: Consists of the measured signals and parameters, such as Voltage, Current,
Watts, VARS, which are compared to the limit.

Channel: The phase of input signal, noted as A, C, B and Ave, or other values, such as
frequency or phase deviation, as uniquely required.

Limit Type: The logical condition used to compare the Limit and the Input Signal (x);
x > limit, x < limit, |x| > limit, |x–ref| > limit.

Limit: A floating point value to which the Input Signal (x) is compared.

Reference: A floating point value used with the Limit Type, |x–ref| > limit, for the value
of ref. Can be used in a window comparison.

Dependency: Selects the Master Trigger state. Values are Off, ActiveMaster, Inactive-
Master; Off turns off the Master Trigger feature. Use the other two values to set up the
Master Trigger condition.

Master: Assigns the specific Trigger number (1 - 32) as the Master Trigger. Set up the
Master Trigger prior to the dependent trigger or the Master Trigger number will not be
available.

Dwell Time: Defines the interval in seconds during which the triggering condition is true
before the trigger becomes Active.

MaxLogTime: Sets the time in seconds that the 1133A will log data after the trigger
becomes Active. Time is from 0 to 65535 seconds.

PostFault: Sets the time in seconds that the 1133A will log data after the trigger has
become Inactive. Time is from 0 to 65535 seconds.
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8.2.2 User Trigger Setup Procedure

1. To configure any User (or DSP) Trigger, click the plus sign to the left of “Triggers”,
then select User Triggers. This should expand the User Triggers configuration
window, shown in Figure 8.1.

Figure 8.1: DSP Trigger Setup Screen

2. Under “Input Signal”, select the adjacent drop-down arrow and choose the desired
parameter on which you want to trigger.

3. Under “Channel,” select the measurement channel (e.g. A, B, C, Ave., etc.), or
relevant value according to the Input Signal type.

4. Select Limit Function (x > limit, x < limit, |x| > limit, |x| < limit, |x-ref| > limit)
for the specific trigger. For example, to trigger for an event when the input signal
(x) drops below the assigned limit, select x < limit.

5. For Limit, type in a floating point value.

6. If using a reference value, click the Reference box and type in the floating point
value. Normally, you would use a reference value when the selected Limit Function
was |x-ref| > limit. In this example, ‘ref’ could be the nominal value, like 60 Hz.

7. Configure Dependency if you want one trigger to become Active only if another
condition becomes Active or Inactive. Always configure the Master channel first. For
example, if you want Channel 1 to trigger only if Channel 2 increases above a set
limit, set up Channel 2 (the Master channel) first.

8. Select a master channel number (1 - 32) under Master to set the dependency relation-
ship. For example, if in the previous step the Dependency was ActiveMaster, then
set Master to a number that this channel looks to for a triggered (Active) condition.
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9. Select the Dwell Time column to set the time that the triggering conditions must
be true before the trigger becomes Active. This could be used to help reduce false
triggers. Allowable values are from 0 to 3267.75 seconds.

10. Repeat steps 2 - 9 to set up any other triggers, especially if there are master trigger
channels and dependencies.

11. Move on to the next step in Section 8.4, Configuring Data Logged.

8.3 Configuring Power Quality Triggers

In the 1133A, Power Quality triggers conform specifically to methods and definitions
in IEC 61000-4-30, section 5.4, Supply–Voltage Dips and Swells. While Power Quality
triggers are set up in a manner very similar to User (DSP) Triggers, and are part of the
shared pool of 32 triggers, they are different than User Triggers due to the methods and
definitions mentioned above.

8.3.1 Power Quality Parameter Definitions

Channel: AV, AI, CV, CI, BV, BI, NI - includes all of the input voltages and currents,
including neutral current.

Limit Type: x > Limit, x < Limit.

Limit: A floating point value, constantly being compared to the input Channel value (x)
in order to capture an event trigger.

Limit Fmt: (Limit Format) Absolute or Percent; choose the limit format that suits your
application. For Absolute, the limit is the same number as the value entered in for Limit.
For Percent, the measured value is compared to a percentage of the measured signal, and
must be entered as a decimal value (e.g. 90% entered as 0.9).

Ref Fmt: (Reference Format) Absolute or Sliding; Absolute means that the reference
value is compared directly. Sliding means that Reference value is not fixed (or absolute)
and can change slowly, such as with a gradually rising or dropping voltage. See additional
details on following pages.

Hysteresis: Floating point value; reduces extraneous records from accumulating when a
measured value is dithering around a limit or reference.

Hysteresis Format: Absolute or Percent; Absolute refers to a fixed value for hys-
teresis, and Percent refers to a percentage of the measured value. As the measured
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value increases or decreases, so the hysteresis will change according to the given per-
centage of hysteresis. Percent must be entered as a decimal value (e.g. 90% entered as 0.9).

Multiphase: B, C, BC or OFF; means that the Trigger parameters will also apply to B
phase, C phase or both B and C phase, without defining another trigger.

8.3.2 Power Quality Trigger Setup Procedure

To set up the 1133A to trigger on Sags and Swells, you will need an open connection between
the 1133A and your computer; you may need to verify the settings on the 1133A. For more
information on opening a connection, please see “Basic Configuration Requirements” in
Section 7.1.2. For definition of Sags and Swells terminology, please read preceding pages
in this chapter.

Figure 8.2: Power Quality Trigger Setup Screen

1. At the top of the Power Quality setup screen are windows for typing in the Reference
values: voltage and current. Install any of these values if you are choosing Sliding as
the Reference Mode.

2. Choose a trigger Channel: Ch AV, Ch AI, Ch BV, Ch BI, Ch CV, Ch CI

3. Choose a Limit function: x > Limit or x < Limit.

4. Type in a numerical value for Limit.

5. Select the Limit Mode as Absolute or Percent.

6. Select the Reference Mode as Absolute or Sliding (see step 1 above).

7. Type in a value for Hysteresis, if desired, other than zero.

8. Select a Hysteresis Mode: Absolute or Percent.

9. Select Multiphase if you want to log data on the other phase(s) with a trigger from
Phase A.
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10. Type in an integer value for Dwell (in half cycles of nominal frequency).

Hysteresis

Hysteresis allows the user to set up triggering conditions to reduce the tendency for
a dithering signal (e.g. voltage) to generate unnecessary triggers. The figure below
illustrates a voltage dithering around about 130 Vrms, which is the set Limit for a trigger.
To avoid unwanted triggers occurring at points A, B, C and D, a hysteresis value of 2 was
chosen. This prevents a trigger from occurring unless the voltage drops at least 2 volts
below the Trigger Limit. For the trigger to again become Active (i.e. after point E), Va
would need to again cross the 130-Vrms Limit.

Figure 8.3: Hysteresis Plot

Power Quality Reference

For Power Quality Triggers with a sliding reference, install the Power Quality Reference
value, for each required channel, across the top of the Power Quality trigger setup window.
In this case, Reference refers to an initial, numerical voltage/current value, which is
preloaded into the Sliding Reference register.

Sliding Reference

Set the Reference Format to Sliding when you want to follow daily variations in voltage or
current that do not require a trigger unless the variation changes suddenly. For example,
if due to usage requirements the line voltage sags during the day and swells during the
night, you might want to use a sliding reference to avoid unnecessary triggers. A sliding
reference would generate a trigger only if the voltage unexpectedly sags or swells at a rate
greater than expected.
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Calculating a Sliding Reference Voltage

Per the specification IEC61000-4-30, the sliding reference voltage is calculated by using
the formula below, a first-order and a one-minute time constant.

Usr(n) = 0.9967 x Usr(n−1) + 0.0033 x U(10/12)rms

Where
Usr(n) is the present value of the sliding reference voltage;

Usr(n−1) is the previous value of the sliding reference voltage; and

U(10/12) is the most recent 10/12-cycle r.m.s. value.

Note that even though the specification defines the input signal (U) as a voltage, Arbiter
Systems has applied the specification to include measured input currents as calculated
using the same formula.

8.4 Logging Data when Triggers Occur

The “Data Logged” menus allow you to set up how the 1133A records data when an event
occurs. Also, to allow better control over which data is recorded with specific triggers,
there are eight channels to separate them. Using Channels, one trigger could be used to
start logging basic data and another trigger could be used to start logging phasor data.
Logging Data is easily up as follows:

1. Specify the Channel and Trigger(s) – User and/or System – associated with the
Channel.

2. Specify the Logging Parameters – data type and logging time.
3. Specify the data items recorded – based on data type.
4. Repeat the above three steps with other triggers.

NOTE: No actual data will be logged in the event of a trigger without configuring the
steps contained in this section.

Configuring System Triggers

Click the System Triggers button in the Data Logged window to open the list of dedicated
triggers available for the 1133A. System Triggers are mainly used to monitor the health
of the 1133A. See Table 8.1 for a list of system triggers.
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GPS Lock Power Interruption

External Event Inputs – 4 ea. Event Memory Overflow

Scheduled Memory Overflow Event Memory Nearly Full

Scheduled Memory Nearly Full System Configuration

Event Memory Erasure Scheduled Memory Erasure

Oscillator Tuning Voltage, Out of
Range

Leap Second Adjustment

GPS Time Differs from Clock Time GPS Time Sync Adjustment

Communication Port Fault – 2 ea Ethernet Port Fault

Table 8.1: System Triggers

8.4.1 “Data Logged” Procedure Details

Follow the instructions below to set up how the 1133A will log data when a specific trigger
becomes Active.

1. In the Configure Trigger Parameters window select Data Logged. See Figure 8.4.

Figure 8.4: Configure Data Logged Screen

2. With the cursor, select the desired trigger(s) for each channel. Right click on the
selection(s) and choose Check Selected in the pop-up window.

3. Select the System Triggers button (if required) and select the required system triggers
for the selected channel.

4. Click the Logging Parameters button to access the logging parameters for each chan-
nel. Select the Data Type – None, Basic, Harmonic, Harmonic Summary, Phasor
and Waveform – according to requirement. See Figure 8.5
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Figure 8.5: Configure Logging Parameters Screen

5. For Waveform Prefault Time, select from 0 to 6 in seconds; available for waveform
only - provides a prefault recording any time a fault is triggered.

6. For Maximum Log Time, of recorded data after the trigger becomes Active, select
from 0 to 65535 seconds.

7. For Postfault Time, of recorded data after the trigger becomes Inactive, select values
from 0 to 65535 seconds.

8. Click the Data Items tab to select the type of data logged once an event is trig-
gered. Items change with each type of data selected under “Logging Parameters.”
See Figure 8.6.

Figure 8.6: Configure Data Items Screen

9. Click on any data type and right-click to increase selection capability. Click OK to
install new values and close.
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NOTE: Multiple triggers in one channel are “OR’ed.” For example, if selecting two
triggers for Channel 1, it will record an event if one or both triggers become Active. This
is true for all triggers, User or System Triggers.

8.5 Configuring Schulz-Laios Settings

The 1133A includes special logic to implement Schulz-Laios settings, which are designed to
detect power system anomalies such as oscillatory transients. Six channels are dedicated
to performing this function in the 1133A.

For technical details concerning Schulz-Laios Settings in the 1133A, see “Detecting Oscil-
latory Transients and Other Anomalies” in Section 11.28.

1. Select Schulz-Laios in the left panel to access those settings. Select Input Signal for
the specific channel number to define the signal measured by Schulz-Laios logic.

2. Select the Input Channel column to define the selection (e.g. A phase voltage).

3. Select the Reset Threshold column and type in the desired value.

4. Select the T1 filter time constant and type in the desired value. For additional
information, see Table 11.4.

5. Select the T2 oscillator-detector time constant and type in the desired value.

6. Repeat the steps 3 - 7 for any of the other channels you wish to set.

7. Click Apply to install these values in the 1133A, and then OK to close.

NOTE: Changing any of the trigger parameters will cause the event partition of flash
memory to be erased.
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8.6 Configuring Event Notification

Triggered event data needs a destination for recording purposes, and PSCSV� provides a
method of assigning trigger data to one or more destinations. In the destination window
below are both User and System Triggers (unseen in window). These destinations are:

� Flash Memory
� Communications Port 1
� Communications Port 2
� Ethernet Port, UDP
� Four Relays, called Contact Outputs on the rear panel (see Configuring Relays)

1. Select “Event Notification” to reveal a list of User and System triggers that may
be assigned to the event reporting channel, including signaling one of the four relay
contacts.

Figure 8.7: Configuring Event Notification Screen

2. Select the trigger(s) required for each destination, right click on the selection(s) and
choose “Check Selected.” If you desire to globally send all of the triggers to flash
memory, right click on the destination window and select Check All.

3. Repeat step 2 to assign triggers for each required destination.

4. Continue on to configuring Schultz-Laios settings if needed. Otherwise, click OK to
install the triggers and close the Configure Triggers window.

5. To configure one of the relay contacts to actuate with a specific event (either User or
System Trigger), please see Configuring Relays.

NOTE: Changing any of the trigger parameters will cause the event partition of flash
memory to be erased.
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8.7 Downloading Triggered Events from Flash

When properly set up, the Model 1133A can respond to various triggers by signaling other
equipment and/or storing a record of the event. If a relay needs to be switched when
a specific trigger is activated, and the 1133A has four relays to serve that purpose. In
this section, the emphasis will be on retrieving the recorded event from the flash memory
module.

For User, DSP or System Triggers, the downloading process is the same, and very much
like Downloading Revenue Data.

1. Make certain that there is an open connection with the 1133A and that you are logged
on with permission to download events. For additional information, see “Connecting
with the 1133A” and “1133A Security.”

2. Click on the Download Event button or select Connection > Flash Memory > Down-
load Event to open the Download Event selection window.

3. Determine range of the event log data that you wish to download, and choose either
the “Select All” or the “Select Range” button to determine. If choosing “Select
Range”, use the two windows to select the event data range according to date and
time.

4. Select “OK” and the Save As window will appear for you to choose a file name for the
downloaded data. A default name is supplied. Click ”Save” and the selected event
data categories will begin filling the Download Session window. A progress meter
will also indicate the total number of event records have been transferred to file.

5. When the downloading of event data is complete, close the progress meter window,
and the Download Session window should remain. To view the event records them-
selves, click on the desired event data type in the Session window and the Save As
window will again appear. Type in the file name, click “Save,” and the data should
fill a spreadsheet window in PSCSV�.

6. To convert data to CSV format, select the specific lines of data and click the CSV
button or select File > CSV Format. When a Save As window appears, type in a file
name and click Save.
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Working with Broadcast Data

9.1 Introduction

All seven, broadcast data types referred to in this section are depicted on the Broadcast
toolbar. Broadcast data may be received directly in PSCSV� software or through other
software tools that are compatible with IEEE 1344 Phasor or Ethernet UDP.

Data logged in PSCSV�may be saved in 1133A format and exported in CSV and PQDIF
formats. To facilitate data reception by multiple devices, the 1133A provides various
options, including RS-485 and Ethernet.

9.1.1 Broadcast Data Choices

To acquire Broadcast Data there must be an active connection between the 1133A and
the computer. To learn about opening a connection between the 1133A and a computer,
see Chapter 6, “Connecting with the 1133A.”

Short descriptions of the eight data types are listed in Table 9.1 below.
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Data type Description No. Items Rate

Basic Voltage, Current, Power, Frequency,
Time Deviation, Flicker

55 1/sec.

Energy Watt-hours, VAR-hours, Volt-Amp-
hours, Q-hours

40 1/sec.

Harmonics Voltage and Current, mag. and
phase, up to 50th harmonic

600 1/sec.

Harmonic
Summary

Voltage and Current, RMS, THD,
RMS-K, THD-F, THD-T and K-
Factor

30 1/sec.

Waveform Voltages and Currents, mag. and
phase

6 20/sec.

Phasor PMU1 Manu data types according to
C37.118 Synchrophasor Spec.

50 varies

Phasor PMU2 Manu data types according to
C37.118 Synchrophasor Spec.

50 varies

Rel. Phase Voltage and Current, all phases and
sequences

24 1/sec.

Table 9.1: Broadcast Data Choices and Descriptions

9.1.2 Filter Data Selection Tool

PSCSV� has a filtered view function so that you can limit the number of items in
the viewing window. Lets suppose you want to view A-phase voltage and current and
nothing else. When you first start the Basic broadcast, you will see all data items that
will more than fill up the viewing window. To limit the number of parameters, follow
the guidelines below. Also, you may arrange the order of viewed parameters. See Figure 9.1

1. From the PSCSV� Toolbar, Select View > Filter Data, and you will see the window
shown shown in Figure 9.1.

2. By default, all of the data items are selected, i.e. in the Currently Viewed side. Select
the items you do not want in this category and click the left-pointing arrow to move
them into Available in Document side, and click OK.

3. Remember that the data file always contains all of the available data, and you are
just restricting what is displayed in the viewing window.
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Figure 9.1: Basic Data Selection Screen

9.2 Logging Basic Data

Basic Data includes all measured voltages, currents, sequence components, power values,
flicker, frequency and time deviation values. Basic Data are synchronized to the GPS,
sent real time at a rate of once-per-second and simultaneously saved in a file of choice.
See Figures 9.2 and 9.3.

Figure 9.2: Basic Data Summary Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A” in Chapter 6.

2. From the main menu select Connection > Acquire Broadcast > Basic Data, or click
the Basic Data button on the Broadcast toolbar to open the Select Broadcast Data
window.

3. Note that PSCSV� will download all measured data to the Basic Data window.

4. When the Save As window appears, use the default name or type in your own file
name. Also, use the browse feature to save to a desired location.
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Figure 9.3: Basic Data Spreadsheet Screen

5. Click Save and the data should begin streaming into the specific broadcast data
screen at a rate of once per second. Data is synchronized with the 1 PPS signal from
the GPS receiver and simultaneously saved to file.

6. Pause or stop the data stream by clicking the Stop or Pause button. If “Paused”, the
data will accumulate in the computer buffer but not print to the screen. Later, when
Pause is removed, the buffered data will fill the screen. The “Stop This” button will
only terminate the stream of data on top. The “Stop All” button will terminate all
data being broadcast from the 1133A.

7. Use the Filter Data tool to limit the data parameters visible in this window. See
page 100, under Filter Data Selection Tool, for more information on filtering data.
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9.3 Logging Energy Data

Energy Data includes all of the values shown in the Broadcast Data windows shown
below. Data includes Watt-hours, VAR-hours, VA-hours, Q-hours, for all phases delivered
and received and totals. Broadcast Data are synchronized to the GPS, sent real time at a
rate of once-per-second and simultaneously saved to a file of choice. See Figures 9.4 and 9.5.

Figure 9.4: Energy Data Summary Screen

Figure 9.5: Energy Data Spreadsheet Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A.” earlier in this section. Only basic permis-
sion required.

2. From the main menu select Connection > Acquire Broadcast > Energy Data, or click
the Energy Data button on the Broadcast toolbar to open the Select Broadcast Data
window.

3. When the Save As window appears, use the default file name or type in your own file
name. Also, use the browse feature to locate files.

4. Click Save and all available energy data should begin streaming into the specific
broadcast data screen at a rate of once per second. Data is synchronized with the 1
PPS signal from the GPS receiver and simultaneously saved to file.
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5. Pause or Stop the data stream by clicking the Stop or Pause button. If “Paused”,
the data will continue but not print to the screen. Later, when Pause is removed,
the built up data will fill the screen. The “Stop This” button will only terminate the
stream of data on top. The “Stop All” button will terminate all data being broadcast
from the 1133A

6. Use the Filter Data tool to limit the data parameters visible in this window. See
Filter Data Selection Tool on page 100 for more information on filtering data.

9.4 Logging Harmonic Data

Harmonic Data includes all of the values shown in the Broadcast Data window (some of
which are not shown in the screen shot below). All available harmonics are delivered to the
chosen window, whether in summary, spreadsheet or graphical form. Broadcast Data are
synchronized to the GPS, sent real time at a rate of once-per-second and simultaneously
saved in a file of choice. See Figures 9.6 and 9.7.

Figure 9.6: Harmonic Data Summary Screen

Figure 9.7: Harmonic Data Spreadsheet Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
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nected, see “Connecting with the 1133A.” earlier in this section. Only basic permis-
sion required.

2. From the main menu select Connection > Acquire Broadcast > Harmonics, or click
the Harmonics button on the Broadcast toolbar to open the Select Broadcast Data
window.

3. When the Save As window appears, use the default name or type in your own file
name. Also, use the browse feature to locate files.

4. Click OK and the data should begin streaming into the specific broadcast data screen
at a rate of once per second. Data is synchronized with the 1 PPS signal from the
GPS receiver and simultaneously saved to file.

5. Pause or stop the data stream by clicking the Stop or Pause button. If “Paused”, the
data will accumulate in the computer buffer but not print to the screen. Later, when
Pause is removed, the buffered data will fill the screen. The “Stop This” button will
only terminate the stream of data on top. The “Stop All” button will terminate all
data being broadcast from the 1133A.

6. Use the Filter Data tool to limit the data parameters visible in this window. See
Filter Data Selection Tool on page 100 for more information on filtering data.

9.5 Logging Harmonic Summary Data

Harmonic Summary Data includes all of the values shown in the Broadcast Data window
(shown below). All harmonic summary values are delivered to the open window. Broadcast
Data are synchronized to the GPS, sent out real time at a rate of once-per-second and
simultaneously saved in a file of choice. See Figures 9.8 and 9.9.

Figure 9.8: Harmonic Data Summary Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A.” Only basic permission required.
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Figure 9.9: Harmonic Data Spreadsheet Screen

2. From the main menu select Connection > Acquire Broadcast > Harmonic Summary,
or click the Harmonic Summary button on the Broadcast toolbar to open the Select
Broadcast Data window.

3. When the Save As window appears, use the default name or type in your own file
name. Also, use the browse feature to locate files.

4. Click OK and the data should begin streaming into the specific broadcast data screen
at a rate of once per second. Data is synchronized with the 1 PPS signal from the
GPS receiver and simultaneously saved to file.

5. Pause or Stop the data stream by clicking the Stop or Pause button. If “Paused”, the
data will accumulate in the computer buffer but not print to the screen. Later, when
Pause is removed, the buffered data will fill the screen. The “Stop This” button will
only terminate the stream of data on top. The “Stop All” button will terminate all
data being broadcast from the 1133A.

6. Use the Filter Data tool to limit the data parameters visible in this window. See
Filter Data Selection Tool on page 100 for more information on filtering data.

9.5.1 Harmonic Summary Values

RMS THD The RMS Total Harmonic Distortion, or THD, is the rms value of all of the
harmonics 2 - 50 and has the same units, volts or amps. RMS THD is calculated from the
following equation:

(9.1) RMS THD =
√

V 2
2 + · · ·+ V 2

50

where Vn is the harmonic rms voltage, and n equals harmonic number.
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RMS K RMS K is the rms sum of all of the harmonic energy, including the fundamental
(i.e. 1 - 50), with each harmonic multiplied by the square of the harmonic number. It
has the same units as the signal, i.e. volts or amps. For a clean signal, it will be almost
exactly equal to the fundamental value.

(9.2) RMS(K) =
√

(V1 × 1)2 + · · ·+ (V50 × 50)2

where V1 is the fundamental voltage and includes all the harmonics up to the 50th.

THD F Total Harmonic Distortion compared to the fundamental and expressed as a
percentage. THD F is calculated from the following:

(9.3) THD(F ) =

√
V 2

2 + · · ·+ V 2
50

V1
100%

where V1 is fundamental voltage, and V50 is the highest measured harmonic.

THD T Total Harmonic Distortion voltage compared to the Total voltage (fundamental
plus harmonics) and expressed as a percent. THD T is calculated from the following:

(9.4) THD(T ) =

√
V 2

2 + · · ·+ V 2
50

V1 + V2 + · · ·+ V50
100%

where the denominator now includes the sum of rms harmonic voltages plus the funda-
mental.

K–FACTOR K–Factor is a weighting of the harmonic load currents according to their
effects on transformer heating, as deerived from ANSI/IEEE C57.110. A K–Factor of 1.0
indicates a linear load (no harmonics). The higher the K–Factor, the greater the harmonic
heating effects. It is calculated based on the following equation:

(9.5) KFactor =
(V1 × 1)2 + · · ·+ (V50 × 50)2

V 2
1 + · · ·+ V 2

50

where each component is multiplied by the harmonic number (e.g.1, 2, · · · , 50), called a
weighting factor.
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9.5.2 Harmonic Load Currents

Harmonic load currents significantly affect power distribution system design. Harmonics
create additional losses through the skin effect at high frequencies and through higher
RMS load currents. By specifying K–Rated transformers and using other techniques,
power distribution systems and customer equipment should have lower failure rate.

9.5.3 Harmonic Summary Data

Harmonic Summary data returned from the 1133A can be a strong indicator of what
harmonics are being returned to the distribution system location by users with non-linear
loads. Harmonic content is potentially damaging both to the power company and the
user. If adequate protection is not taken, equipment will experience early failure and also
lower overall efficiency.

9.6 Logging Waveform Data

Waveform Data includes all of the values shown in the Broadcast Data window. When
activated, the window allows individual selection of current or voltage using the Input
Toolbar buttons. Waveform data are synchronized to the GPS, broadcast at a rate of 600
per second and simultaneously saved in a file of choice. See Figure 9.10.

Figure 9.10: Waveform Data Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A.” Only basic permission is required.

2. From the main menu select Connection > Acquire Broadcast > Waveform, or click
the Waveform button on the Broadcast toolbar to open the Save As window.



9.7 Logging Phasor Data 109

3. When the Save As window appears, choose to save the Waveform file to the default
filename, or type in a new file name and click Save.

4. The Waveform window should appear and display the phase A voltage waveform
(AV).

5. Click any one or group of the buttons on the Input toolbar to select individual
currents or voltages of the three phases (AV, AI, BV, BI, CV, CI) and switch them
ON or OFF.

6. To terminate the broadcast, click the “Stop This” button or Select Connection >
“Stop This” from the main menu.

7. Review previously recorded waveform data by opening any recorded file by selecting
File > Open or clicking the Folder button. Data may be “paged through” by using
the slider and right and left arrow buttons.

9.7 Logging Phasor Data

Phasor Data includes all of the individual voltages and currents defined in “Input Con-
figuration” (see “Configuring Measurement Parameters, DSP Mode”), and are broadcast
from the 1133A at a rate set up in Configure Communications, PMU-1 or PMU-2. Phasor
Data may be displayed in either vector format or as a frequency plot. When viewed as
Phasor Vectors, each phase voltage and current may be selected for viewing from the view
buttons in the PSCSV� main window. As a Frequency Plot, the display records the de-
viation from the system frequency (either 50 or 60 Hz) over time. See Figures 9.11 and 9.12.

To review previously recorded phasor data, and move through the record file, use the
slider and right and left arrows on the record toolbar.

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A.” earlier in this section. Only basic permis-
sion required.

2. From the main menu select Connection > Acquire Broadcast > Phasor, Absolute or
click the Phasor button on the Broadcast toolbar to start logging data.

3. When the Save As window appears, click Save to save the Phasor file to the default
filename, or type in a new file name.

4. The Phasor window should appear and display the voltage and current phasor(s).
The number of phasors is determined by the system choice from the DSP selection.

5. Click any one or group of the Input buttons on the Input toolbar to switch ON or
OFF individual currents or voltages of the three phases (AV, AI, BV, BI, CV, CI).
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Figure 9.11: Phasor Data Screen

Figure 9.12: Phasor-Frequency Plot Data Screen

6. To terminate this broadcast session, click the “Stop This” button, or select Connec-
tion > Stop Broadcast.

7. Click the Close button on the Phasor window when finished viewing the phasor
broadcast.

9.8 Logging Phase Data

Use Phase Data to compare any voltage or current phase angle using A-phase voltage or
A-phase current as the reference. When selected, all phase data from every input signal
is delivered to the Relative Phase window. Broadcast Data are synchronized to the GPS,
sent out real time at a rate of once-per-second and simultaneously saved in a file of choice.
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See Figures 9.13 and 9.14.

Figure 9.13: Phase Summary Data Screen

Figure 9.14: Phase Spreadsheet Data Screen

1. Make certain that there is an open connection with the 1133A. If you are not con-
nected, see “Connecting with the 1133A.” earlier in this section. Only basic permis-
sion required.

2. From the main menu select Connection > Acquire Broadcast > Phase, Relative
(Control + R) or click the Phase Data button.

3. Choose the default filename, or type in a file name to store the incoming data, and
click Save. The relative phase data should begin streaming into the window.

4. To terminate the relative phase broadcast data, click the “Stop All” or “Stop This”
button, or select Connection > Stop All Broadcasts, or Connection > Stop This
Broadcast.

5. Use the Filter Data tool to limit the data parameters visible in this window. See
Filter Data Selection Tool on page 100 for more information on filtering data.
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6. Relative phase readings may be displayed in either Summary or Spreadsheet format,
as shown in Figures 9.13 and 9.14. To select these formats, choose View > View As
> Real Time (or Spreadsheet).

9.9 Exporting Data in CSV Format

1133A formatted data is not compatible with spreadsheet programs and must be converted
into a compatible format, like Comma Separated Variable (CSV). CSV extensions are
accepted in most spreadsheet programs. Use this utility to convert selected records to .csv
files and save them for use in most spreadsheet programs. See Figure 9.15.

Figure 9.15: Export CSV Format Data Screen

1. Open a connection between the 1133A and computer using PSCSV�. .1133 data
must be currently downloaded from an 1133A, or from an opened file from a previous
recording.

2. For data currently being downloaded, use your cursor and select the lines of data to
be converted.

3. If the data are from a file, open the file using the Open button, or use File > Open
from the main menu, and highlight the lines of data to be converted.

4. The CSV button should now be active. Select File > Export CSV or click on the
CSV button and type in a name to save the converted file, or use the default name.

5. Click Save and the data should be converted to CSV format and saved under the
.csv extension into the chosen directory. At the conclusion of the conversion process,
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PSCSV� will ask if you want to open the newly-converted data in your resident
spreadsheet program.

6. CSV data may then be opened (imported) in most all spreadsheets

9.10 Exporting Data in PQDIF Format

1133A formatted data is not compatible with PQDIF applications and must be converted
into a compatible format with a pqd extension. Use this utility to convert selected records
to .pqd files and save them for use in applications that use pqd formats.

1. Open a connection between the 1133A and computer using PSCSV�. To export data
to PQDIF format, it must be opened in PSCSV�, either from a saved file, or data
currently being downloaded from an 1133A.

2. For data currently being downloaded, use your cursor and select the lines of data to
be converted.

3. If the data are from a file, open the file using the Open button, or use File > Open
from the main menu, and select the lines of data to be converted.

4. The Export PQDIF menu item should now be active. Select File > Export PQDIF
and type in a name to save the converted file, or use the default name.

5. Click Save and the data should be converted to PQDIF format and saved under the
.pqd extension into the chosen directory.



114 Working with Broadcast Data



Chapter 10

Working with Scheduled Data

10.1 Introduction

Scheduled data is defined as energy usage, measured over a specific time interval, stored
in the Model 1133A flash memory for revenue purposes. Scheduled data may be specified
at different intervals defined by the user, every fifteen minutes being common. Since the
1133A partitions flash memory between scheduled data and event data, it is up to the
user to set the amount of storage required ahead of time. To do this, see Flash Memory
Management in Chapter 7.

10.1.1 Topics Addressed in this Section

� Protocols
� Checking Status
� Configuring
� Downloading
� Erasing

10.1.2 Protocols

Currently, there are several protocols available for outputting scheduled data from the
Model 1133A: Arbiter’s PSCSV� software, DNP 3.0 and Modbus. KYZ is also used to
meter scheduled data and is supported in the 1133A. To set Kp Register Scale Factors
used with KYZ Pulse Metering, see Section 7.10.3. Another major protocol used to receive
scheduled data from various metering devices is MV90. At this time Arbiter Systems has
planned to comply with MV90 so that those who rely on this protocol may be able to
integrate the Model 1133A more easily into their systems.
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10.1.3 Registered or Scheduled Data

The 1133A uses the standard 16 MB, or optional 32 MB, flash memory module to store
scheduled data and uses FRAM to store Scheduled data in counter registers. FRAM uses
ferrite technology to store data for up to 10 years and has no write speed limitations like
other storage devices. It is ideal for nonvolatile memory applications requiring frequent or
rapid writes.

10.1.4 Downloading Scheduled Data with PSCSV�

The 1133A always stores scheduled data in a 16 Mbyte, or optional 32 Mbyte, flash
memory module for later review and downloading. Users can schedule to download
scheduled through a network, over a modem, or on site through one of the serial ports.
Additionally, the 1133A can trigger on an imminent full-memory condition to prevent
data loss.

10.1.5 Logging Data with KYZ Pulse Metering

Featuring four, multi-mode contacts, the 1133A permits seven different operational modes,
including KYZ pulse metering. Once KYZ relays are configured and system power is
connected to the voltage and current inputs, the relays will start logging data.

For KYZ pulse metering, specify optional KYZ relays (Option 6) instead of standard
mechanical relays. See Section 2 for details on relay options. Relay specifications are
located under “Programmable Contact Output Connections” in Chapter 12. To configure
KYZ pulse metering, see “Configuring KYZ Pulse Metering” earlier in this section, under
“Configuring the 1133A.”

10.2 Logging Scheduled Data using Other Protocols

10.2.1 DNP 3.0 and Modbus Protocols

Logging scheduled data under DNP 3.0 and Modbus requires additional, third party
software designed to connect to devices that use these protocols and communicate using a
serial port or the Ethernet. Prior to actually retrieving any scheduled data it is essential
to configure the 1133A communications ports for the desired protocol. Use PSCSV� to
configure the 1133A for DNP 3.0 or Modbus. For information on configuring these ports
for DNP or Modbus protocols see “Configuring the 1133A”, and “Configuring DNP 3.0
Protocol” or “Configuring Modbus Protocol” earlier in Section 7.

Once configured, the third party software will need to open the specific port on the 1133A
to establish communications. After establishing communications, determine the codes
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that specify data items that you are seeking to download. To identify the codes that
correspond to these data items, consult the tables in Appendix A, DNP 3.0 and Modbus
Data Structure.

10.2.2 Checking the Flash Memory Status

Flash memory in the 1133A is set up so that it can be configured to store two types of
data: Scheduled and Event. To store scheduled data, the scheduled partition of the flash
memory module must have some space allocated to it through PSCSV� . PSCSV� allows
you to partition the entire flash module as a percentage of the whole for Event data and
Scheduled data. A slider in PSCSV� , Flash Memory Configuration window provides this
means of changing the size of the flash partitions. See Figure 10.1.

Figure 10.1: Flash Status Screen

Prior to actually configuring the flash module partitions, it would be good to check the
flash memory status for any data that may be residing in flash, in case it needs to be
downloaded from flash to a computer.

Procedure

1. Click the Flash Memory Status button, or select Connection > Flash Memory >
View Status, to see if flash memory has data that needs to be downloaded.

2. Click the OK button to close the window.

3. If scheduled data needs to be downloaded, go to the next section, Downloading
Scheduled Data using PSCSV� .
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Figure 10.2: Scheduled Data Download - Specify Range

4. If event data needs to be downloaded, go to the section entitled, “Working with
Triggers and Event Data.”

5. After old event and scheduled data is safely downloaded, you may proceed to configure
flash memory. If old data does not need to be downloaded, it will be erased when
flash memory is reconfigured.

10.3 Downloading Scheduled Data using PSCSV�

To download scheduled data stored in the 1133A, use PSCSV� software. Use any of
the communication ports to download scheduled data through PSCSV� or other 1133A
compatible software tool. The following steps describe that process using PSCSV�.

1. Make certain that there is an open connection with the 1133A and that you are logged
on with permission to download scheduled data. If you are not, see “Connecting to
the 1133A” in Chapter 6 and “1133A Security” in Chapter 7.

2. Determine where you want to store the incoming scheduled data. If necessary, create
a directory or file folder in the desired location.

3. From the main menu, select Connection > Flash Memory > Download Scheduled
or click the Download Scheduled button, and the Download Scheduled window will
appear. Choose either Select All or Select Range. If selecting range, type in the time
and date conditions.

4. Click OK and the Save As window will appear. Choose the default file name or type
in a new file name and click Save.

5. The Downloading Data window will appear and indicate the progress of the download.

6. After the download is complete, choose one of the lines of data (e.g. Energy) and
select it. A Save-AS window will appear allowing you to choose a filename and save-as
location. Click OK and data will fill the new window.
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Figure 10.3: Scheduled Data - Download Session

Figure 10.4: Scheduled Data - Summary View

7. When the download is complete, click Cancel to close the progress window. Scheduled
Data will be stored in the chosen file location and will appear in categories in the
Download Session window.

8. To view the specific data, click one of the record groups (e.g. Energy) in the Scheduled
Data window. When a Save As window appears, browse to a chosen file location,
click Save, and data will begin to fill a new spreadsheet window and be saved to file.

9. To convert the .1133A file to .csv format, highlight the data to be converted, click
the CSV button and save to the desired filename and directory.

10. Click the Close button when finished with the downloading process.

10.4 Configuring Scheduled Storage

Configuring Scheduled Storage includes selecting the types of data from the included list
for storage in flash memory and setting up the storage interval that data are collected.
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Figure 10.5: Scheduled Data - Spreadsheet View

For information on using DNP 3.0 or Modbus to access scheduled data, see “Configuring
DNP 3.0 Protocol” and Appendix A.

WARNING: Save current data before configuring. Configuring Scheduled Storage in
the flash memory module will cause all scheduled data stored in flash memory to be deleted.

1. Open a connection between the 1133A and computer using PSCSV� and log on
using an account with permission to configure. If necessary, see “1133A Security.”

2. From the main menu, select Connection > Configure > Scheduled Data or click the
Configure Scheduled Storage button.

3. Select, from the list of values in each category, the items to be stored as scheduled in
flash memory. These categories include Energy, Voltage, Frequency Variation, Flicker
and Harmonics. Right click with the mouse to increase the selection options.

4. For each set of items (e.g. Energy) select the storage interval in the window at the
bottom, which is the recording rate. Allowable values are every 1, 5, 10, 15, 30 and
60 minutes.

5. Click Apply and then OK to close the configuration menu. Prior to deleting previous
scheduled data, PSCSV� issues the message shown below. Click Yes to proceed or
No to quit.

10.5 Erasing Scheduled Data Using PSCSV�

If you wish to delete the existing records stored in the Scheduled partition of the flash
memory module, then follow these instructions. Erasing the scheduled partition of flash
memory is a complete, one-step process where all of the flash memory devoted to scheduled
data is deleted. No partial deletions are possible.

1. Open a connection between the 1133A and computer using PSCSV� and log on using
an account with permission to erase scheduled. If necessary, see “1133A Security.”
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2. Make certain that no downloading of scheduled data is in process.

3. Select Connection > Flash Memory > Erase Scheduled from the main menu or click
the Erase Scheduled button on the Flash Toolbar.

4. While erasing flash memory, a progress window will appear.

5. When the erasure is complete, a message will appear that states that the erasure was
successful. Click OK to close the window. Otherwise click the “Close This Dialog
Upon Completion” box. If the erasure was not successful, you will receive a message.

6. To check Flash Memory Status for a percent saved condition, select from the main
menu Connection > Flash Memory > View Status, or click the Flash Status button.



122 Working with Scheduled Data

10.6 1133A Scheduled Data Values

10.6.1 Energy Values

Symbol Description Values Included No.
A WH DEL Watt-hours, Delivered A, B, C phase and Total 4
B WH REC Watt-hours, Received A, B, C Phase and Total 4
A VARH Q1 VAR-hours, Q1, Q2, Q3, Q4 A, B, C phase and Total 16
B VAH DEL Volt-Amp-hours, Delivered A, B, C phase and Total 4
C VAH REC Volt-Amp-hours, Received A, B, C phase and Total 4
B QH DEL Q-hours, Delivered A, B, C phase and Total 4
C QH REC Q-hours, Received A, B, C phase and Total 4
Total Values 40

10.6.2 Voltage Values

Symbol Description Values Included No.
A VH Volt-hours A, B, C phase and Total 4
A V2H Volt-Squared-Hours A, B, C phase and Total 4
B AH Amp-Hours A, B, C phase and Total 4
B A2H Amp-Squared-Hours A, B, C phase and Total 4
Total Values 16

10.6.3 Frequency Variation Values

Symbol Description Values Included No.
Freq Var Ave
Err

Frequency Variation Average
Error

1

Sudden Freq
Var

Sudden Frequency Variation 1

10.6.4 Flicker

Symbol Description Values Included No.
Flicker AV Voltage Flicker A, B, C phase 3
Flicker BI Current Flicker A, B, C phase 3

10.6.5 Harmonics

Symbol Description Values Included No.
AV 2 Voltage Harmonic A, B, C phase, fund. - 50th 150
BI 3 Current Harmonic A, B, C phase, fund. - 50th 150
AV RMS THD RMS Voltage Total Harmonic

Distortion4
A, B, C phase 30

Total Values 330



10.7 How Energy is Totalized in the Model 1133A 123

10.7 How Energy is Totalized in the Model 1133A

When scheduled data are downloaded from the 1133A, it is organized according to
individual phase and also by the totals of all phases. Also, it is further divided according
to its direction of flow - whether Delivered (DEL) or Received (REC) by power companies.
Therefore, energy is recognized as bi-directional as far as the 1133A is concerned and
separated into those categories. Lastly, there are two measurement times to consider:
the instrument interval (20/second) and a measurement period set by the user called
Frequency. While the measurement interval was chosen to provide accurate analysis of
the power, the Frequency provides a period of time over which power is measured and
recorded, as energy accumulates in a register. At the end of the measurement period, the
accumulated values for scheduled energies are copied to the 1133A flash memory module
for future use as Scheduled Data. Also, the registers are cleared to zero for the next cycle.

Suppose that the measurement period for a three-phase system is set to five minutes.
During the next five minutes, the 1133A will measure the active power for each phase and
calculate totals for all the phases. If the active power is negative, then it is regarded as
received and added to the REC register. If the active power is positive, then it is regarded
as delivered and added to the DEL register. For a three-phase system, all phases are
added algebraically to produce the total. If the total is positive, it is placed in the Total
Wh DEL register. If the total is negative, it is placed in the Total Wh REC register.
When the timer reaches five minutes, the contents of each register is copied into a flash
memory location and cleared for the next scheduled period. When downloaded, all energy
is displayed as positive, but separated in to their respective REC or DEL columns.
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10.7.1 Example, Totalizing Energy

1. For the first minute, A = +4 kWh. B = +2 kWh. C = -3 kWh. Total Energy = +3
kWh (4 + 2 - 3)

Phase Delivered (DEL) Received (REC)
A 4 0
B 2 0
C 0 3

Total 3 0

2. For the second minute, A = B = C = +10 kWh.
Phase Delivered (DEL) Received (REC)

A 14 0
B 12 0
C 10 3

Total 33 0

3. For the third minute, A = B = C = -5 kWh.
Phase Delivered (DEL) Received (REC)

A 14 5
B 12 5
C 10 8

Total 33 15

4. For the fourth minute, · · ·
5. For the fifth minute, · · ·

Lastly, Net energy values for each phase and total can be computed at any time, once the
data are located in the computer. For example, if the net energy per phase is required
for phase A, then the REC entry may be subtracted from the DEL entry to get the net
energy for that phase for that period. Suppose the following values are recorded for the
end of the fifth period:

Phase Delivered (DEL) Received (REC) Net
(Calculated by User)

A 14 11 +3
B 17 5 +12
C 10 8 +2

Total 33 16 +17

The net energy for phase A is 14 - 11 = 3 kWh
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Functional Description

11.1 Overview

The Arbiter Systems(r) Model 1133A Power Sentinel� consists of several blocks. They
are: GPS receiver and synchronization; voltage and current inputs; programmable-gain
amplifiers, multiplexers, and analog-to-digital converter; digital signal processor; host
processor; display and keyboard; I/O functions; and power supply. The button features
of the instrument and its measurement functions are described in the sections, which follow.

Two microprocessors are required to handle the many tasks being performed each
second in such a highly integrated instrument. A Texas Instruments TMS320C32
floating-point DSP unit performs the digital signal analysis tasks. Instrument I/O
functions and interface to the “real world” are handled by an SGS-Thomson ST10F167
16-bit micro-controller. Both of these processors have significant additional process-
ing power, which is not used in the initial version of the 1133A. This will allow for
the future expansion of features, which is sure to come, with a minimum amount of
upset; indeed, many future enhancements should be possible with only a firmware upgrade.

11.2 GPS Synchronization

To provide accurate time synchronization for power measurements, the 1133A uses
an eight-channel global positioning system (GPS) receiver and proprietary technology
developed by Arbiter Systems and refined in several generations of GPS timing products.
By comparing the internal 10-MHz crystal oscillator to the 1-PPS output of the GPS
receiver, the 1133A can maintain its frequency at any time within a few parts in 1010,
and time within one microsecond. All of the internal timing signals are derived from this
accurate time-base.
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11.3 Current Inputs

A three-phase, current input section is designed to be accurate to a few ppm over time and
temperature (see “Error Analysis”). This current input section uses a two-stage process,
similar to a two-stage current transformer except that the first stage is dc-coupled. Each
of these two stages has an accuracy of a few tenths of one percent; together, they have an
accuracy of a few parts per million.

11.4 Voltage Inputs

The voltage inputs uses low-TC (temperature coefficient) voltage-divider resistor networks
as signal attenuators. Voltage inputs may be configured as a three-phase, three-element
input, with four connections (A, B, C, and N), or configured as a two-element input, with
independent connections to each element (A+, A-, C+, and C-, for example).

11.5 Self Calibration

Designed to provide exceptional stability over time and temperature, the input sections
use several high-performance and higher-priced components. Drift and temperature
sensitivity are reduced, in the programmable gain amplifiers (PGA’s) and analog-to-digital
converter (ADC), by use of an internal, continuous self-calibration process. The inputs to
the PGA’s are multiplexed, each to four different signals: the three current (or voltage)
inputs, and a calibration signal generated by a special source built in for the purpose.
This enables the PGA’s and ADC’s to make use of lower-cost components, since their
drifts and initial errors are removed by self-calibration.

11.6 Error Analysis

All identified sources of error in the 1133A have been quantified using worst-case manu-
facturers’ performance data. These have then been combined using a root-sum-of-squares
(RSS) method to yield a performance estimate. Effects due to initial calibration, measure-
ment noise, temperature, and aging are all included. The reason for using RSS analysis is
beyond the scope of this paper. However, we have found in our many years’ experience
building calibration instruments that this method yields the most realistic estimate of
actual worst-case performance, provided that numerous errors contribute significantly to
the overall performance (i.e., no one error dominates), and provided that worst-case actual
data is used for the analysis.

The error analysis, used for the 1133A power or energy measurements, is shown in Table
6-1. Similar analyses have been performed for the other functions of the instrument, and
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include most of the same factors shown here.

Temperature Errors, 0–50◦C Error, ppm

Current input, resistor TCR 63

Voltage input, resistor ratio 50

Voltage reference (x2) 50

Cal. source, resistor ratio (x2) 25

Time Stability, 1 year - -

Current input, resistor 25

Voltage input, resistor ratio <20

Voltage reference (x2) 36

Cal. source, resistor ratio (x2) <40

Measurement Noise 10

Total RSS Error, Basic 117

Calibration Errors - -

Cal. artifact, Rotek MSB-001A 50

Traceability to National Standards 50

Total Error, RSS 136

Specification (0.025%) 250

Table 11.1: Power/Energy Error Analysis

11.7 Signal Sampling

The signals, representing the scaled voltage and current inputs and the calibration
signal, are time-multiplexed into a two-channel ADC. Each signal is sampled at a
rate of 10240 samples per second. The current and voltage signals for each phase are
sampled simultaneously to eliminate errors in power calculation, which would occur with
non-simultaneous sampling. The sample clock in the 1133A is synchronized to UTC-
USNO (GPS) within one microsecond, allowing measurements of phase angle across a
power grid to be compared directly, and ensuring that revenue is billed at the correct rates.
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11.8 Power and Energy

Power and energy are determined by making twenty separate measurements per second
of the cross product of voltage and current for each phase. Each measurement uses 1024
samples (i.e., it takes data from a 100 millisecond window), yielding a 50% overlap.

Apparent power (VA) and reactive power (VAR) are determined from the results of the
voltage and current magnitude measurements (see next section), using standard identities.
The active power measurements and reactive power measurements are then compensated
for PT and CT corrections (see below) using a complex multiplication, and corrections
are performed for transformer iron and copper losses, if enabled.

At this point, two different things are done with the resulting measurement data. First,
a determination is made of the quadrant in which this data should be registered (Wh
delivered or received, VARh delivered or received.) The results of each measurement
cycle (20/sec) are then added to the proper set of registers. These registers are stored
periodically, and accumulation restarted from zero. The user may configure the unit for
different intervals to register energy.

The second thing that is done with the data is to determine the actual power level. This
number will be displayed on the front panel (as Watts or VARs), and it will be returned
via the serial interface if a simple request for “power” is made. This result is calculated
by averaging the 20 power measurements made during each second. Therefore, the update
rate for this quantity is once per second. This data is not registered separately depending
on the quadrant, as the energy data is; therefore, it is theoretically possible, if the direction
of power flow changes periodically, that the sum of measurements reported over the serial
interface may gradually depart from the registered energy data. This is due to the loss
of information in the averaging process; the registered data are the most accurate. The
averaged data are provided primarily as a convenience or for system control purposes; it
is not intended for billing purposes.

11.9 Voltage and Current

Voltage and current are measured in a similar fashion to power, using overlapping
1024-point measurements. In this case, however, the cross product is replaced with
the square of the voltage or current samples. The square root of the resulting sum is
proportional to the rms voltage or current value during the measurement interval. This
value is corrected for the CT and/or PT correction factors before further use. The 1133A
uses the resulting data to correct the energy measurements, as described above. It also
provides data to the host system by averaging it over one-second intervals.
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11.10 CT and PT Compensation

To correct for the inaccuracies of the CT’s and PT’s used in the metering setup, CT
and PT compensation may be enabled. Since the system voltage is relatively constant,
the PT compensation factor is a single, complex (i.e., magnitude and phase, or real and
imaginary) correction factor.

CT compensation is more complicated than PT compensation. Due to the fact that
magnetizing currents in CT’s are not exactly proportional to the load current, a matrix is
used. This allows the entry of several different compensation factors measured at different
current levels. The 1133A interpolates between the numbers in this table (also complex)
to determine the correction factor to be used.

Correction for energy is performed using the (complex) product of the PT and CT factors.
Correction for voltage or current is performed using the magnitude of the appropriate
factor. Correction for phase angle is made using the phase of the appropriate component,
i.e. the arctangent of the complex value. The actual calculation performed may be different
than this description, due to computational considerations (a complex multiplication is
far faster than a trigonometric operation such as an arctangent, for example); however,
the end result will be as described.

11.11 Transformer Compensation

There are two different types of transformer compensation. They are used to correct
for the losses in a transformer when primary-side metering is used to meter the energy
delivered to a customer at the secondary of the transformer.

Copper compensation is used to correct for the I2R losses in the transformer windings
due primarily to their (non-zero) resistance. As you would expect, this effect is primarily
active (resistive), although there may be minor reactive effects, and it is proportional
to the current squared. This factor allows the user to correct for these losses. It is a
complex factor, providing both Watts and VARs correction, and is proportional to current
squared; i.e. so many watts and VARs are to be subtracted from the registered amounts
per ampere squared of load current.

Iron losses (also called core losses) are due to magnetizing currents (the small amount of
current required to generate the flux in the core, which is unrelated to the load current)
and eddy current losses in the core material. These are approximately proportional to
the square (watts) or 4th power (vars) of the voltage, and the compensation is performed
using the same basic method as described above for copper loss.
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11.12 DC Offsets

DC offsets may be present in the signals applied to the input of the 1133A, although this
is unusual. More commonly, small dc errors in the measurement circuit result in non-zero
average of the samples.

This potential source of error must be corrected to obtain maximum accuracy, since the
1133A makes wideband measurements of power, voltage, and current. Components at
any frequency within the measurement bandwidth, including dc, will affect the measure-
ment. Therefore, part of the measurement process is to average the (windowed) data,
measuring the dc component. The effects of dc offsets are then subtracted from the results.

11.13 Phase and Frequency

As a part of its measurement process, the 1133A performs a fast Fourier transform (FFT)
of the windowed voltage and current samples. In accordance with IEC 61000-4-7, this
process is performed twenty times per second, using overlapping 1024-sample Hanning
window data. This yields new FFT results twenty times per second for each voltage and
current input, for a total of 120 FFT’s per second. Phase angle may be determined from
the relationship between the real and imaginary component of the fundamental-frequency
bin of the FFT. (Since the window is 100 ms wide, each bin is 10 Hz apart; therefore, this
is bin 5 for 50 Hz and bin 6 for 60 Hz.)

So long as there is significant measured energy in the bin, frequency offsets do not affect
the measured phase angle. This is true as long as the signal being measured is the main
source of energy in the bin; i.e. there is minimal leakage from adjacent bins, and minimal
noise. Provided that the frequency is anywhere near nominal (within 10 Hz or so), the
phase measurement is perfectly usable.

The phase measurements may be compared to determine phase angle between voltages
and currents or between any two voltages or currents. Because the sampling process is
synchronized via GPS to UTC, absolute phase angle measurements may be made and
compared between two units located at some distance from one another.

Frequency is measured by taking the difference in phase angle between subsequent
measurements, based on the identity f = dφ/dt. Frequency is averaged over one second
prior to being displayed or made available for output.

The 1133A is the first product to make absolute (i.e. relative to UTC time) phase-angle
measurements available in an economical unit which will be widely applied. Measurements
of phase angle have been available before, but most products have not offered accurate time
synchronization, and therefore most users are not experienced with the concept of absolute
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phase. All phase angles in the 1133A are reported as absolute phase angles, relative to
UTC (USNO) top-of-second. A phase angle of zero degrees is defined as corresponding
to the positive maximum of a cosine wave being coincident with 1PPS-UTC(USNO).
Relative phase angles, for example between phases, or between a voltage and a current,
may be calculated by subtraction. Relative phases of harmonics may also be found
by subtraction; however, the harmonic number prior to subtraction must multiply the
fundamental, absolute phase. This is because the subtraction is actually one of time; the
purpose being to ’re-align’ the reference point to correspond to zero degrees on the fun-
damental. The phase angle corresponding to this time shift is proportional to the frequency.

11.14 Harmonics

Harmonics are measured using overlapping Hanning window FFT’s of 1024 samples and
100 ms window length. Based on the instantaneous frequency, the location of the bins
containing significant energy for each harmonic are determined. This is a total of three
bins, one approximately centered on the harmonic and those two adjacent to it. Then,
the energy in those three bins is totaled, resulting in the energy for that harmonic. This
can then easily be expressed as a percent of the rms signal level, or in whatever form
is required. While there is a closed-form correction, which can be employed to find the
harmonic magnitude in the presence of frequency errors, this approximation was chosen
because it is much faster and gives adequate performance.

There is an error in this approximation, due to the fact that there will be a small amount
of energy leakage into nearby bins, which will not be included in the three measured bins.
This is generally of little consequence when the frequency is close to being accurate (which
is most of the time), since the amount of energy outside of the three bins summed is so
low. Finally, with the Hanning window, there is no signal at all outside of these three bins
if the frequency is exact.

In the real world, however, the frequency will be off somewhat, and it is reasonable to ask
how large the error can be. For small frequency errors, say 0.01 Hz, the 50th harmonic will
be 0.5 Hz from the center of the nominal bin. This results in an error of about 0.005%,
which is insignificant. The worst-case error will occur when a harmonic is very nearly
centered between two bins. In this case, the algorithm described above will ‘miss’ a bin
containing a signal with amplitude of about 17% of the actual harmonic amplitude. The
energy contained in this bin is then (0.17)2 or about 2.9% of the total energy, resulting
in a measured energy 0.971–times what it should be. The measured harmonic amplitude
will then be

√
0.971 or about -1.5% in error. This is well within the specification limits

(5%) of IEC 61000-4-7. This worst-case error would occur for the 50th harmonic with
a fundamental frequency error of 0.1Hz. At lower harmonics, the frequency error must
be progressively greater; for example, to result in a -1.5% error in measuring the 9th
harmonic would require a fundamental frequency offset of 0.556 Hz.
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The phase angle of the harmonics is determined by taking the arctangent of the real and
imaginary components of the bin closest to each harmonic. This information cannot be
used, however, in the averaging process described in IEC 61000-4-7, because this specifi-
cation requires the rms average of a series of measurements. This, by definition, requires
magnitude data only. Therefore, there are two different harmonic tables available from
the unit. The averaged harmonic data, in accordance with IEC 61000-4-7, is provided in a
300-element array (6 channels x 50 harmonics), averaged over the interval specified by the
user (typically 10 or 15 minutes). The harmonic magnitude and phase data are provided
in a 600-element array, once per second. The harmonic magnitude is the rms value over
the preceding second, and the phase angle is the ’instantaneous,’ absolute (based on a 100
ms window centered at top of second) phase angle, as described in the preceding paragraph.

11.15 Flicker

Flicker is measured in accordance with IEC 61000-4-15, the successor standard to IEC
868. Unlike the other measurements described above, flicker measurement is a continuous
process. This process is performed using a sample rate of 640 samples per second (sps).
Anti-alias (decimation) filtering is performed on the 10240–sps data stream, and the
resulting samples are further processed following the block diagram suggested in IEC
61000-4-15. The resulting measurements of flicker perceptibility are classified using a
256-level logarithmic classifier at the full 640–sps rate. Pst is then determined every ten
minutes (or as specified), as described by the standards.

Although no standards currently require it, the 1133A also measures flicker on the current
inputs. This information can be useful in determining whether a customer’s load is causing
flicker on the power system, or whether the customer is being subjected to flicker from
other sources. It is unrealistic to penalize a utility for ’poor power quality’ at a customer’s
load when the cause of the problem is the load itself.

11.16 Interruptions

Interruptions are monitored on the voltage inputs by comparing the 20/second voltage
measurements with a user-supplied threshold. Events are triggered when the voltage dips
below the preset threshold. These can cause the logging of pre- and post-fault data,
contact closure, or any of the other actions described under ‘Event Logging.’
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11.17 Voltage Fluctuations

Voltage fluctuations are monitored by classifying the 20/second voltage data, per phase,
with a 256-step linear classifier covering a range of 20% of nominal voltage. These data
are then summarized as a cumulative probability table over a specified interval - typically
15 minutes. In addition, the minimum, maximum, mean and standard deviation are
calculated. The data may be recorded in flash memory either continuously or on demand.
Voltage fluctuations corresponding to system stability events may also be monitored and
a trigger generated using Schulz-Laios filtering of the voltages.

11.18 System Time Deviation

System time deviation, which is the accumulated error of a clock using the system
frequency as its reference, compared to an absolute reference such as UTC, is determined
from the 20/second phase data described earlier. System time deviation is accumulated
as integer cycles of error plus fractional phase, and is converted to seconds as needed.
The positive-sequence voltage phase angle is used for this measurement. Since this is an
integrated value, the constant of integration (initial time offset value) must be specified
by the user.

11.19 Phasor Measurements

Phasor data are formatted and output in accordance with IEEE Synchrophasor Standard
C37.118. Phasors consist of the real and imaginary component of magnitude for the
voltages and currents at a particular point in a power distribution system, along with
suitable time synchronization fields and other information. This information is available
in real time, and is based on the measured fundamental voltage, current, and phase angle
described above, at a variable rates based on system frequency. There is a measurement
delay due to the data acquisition delay of 50 ms, signal processing time of approximately
15 ms, and data transfer time which depends on the data rate.

11.20 Phase Balance

The 1133A measures phase balance by calculating the symmetrical sequence components
(positive, negative, and zero sequence) for the three-phase voltage input. Normally, if the
unit is connected properly, the positive-sequence voltage will be equal to the line voltage
and the negative- and zero-sequence voltages will be approximately zero. In the event
that a user-specified limit on the imbalance (See “Triggering,” later in this section) is
exceeded, an event will be recognized. In addition, the sequence components are averaged
over a user-specified interval (typically 10 or 15 minutes) and may be logged if desired.
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These calculations are performed using the voltage magnitude and phase information, at
the rate of 20/second.

11.21 Load Balance

Load balance is calculated in much the same way as phase balance, except on the
customer’s load current. Both of these measurements may be used to identify serious
power system problems, such as a dropped phase, which could cause serious damage to
both the utility’s and the customer’s equipment.

11.22 Flash Memory and Event Logging

16 megabytes of standard flash memory for data and event logging can be increased to
32 megabytes total if required. This memory may be used to record three basic types
of information: (1) registered quantities, (2) event data, and (3) system status events.
Registered quantities are recorded on a fixed schedule and may include many more
items than a typical energy meter, including just about any function the instrument can
measure. The event data are logged on the occurrence of an event designated to initiate
logging. System status is used for advanced monitoring and control of the operation of
the 1133A and the system node to which it is connected.

Events are defined as any measured quantity exceeding a user-specified threshold, an
external trigger, or an internal state of the 1133A (low flash memory, for example). In
addition, an event may trigger a dial-up modem call to be initiated, reporting the event;
and/or a relay contact may be closed (or opened).

There is a great deal of flexibility as to what may be recorded in flash memory at the time
an event is recognized. Recorded information may any of the following:

� Time of event
� Type of event
� State of measured quantities
� Pre- and post-event data
� Any of the measured quantities - e.g. voltage, power, waveform, etc.

The 1133A must be configured in advance to specify the events being recognized and
actions to be taken.

To maximize usage of flash memory, it is important to distinguish registered quantities
from event log data. The amount of memory needed to record a certain number of
registered items for a certain period can be determined exactly, whereas the amount of
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memory required to log events depends on the number and type of events, and the number
of items to be recorded for each type. Since the number and type of events cannot be
known a priori, the amount of memory required also cannot be stated with certainty.
The 1133A handles this by allocating sufficient memory as required for the registered
quantities over the specified period of time, and then making whatever memory is left
available for event logging. To deal with low register or event memory conditions, the
1133A can be configured to initiate an auto-dial call or contact closure when the condition
is met. Memory is allocated in 64-kbyte blocks, which is the block size of the flash memory.

Flash memory must be erased in blocks, and data cannot be over-written until its block
is completely erased. Therefore, the normal process will be to first read out the desired
data, and then erase the blocks, making them available for re-use. All blocks of data
are password-protected, having two levels of security from separate permissions: one to
access the data, and a second to clear it from memory. This means that registered data
and event data each have their own sets of permissions. This would normally be used to
separate billing data from operational data.

In addition to the password security, the flash memory is located on a separate module,
mounted internally to the 1133A. In the event of a failure or sabotage to the instrument
itself, the memory module may be removed and read on a separate 1133A mainframe,
preventing the loss of critical billing information and other data.

11.23 Contact Outputs

Four contact outputs may be used to report events recognized by the 1133A, or they may
be controlled remotely, by command. They may also be operated on a schedule, which may
be downloaded for up to 30 days in advance. In addition to reporting events, these con-
tacts may be used to synchronize external equipment or to operate load-control switchgear.

11.24 Event Inputs

Four external event inputs are also provided. These are optically isolated and accept
dc signals at levels from 24 to 240 volts (an internal modification will allow 5 volt
logic-level inputs). Application of a signal to one of these inputs will be time-tagged to
one microsecond resolution. Resultant actions from an event input are described above
under triggers, Sections 3, 5 and 7.
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11.25 Serial Channels

Two standard serial channels can be configured at the time of order with RS-232 or
RS-485 drivers, or with a V.34bis 33.6k modem. Each channel can have access to all
functions of the 1133A. Alternatively, certain functions (such as the ability to clear the
revenue registers) may be enabled or disabled independently. Each serial channel has
a RJ-11 (6-position) modular connector useful for connecting with a standard phone
cable. Use a RJ-11 to DB-9F adapter at the end of the phone cable to connect the 1133A
to a computer. These adapters may be rewired in the field to match interface requirements.

Both serial channels, and the Ethernet channel, may be operated simultaneously, each
serving different hosts with separate access authorization and information channels.

11.26 Ethernet MMS Interface

An Ethernet (10Base–T) interface, supporting the emerging MMS standard for substation
automation, will connect via a RJ-45 (8-position) modular connector. This interface
will not be available initially, but the hardware is included, to allow future expandabil-
ity when this capability is added. Contact the factory for more information on this feature.

11.27 Triggering in the Model 1133A

The digital signal processor (DSP) in the 1133A Power Sentinel measures dozens of differ-
ent parameters of the applied input signals, in many cases at a rate of 20 measurements
per second. Most of these parameters may be used to trigger an alarm condition, based
on preset thresholds and conditions.

Triggering in the DSP works as follows. First, there are 31 different measurement types
that may be selected for processing by the trigger algorithm (Table 6-2). For each of these,
there are (typically) four different measurement channels, A, C, B and either average,
total, or maximum (of A, C, and B). Thus, there are a total of 124 different signals
(corresponding to individual measurement results) which can be selected. Not all of these
are defined at this time, however.

Second, there are 32 trigger channels, which may be configured for use concurrently
(Table 11.3). Each of these may be set to use any of the 124 signals as their input. For
each channel, there is a limit, which may be set by the user, as well as a reference value,
which may be used by the trigger logic. The limit function logic may be set to any of four
modes: x > limit; x < limit, |x| > limit; or |x - ref| > limit. In addition, each trigger
channel may be made dependent on the results of another channel. It may be set so that
the channel requires the other trigger to be either active or inactive before proceeding with
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its own comparison. Comparisons are made at the 20 per second rate for all channels,
even for input signals, which change more slowly.

Each channel also has a dwell time, or delay time, register. Before it will generate a
trigger, the specified signal must exceed its limit condition for a number of comparisons
equal to this register (plus one). The register is a 16-bit unsigned integer, having a range of
0 to 65535 cycles. Since comparisons are performed 20 times per second, this corresponds
to a range of dwell time of 0 to 3276.75 seconds. A value of 0 allows the trigger to be
recognized at any time the corresponding condition is true; a value of 1 (0.05 seconds)
requires the trigger condition to persist for two consecutive comparisons, and so on.

Considering all of the different input signal possibilities, along with the different limit
modes and inter-channel dependencies, there are an almost limitless number of possible
combinations of settings for each trigger channel.

11.28 Detecting Oscillatory Transients and Other Anom-
alies

Special logic is included in the 1133A to implement the algorithms described by Schulz
and Laios [1], which are designed to detect power system anomalies such as oscillatory
transients. There are six channels dedicated to performing this function in the 1133A
(Table 6-4). Each of these may have any of the 124 signals described above as its input.
Each channel has three outputs: a low-pass-filtered (’bound’) output, a rate-of-change
output, and an oscillation-detector output. Each channel also has three control parameters
(in addition to the input signal selection): the rate-of-change filter time constant (T1 in
[1]); the oscillation-detector time constant (T2 in [1]); and the oscillation-detector reset
threshold, also described in [1]. These parameters control only the operation of these
signal-processing blocks, and do not in themselves generate any triggers. To generate
triggers, select one of the three outputs of one of the channels in this block. This serves
as an input to one of the 32 trigger channels. As recommended by Schulz and Laios, the
input filtering for this block is the BPA #1 low-pass, described in [2], which is a 12-point
Hanning-weighted FIR low-pass filter having a group delay of 0.3 seconds at a 20/second
sampling rate.
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ID
No.

Function Update
Rate

Channels Available

0 Off N/A N/A
1 Voltage 20/sec A, C, B, Averagea

2 Current 20/sec A, C, B, Averageb

3 Active Power (Watts) 20/sec A, C, B, Totalc

4 Reactive Power (VARs) 20/sec A, C, B, Totalc

5 Apparent Power (VA) 20/sec A, C, B, Totalc

6 Power Factor (PF) 20/sec A, C, B, Totalc

7 Sequence Voltage Components 20/sec Zero, Pos., Neg.
8 Sequence Current Components 20/sec Zero, Pos., Neg.
9 Phase Balance Ratio, derived from

sequence components
20/sec Zero/pos., Neg./Pos. for

both voltage & Current
10 Frequency and Time 20/sec Frequency, F, df/dt, T
11 THD, Voltage 1/sec A, C, B, max (A, C, B)a

12 THD, Current 1/sec A, C, B, max (A, C, B)b

13 Harmonic VRMS 1/sec A, C, B, max (A, C, B)a

14 Harmonic IRMS 1/sec A, C, B, max (A, C, B)b

15 K-Factor, voltage 1/sec A, C, B, max (A, C, B)a

16 K-Factor, current 1/sec A, C, B, max (A, C, B)b

17 Flicker, instantaneous, voltage 1/sec A, C, B, max (A, C, B)a

18 Flicker, PST, voltage 1/sec A, C, B, max (A, C, B)a

19 Flicker, instantaneous, current 1/sec A, C, B, max (A, C, B)b

20 Flicker, PST, current 1/sec A, C, B, max (A, C, B)b

21-25 Reserved TBD TBD
26-31 Transient detector channels 0 - 5 20/sec Bound, rate/change, osc.

Table 11.2: Signal Functions Available for Triggering
aAverage or maximum of 3 voltage channels in 3Φ4W3E and 3Φ3W2E input mode, 1 channel in 1Φ2W1E

mode, and 2 channels in other modes. In 3Φ3W2E mode, the voltage VAC is derived internally by point-by-
point calculation after A/D conversion. The voltage VB, synthesized internally in 3Φ4W2-1/2E mode, does
not correspond to an actual physical quantity and is not included in the analysis, although measurements
can be made on the synthesized signal.

bAverage or maximum of 3 current channels in 3Φ modes, 1 channel in 1Φ2W3E mode, and 2 channels
in other modes. In 3Φ3W2E mode, the current IB is derived internally by point-by-point calculation after
A/D conversion.

cTotal of 3 elements in 3Φ4W3E and 3Φ4W2-1/2E modes, 1 element in 1Φ2W1E mode, and 2 elements
in other modes.
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Function Range or Options
Input Signal 0 – 31, per Table 11.2 above (set to 0 if not used)
channel 0 – 3, per right column in table above
Trigger dependency 0 – 2, Off, Active, Inactive
master channel 0 – 31, any other trigger channel
Limit type 0 – 3; x > limit, x < limit, |x| > limit, |x – ref| < limit
Dwell (delay) time 0 – 65535, 50 ms/count; 0 to 3276.75 seconds
Limit value Floating point, in measurement units (volts, watts, ...)
Reference value Floating point, in measurement units (volts, watts, ...)

Table 11.3: Trigger Channel Parameter Summary (32 channels)

Function Range or Options
T1 High pass (rate detector) time constant, seconds, minimum

0.05 seconds, typical 0.5 seconds
T2 Oscillatory detector low pass time constant, seconds; mini-

mum 0.05 seconds, typical 5.0 seconds.
Oscillatory detector re-
set threshold

Threshold in measurement units Set to any negative number
to disable reset

Input Signal 0 – 31, per Table 11.2 above; 0 - 3, per right column in
Table 11.2 above

Table 11.4: Schulz-Laios Transient Detector Algorithm Control (6 ch.) [1]
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Chapter 12

Technical Specifications and
Operational Parameters

12.1 Scope

This section describes the functional and operational characteristics of the 1133A,
including:

� Standard Options

� Receiver Characteristics

� AC Current and Voltage Inputs, Other Inputs & Outputs

� Instrument Interface

� Flash Memory Data Storage

� Accuracy Specifications

� Power Quality Measurement Capability

� System Control and Monitoring

� Synchronization through GPS or optional IRIG-B

� Power Requirements

� General - physical & environmental

NOTE: Specifications are subject to change without notice.
A built-in Global Positioning System (GPS) satellite receiver synchronizes the 1133A to
within 1 µs of Coordinated Universal Time (UTC). Optionally, an IRIG-B decoder replaces
the GPS receiver and synchronizes 1133A to the accuracy of the IRIG-B time source. The
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GPS receiver can simultaneously and continuously track up to twelve satellites. Results
from all tracked satellites are averaged for better accuracy using least-squares estimation.
No Position-Hold function is used. Standard three-phase voltage and current inputs allow
for revenue metering, power quality and system control monitoring.

16 MB of standard flash memory, or 32 MB of Optional flash memory, are used to
record revenue data, power quality, internally detected faults, alarms, and various events.
Download any registered and event data, or broadcast current data for analysis using
PSCSV� software. Other supported protocols include DNP, Modbus and PQ-DIF.

Four, Form-C (SPDT) contact outputs may be used to report events recognized by the
1133A, or they may be controlled remotely, by command. Schedule contact outputs for
up to 30 days in advance to synchronize external equipment or to operate load-control
switchgear. Contacts may also be configured for KYZ pulse metering when used with
Option 06.

Four, optically-isolated event inputs are provided and accept dc signal levels of 24 - 240
volts, or 5-V CMOS-level voltages with modification (see Appendix B). Upon application
of a signal to one of these inputs, the event will be time-tagged to one microsecond
resolution and recognized as an event. These events may cause any of the actions
described under ’Event Logging.’

One IRIG-B Unmodulated output is provided for synchronizing relays, digital fault
recorders, and other power monitoring equipment that rely on the IRIG-B time code
format.

Three communication ports are available: SERIAL 1, SERIAL 2 and one IEEE 802.3I
10Base-T. SERIAL 1 and 2 may be configured as RS-232, RS-485 or Modem.
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12.2 Standard Options

Option Part Number Option Description

1133opt01 16 MB Flash Memory Option

1133opt02 32 MB Flash Memory Option

1133opt03 Standard Power Supply

1133opt04 Low Voltage Power Supply

1133opt05 Standard Power Mechanical Relay

1133opt06 KYZ–Rated Solid State Relay

1133opt07 Replace GPS Input with IRIG-B Input

1133opt10 RS-232 Port, Port 1

1133opt11 RS-422/485, Port 1

1133opt12 Modem, Port 1

1133opt20 RS-232 Port, Port 2

1133opt21 RS-422/485, Port 2

1133opt22 Modem, Port 2

1133opt99 CE Mark Compliance

Table 12.1: 1133A Standard Options
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12.3 AC Voltage and Current Inputs

AC Voltage and Current Input connectors allow for connecting to most common electrical
systems. All other values - such as power and energy - are derived from these measure-
ments and the internal GPS-synchronized or IRIG-B synchronized clock. Possible input
configurations and ranges are specified below.

12.3.1 Input Configurations

3 Phase (3Φ) 3-element, 2 1/2-element, 2-element

1 Phase (1Φ) 2-element, 1 1/2-element, 1-element

12.3.2 Input Voltage

Range (3Φ/1Φ) 0 - 75, 150, 300, or 600 Vrms, selectable (phase-to-phase
for 2 element, phase-to-neutral for 2 1/2 and 3 element).

Over range 88, 175, 350 or 700 Vrms, nominal

12.3.3 Input Current

Range (3Φ/1Φ) 2.5, 5, 10, or 20 Arms selectable, per element

Over Range 2.9, 5.9, 11.7, or 23.5 Arms, nominal (maximum contin-
uous input current: 20 Arms per element)

12.4 Volt-Amps (VA), Watts (W), Volt-Amp-Reactance
(VAR)

Range Product of rated voltage and current ranges and num-
ber of elements (for input configuration, see Section 7 -
“Configuring Measurement Parameters, DSP Mode”)

12.5 Compensating Constants and Ratios

CT and PT Nominal ratios, magnitude and phase compensation, CT
uses quadratic spline curve model (see “Configuring the
1133A, Measurement Parameters”)

Transformer Both iron and copper compensation

12.6 Input Frequency Range

Range: 45 - 65 Hz, for specified accuracy;

Harmonics: To 3 kHz
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12.7 Input Connector Ratings

Connections Removable screw-clamp terminal block, accepting 0.2 - 4
mm2 (AWG 24-10) solid or stranded conductors

Insulation 400 V, nominal, to neutral/chassis, surge voltage class III

600 V, nominal, to neutral/chassis, surge voltage class II

Contact factory for more detailed information

12.8 Instrument Interface

12.8.1 Front Panel Indicators and Controls

Status LEDs Operate (green)

Time Set (green)

Unlocked (red)

Fault (red)

Display 2X20 character LCD display

Keypad 8 button, for status only (for configuration, see Chap-
ter 7)

12.8.2 External Interface Connections

Serial Two, RS-232 or RS485 half-duplex or modem (V.34bis,
33.6k) optionally available for each port

Connectors Two, RJ-11 modular;

One, RJ-45 modular Ethernet: 10base-T per IEEE 802.3I

12.8.3 Programmable Contact Output Connections

Two types of programmable relays are offered with the 1133A: standard mechanical,
Form-C (SPDT) and optional solid-state, Form-C for use with KYZ pulse metering. Use
protective measures when using optional KYZ-rated contacts to guard against surges that
will damage the contacts if ratings are exceeded. See “Configuring Multi-Mode Relays” in
Section 7.10, for details on configuring contacts.
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Standard Mechanical Relays

Type & Number Four, Form-C (SPDT) contact sets

Connections Pluggable 12-pole 5-mm terminal strip, with 4, 3-pole
mating connections

Rating 250 Vac/125 Vdc, 8 A max. 2000 VA/150 W max.

Isolation 4000 Vrms for 1 minute to chassis

Functions Programmable Load Control, with preset times or via
systems interface

(Selectable) Fault Failsafe (faulted with power off)

Alarm Failsafe

Out-of-Lock Failsafe

One pulse per hour; contacts closed for one minute at top
of the hour

Other Functions, as required

Optional Solid State Relays

Type Four, Form-C (SPDT), Solid State contact sets

Connections Pluggable 12-pole 5-mm terminal strip, with 4, 3-pole
mating connections

Rating 240 Volts, 120 mA, 35 Ohms max On Resistance (typical
23 Ohms)

Isolation 3750 Vrms Input/Output

Functions KYZ Pulse Metering, or any switching function requiring
long life relays that can tolerate 100 mA max ON current
and 23 Ohms resistance.

12.8.4 Event Input Connections

Type Four, optically-isolated 24 - 240 Vdc (may be configured
for 5-V logic level)

Connections Pluggable 8-pole 5-mm terminal strip, with 4, 2-pole mat-
ing connectors

Isolation 4000 Vrms for 1 minute to chassis

Resolution 1 microsecond

Types of Events / Triggers

Events are logged by triggers, and in the 1133A are separated into three groups: DSP
Triggers, Power Quality Triggers and System Level Triggers. DSP Triggers include
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any measurement processed by the DSP that meets a logical condition, such as the
frequency changing by 0.1Hz, or the line voltage dropping below 110 volts. Power Quality
triggers conform specifically to methods and definitions in IEC 61000-4-30, section 5.4,
Supply–Voltage Dips and Swells. System Triggers are 1133A conditions that may be
important to know, such as the 1133A losing GPS synchronization or the flash memory
module being full. When a triggering condition is true, then an event can be logged or
some action taken. For additional information concerning Triggering in the DSP, see
Chapter 8, Working with Triggers and Downloading Event Records.

12.9 Flash Memory Data Storage

Flash Module Removable

Capacity 16 Mbytes (standard), 32 Mbytes (optional), number of
records stored depends on data items selected.

Configuration 250, 64K blocks Registered data area (16 Mbyte, stan-
dard)

Data Selectable from all functions measured and totalized by
1133A; each record is stored with a time tag

Storage Rate Selectable; default is as follows:

15 min. - Voltage, Current, Harmonics, Frequency Vari-
ation

10 min. - Flicker

24 hours - IVDF

Power - other intervals as short as one minute may be
selected.

Event data stored upon occurrence

Lifetime 100,000 storage cycles, minimum

Data Retention Indefinite; no power or battery required for data retention
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12.10 DSP Configuration

Configuration Using PSCSV� (see Configure Operation, DSP Mode,
CT-PT Ratios and Transformer Loss Compensation. In-
ternal Calibration set at factory).

Unit Type Texas Instruments TMS320C32 Floating-Point DSP

Configuration (Default) 120 V, 5 A, 60 Hz, 3-phase / 4-wire / 3-element;
Make other available configurations through PSCSV�
software.

Mode All structures initialized to known default settings (cali-
bration values done after initialization)

12.11 IP Address

192.168.000.254 (default address) - Set up by user with PSCSV�software.

12.12 Ethernet (Physical) Address

Set at factory Last 3 pairs of 48 bits (shown in Hex) are same as unit
serial number. Check using STATUS/TIME button (e.g.
for 00-01-B3-BC-61-4E, 00-01-B3 is fixed, BC-61-4E is
the unit serial number, which is 12345678 in decimal).

12.13 Measurement Specifications

Note: Accuracy specifications include all sources of uncertainty. Except as noted, specifi-
cations apply for the full operating range, including temperature (-10◦C to +50◦C), line
voltage, input range including specified over-range, power factor, input frequency, and
drifts over a one-year calibration interval. Specifications assume synchronization to GPS
and operation in 3-element mode or in a well-balanced system where imbalance does not
degrade accuracy.
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Watts, Wh 0.025% of reading, 10% of range or greater and PF > 0.2

Under Range 0.0025% of range, below 10% of range

Power Factor 0.005% of VA, PF > 0.2

VA, VAh Same as W, Wh except no PF effect

VAR, VARh Same as W, Wh except replace PF with
√

1− PF 2

Vrms 0.02% of reading or 0.002% range, whichever is greater

Arms 0.03% of reading or 0.003% range, whichever is greater

V2h 0.04% of reading or 0.004% range, whichever is greater

A2h 0.06% of reading or 0.006% range, whichever is greater

Phase Angle, φ 0.01◦, phase-to-phase or voltage-to-current, 10% of range
minimum

Power Factor 0.0002 × sin(φ), 10% of range min.

Harmonics 0.05% THD or 5% of reading, whichever is greater

Frequency <1 ppm (0.0001%) of reading, 50 or 60 Hz nominal, plus
time base error

System Phase 0.03◦ plus [time base error × 360◦ × frequency]

System Time 1 µs plus time base error

Event Inputs 10 µs (typical)

12.14 Power Quality Measurement Capability

The 1133A is equipped to detect power quality issues and record them to flash memory
and/or send them out one of the available ports (RS-232/485/Modem and Ethernet). Flash
memory may be configured to record types of information: (1) Revenue and (2) Event data.
Revenue quantities are recorded on a fixed schedule and may include many more items than
a typical energy meter would record. Event data are logged on the occurrence of an event
trigger and designated to initiate logging data. System status is used for advanced mon-
itoring and control of the operation of the 1133A and system node to which it is connected.

Some of these power quality issues are specified below, and may be triggered as an
event through PSCSV� Software. Other Power Quality issues may be seen as Revenue
Information; this includes Energy, Voltage/Current, Frequency Variation, Flicker and
Harmonics. Specify configuration options through PSCSV� software, which is described
in Chapter 7. Regularly check the Arbiter web site at www.arbiter.com/pscsv/index.php
for updates to PSCSV�.
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12.14.1 Harmonic Measurements

Categories Harmonics Data; Harmonic Summary Data

Standard Per IEC 61000-4-7, 100-µs overlapping data window

Measurements THD, K-factor, rms harmonic current and voltage, rms
harmonic current and voltage with K-factor compen-
sation (each harmonic magnitude is multiplied by the
square of the harmonic number before summing), indi-
vidual harmonic magnitude and phase

Logged Data Selectable, may be regularly logged or registered; or
event-logged when user-specified limits are exceeded

12.14.2 Power Interruptions

Logged Data Selectable, may be regularly logged or registered; or
event-logged when user-specified limits are exceeded

Method DSP

Configuration Set up with PSCSV� (see “Configuring Triggers and
Downloading Event Data” in Section 8.2.)

12.14.3 Flicker

Standard Per IEC 61000-4-15, Pst and Instantaneous

Logged Data Selectable, may be regularly logged or registered; or
event-logged when user-specified limits are exceeded

Configuration Set up with PSCSV� (see “Configuring Triggers and
Downloading Event Data”); Download with PSCSV� ,
DNP 3.0 and Modbus and PQ-DIF.

12.15 Limit Alarms

Limit alarms may currently be defined and set through PSCSV� software and include
alarming to the display, memory and through any of the communication channels.

Functions Upper or lower limits may be set on most measured func-
tions. Limits may also be set on maximum imbalance (ra-
tio of Zero and Negative Sequence Components to Posi-
tive Sequence).

Output Via system interface and display or contact closure

Interface Configure and read with PSCSV� (see “Configuring
Multi-Mode Relays” in Section 7.10).
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12.16 System Control and Monitoring

Combining DSP and GPS technology, the 1133A can measure time-dependent electrical
system quantities and display them on the front panel or record them for future use. To
record System Time, Phase and Frequency data, see Chapter 7 on using PSCSV� software.

12.16.1 System Time, Phase and Frequency

“System” refers to the electrical system under measurement. By comparing the generated
system time and frequency to the GPS signal as a reference, the 1133A can measure and
record the (integrated) difference in time and frequency, as well as other time-related system
facts.
System Time Unlimited accumulation with 1-µs resolution

Frequency 7 digits, xx.xxxxx Hz

System Phase 0 - 360 degrees with 0.01 degree resolution

Effect of DC None; Rejected by narrow band digital filtering

& Harmonics

12.16.2 Phasors

Standard Per IEEE Standard C37.118

Rate Depends on nominal frequency; 1 - 50 measurements per
second for 50 Hz, 1 - 60 measurements per second for 60
Hz

Interface User configured through PSCSV� (see Configure Ports
– C37.118 Synchrophasor Protocol). Uses SERIAL 1 and
SERIAL 2 (RS-232, RS-485 or Modem) and the Ethernet
port, and UDP Broadcast mode uses the Ethernet port.

12.17 Synchronization

The standard 1133A includes an twelve-channel global positioning system (GPS) receiver,
which provides accurate time to a fraction of a microsecond anywhere in the world.
Optionally, choose an IRIG-B decoder to synchronize the 1133A. By comparing an
internal 10 MHz oscillator to the 1-PPS (pulse-per-second) output of the GPS receiver, the
1133A maintains its frequency to within a few parts in 1010. For IRIG-B synchronization
(Option 07), timing signals are as accurate as the IRIG-B clock source.
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12.17.1 GPS Information

Tracking GPS-L1 (1575.42 MHz) - 12 Channel, tracks up to 12
satellites depending on receiver model

Acquisition 2 minutes, typical

Accuracy UTC - USNO ±1 µs

Out-of-Lock Via system interface and status display; optional, via con-
tact closure

Indication Satellite Tracking, view from front panel, STATUS key

12.17.2 GPS Antenna / Cable Characteristics

Power +5 Volts DC, 30 mA max., supplied through antenna
cable from 1133A

Frequency 1575.42 MHz

Gain 35 dB (nominal)

VSWR 2:1

Mounting 3/4-inch NPT pipe thread (1” - 14 marine type) mount

Dimensions 77.5 mm diameter x 66.20 mm height (3.05” x 2.61”)

Weight 170 grams (6.0 oz.)

Connections Type-F

Cable Type RG-6, 15 m (50 ft) included; longer cables option-
ally available

12.17.3 Synchronization Output - IRIG-B

The 1133A includes one IRIG-B output for use with synchronizing external equipment.
Type One; two-pole; IRIG-B000 or IRIG-B003 per IEEE std.

1344 (unmodulated or DC level-shift), 200 mA peak;
pluggable 5-mm terminal strip with mating connector

12.17.4 Time Base Error

GPS Locked Less than 1 µs, when locked to at least one satellite

Unlocked 10 ppm, typical, after being locked for 10 minutes mini-
mum (< 1 second/day unlocked, typical)

12.18 Instrument Power Requirements

The 1133A derives its operating power from an integral power supply. Two power supplies
are available. The standard Option-03 power supply accepts high-voltage, ac or dc inlet
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power. Option 04 accepts only low-voltage dc inlet power. Both options use the same
terminal strip for the power line connection.
Option 03 85 - 264 Vac, 47 - 63 Hz or 110 - 250 Vdc, 5 VA, typical

Option 04 10 - 60 Vdc, 5VA, typical. (DC only)

Input Terminal strip with fuse; surge withstand per ANSI C37-
90.1 and IEC 801-4 standard

12.19 General Specifications

12.19.1 Physical Specifications

Size 1 RU (430 mm W x 44 mm H) rack mount or tabletop;
260 mm deep FMS. Rack mounts included.

Weight 2 kg (4.5 lbs.), net

5 kg (11 lbs.), shipping

12.19.2 Environmental Specifications

Temperature Standard Operating: -10◦ to +50◦ C

non-operating: -40◦ to +85◦ C

Humidity Non-condensing
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Chapter 13

DNP 3.0 and MODBUS Data
Structures

13.1 Introduction

Arbiter Systems provides additional capability and flexibility for data acquisition within
the Model 1133A by supporting both DNP 3.0 and Modbus protocols.

Prior to using a DNP 3.0 or Modbus application to access 1133A data, configure the 1133A
for these protocols using PSCSV�software. To set up the 1133A for use with Modbus or
DNP 3.0, see Configuring Modbus Protocol and Configuring DNP 3.0 Protocol in Section 7.

The majority of information in this section consists of the tables of index values used to
access 1133A data from other software applications specifically designed for use with DNP
3.0 or Modbus. While these index codes have been tested successfully, Arbiter Systems
has no control over the performance and suitability of using these applications with the
Model 1133A, and makes no claim or warranty in this regard.

13.2 Definitions and Conventions

13.2.1 DNP 3.0

DNP 3.0 is an industry standard SCADA communications protocol originating in the
electric industry in the USA. DNP 3.0 describes standards for SCADA protocol facilities
such as data requests, polling, controls, and report by exception (RBE), where master-slave
and peer-to-peer communication architectures are supported. A master device issues
commands and the slave device responds to the commands.

Using DNP 3.0, the Model 1133A is considered a slave device that only responds to
commands from the master with data or status. You cannot configure the 1133A using
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DNP 3.0. Configure the 1133A through PSCSV�software only.

13.2.2 Modbus

Modbus Protocol is a messaging structure, widely used to establish master-slave commu-
nication between intelligent devices. A Modbus message sent from a master to a slave
contains the address of the slave, the command, the data, and a check sum (LRC or CRC).
It is traditionally implemented using RS232, RS422, or RS485 over a variety of media, but
also is available as Modbus TCP/IP. Modbus can be transmitted via two modes: ASCII
and RTU. With ASCII, each twelve-bit byte in a message is sent as 2 ASCII characters,
and with RTU, each twelve-bit byte is sent as two four-bit hexadecimal characters.

13.2.3 32-Bit Numbers / Little Endian

Indices in boldface represent 32-bit values, 2 16-bit values each. Little endian means that
the lower-indexed value contains the lower half (16 least-significant bits) of the 32-bit
quantity. Example: to find the A Active Energy Delivered 32-bit value, use: 65536 *
DNP[729] + DNP[728]. 32-bit register values are scaled according to the values of Kp set
separately using PSCSV�configuration.

13.2.4 Scale Factors

The scale factors Vmax (maximum rms voltage, volts), Imax (maximum rms current,
amperes), Pmax (maximum per-element power, watts) and Ptmax (maximum total power,
watts) are set using PS-CSV configuration. These values are stored internally in the
Model 1133A, and are used as shown below to scale the various integer results in the
DNP/Modbus integer data structure.
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DNP Modbus Quantity Full Scale
Type:Index Input Reg.

AI:0 30001 A Voltage Vmax = 32767
AI:1 30002 A Voltage Phase ±180deg = ±32767
AI:2 30003 C Voltage Vmax = 32767
AI:3 30004 C Voltage Phase ±180deg = ±32767
AI:4 30005 B Voltage Vmax = 32767
AI:5 30006 B Voltage Phase ±180deg = ±32767

AI:6 30007 A Current Imax = 32767
AI:7 30008 A Current Phase ±180deg = ±32767
AI:8 30009 C Current Imax = 32767
AI:9 30010 C Current Phase ±180deg = ±32767
AI:10 30011 B Current Imax = 32767

AI:11 30012 B Current Phase ±180deg = ±32767
AI:12 30013 Zero Sequence Voltage Vmax = 32767
AI:13 30014 Zero Sequence Voltage Phase ±180deg = ±32767
AI:14 30015 Positive Sequence Voltage Vmax = 32767
AI:15 30016 Positive Sequence Voltage Phase ±180deg = ±32767

AI:16 30017 Negative Sequence Voltage Vmax = 32767
AI:17 30018 Negative Sequence Voltage Phase ±180deg = ±32767
AI:18 30019 Zero Sequence Current Imax = 32767
AI:19 30020 Zero Sequence Current Phase ±180deg = ±32767
AI:20 30021 Positive Sequence Current Imax = 32767

AI:21 30022 Positive Sequence Current Phase ±180deg = ±32767
AI:22 30023 Negative Sequence Current Imax = 32767
AI:23 30024 Negative Sequence Current Phase ±180deg = ±32767

Table 13.1: Voltage and Current Register Values

13.3 Voltage and Current Data Structure

The 1133A measures any voltage and current by scaling an analog input (AI)1 according
to PT or CT values stored in the 1133A. Users also select a nominal range to maximize
accuracy, e.g. 0 to 5 Amps, or 0 to 150 Volts. Make these selections using PSCSV�software
prior to recording any data or the data will not be accurate.
Thereafter, DNP users should be able to download any of the Quantities listed in Table
A-1 by using the Index value associated with it.
For example, call B-phase current magnitude with index number 10, or B-phase current
phase angle with index number 11. The measurement resolution is determined by the
maximum current divided by 32767.

1AI indicates analog-input point, CT indicates Counter Point, BI indicates Binary Input
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DNP Modbus Quantity Full Scale
Type:Index Input Reg.

AI:24 30025 A Active Power (W) ±Pmax = ±32767
AI:25 30026 A Reactive Power (VAR) ±Pmax = ±32767
AI:26 30027 A Apparent Power (VA) Pmax = 32767
AI:27 30028 A Power Factor ±1.0000 = ±32767
AI:28 30029 A Q ±Pmax = ±32767

AI:29 30030 Reserved 0
AI:30 30031 C Active Power (W) ±Pmax = ±32767
AI:31 30032 C Reactive Power (VAR) ±Pmax = ±32767
AI:32 30033 C Apparent Power (VA) Pmax = 32767
AI:33 30034 C Power Factor ±1.0000 = ±32767

AI:34 30035 C Q ±Pmax = ±32767
AI:35 30036 Reserved 0
AI:36 30037 B Active Power (W) ±Pmax = ±32767
AI:37 30038 B Reactive Power (VAR) ±Pmax = ±32767
AI:38 30039 B Apparent Power (VA) Pmax = 32767

AI:39 30040 B Power Factor ±1.0000 = ±32767
AI:40 30041 B Q ±Pmax = ±32767
AI:41 30042 Reserved 0
AI:42 30043 Total Active Power (W) ±Ptmax = ±32767
AI:43 30044 Total Reactive Power (VAR) ±Ptmax = ±32767

AI:44 30045 Total Apparent Power (VA) Ptmax = 32767
AI:45 30046 Total Power Factor ±1.0000 = ±32767
AI:46 30047 Total Q ±Ptmax = ±32767
AI:47 30048 Reserved 0

Table 13.2: Power Register Values

13.4 Power Data Structure

The 1133A determines power quantities based on the cross product of measured voltages
and currents. For additional details on this measurement, see Section 6, Functional De-
scription, Power and Energy.
DNP users should be able to download any of the Quantities listed in Table A-2 by using
the Index value associated with it.
For example, call C–phase Active Power with index number 29, or C-phase power factor
with index number 11. The measurement resolution is determined by the maximum current
divided by 32767.
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13.5 Frequency, Flicker and Relative Phase Data Structure

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

AI:48 30049 Frequency 655.35 Hz = 32767
AI:49 30050 Frequency Error ±32.767 Hz = ±32767
AI:50 30051 Frequency Rate of Change ±327.67 Hz/s = ±32767
AI:51 30052 Reserved 0
AI:52 30053 System Time Deviation (seconds) ±327.67 sec = ±32767

AI:53 30054 System Time Deviation (cycles) ±3276.7 cycles = ±32767
AI:54 30055 Instantaneous Flicker, A Voltage 6553.5 Flicker = 32767
AI:55 30056 Instantaneous Flicker, A Current 6553.5 Flicker = 32767
AI:56 30057 Instantaneous Flicker, C Voltage 6553.5 Flicker = 32767
AI:57 30058 Instantaneous Flicker, C Current 6553.5 Flicker = 32767

AI:58 30059 Instantaneous Flicker, B Voltage 6553.5 Flicker = 32767
AI:59 30060 Instantaneous Flicker, B Current 6553.5 Flicker = 32767
AI:60-63 30061-64 Reserved (4 values) 0
AI:64 30065 A Voltage Relative Phase (rel. to A Volt-

age)
Ref. = 0

AI:65 30066 A Current Relative Phase ±180deg = ±32767

AI:66 30067 C Voltage Relative Phase ±180deg = ±32767
AI:67 30068 C Current Relative Phase ±180deg = ±32767
AI:68 30069 B Voltage Relative Phase ±180deg = ±32767
AI:69 30070 B Current Relative Phase ±180deg = ±32767
AI:70 30071 Zero Sequence Voltage Relative Phase ±180deg = ±32767

AI:71 30072 Zero Sequence Current Relative Phase ±180deg = ±32767
AI:72 30073 Positive Sequence Voltage Relative Phase ±180deg = ±32767
AI:73 30074 Positive Sequence Current Relative Phase ±180deg = ±32767
AI:74 30075 Negative Sequence Voltage Relative

Phase
±180deg = ±32767

AI:75 30076 Negative Sequence Current Relative
Phase

±180deg = ±32767

Table 13.3: Frequency, Flicker and Relative Phase Register Values
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Frequency, Flicker and Relative Phase Register Values, continued.

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

AI:76 30077 A Voltage Relative Phase (rel. to A Cur-
rent)

±180deg = ±32767

AI:77 30078 A Current Relative Phase ±180deg = ±32767
AI:78 30079 C Voltage Relative Phase ±180deg = ±32767
AI:79 30080 C Current Relative Phase Ref. = 0
AI:80 30081 B Voltage Relative Phase ±180deg = ±32767

AI:81 30082 B Current Relative Phase ±180deg = ±32767
AI:82 30083 Zero Sequence Voltage Relative Phase ±180deg = ±32767
AI:83 30084 Zero Sequence Current Relative Phase ±180deg = ±32767
AI:84 30085 Positive Sequence Voltage Relative Phase ±180deg = ±32767
AI:85 30086 Positive Sequence Current Relative Phase ±180deg = ±32767

AI:86 30087 Negative Sequence Voltage Relative
Phase

±180deg = ±32767

AI:87 30088 Negative Sequence Current Relative
Phase

±180deg = ±32767

AI:88-95 30089-96 Reserved (8 Values) 0
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13.6 Harmonic and Harmonic Summary Data Structure

DNP Modbus Quantity Full Scale
Type:Index Input

Reg.

AI:96 30097 A RMS Harmonic Voltage Vmax = 32767
AI:97 30098 A RMS Harmonic Voltage, K-Factor Adjusted Vmax = 32767
AI:98 30099 A Voltage RMS THD, Fundamental Reference 100% = 32767
AI:99 30100 A Voltage RMS THD, Total Signal Reference 100% = 32767
AI:100 30101 A Voltage K-Factor 65.535 = 32767

AI:101 30102 A RMS Harmonic Current Imax = 32767
AI:102 30103 A RMS Harmonic Current, K-Factor Adjusted Imax = 32767
AI:103 30104 A Current RMS THD, Fundamental Reference 100% = 32767
AI:104 30105 A Current RMS THD, Total Signal Reference 100% = 32767
AI:105 30106 A Current K-Factor 65.535 = 32767

AI:106 30107 C RMS Harmonic Voltage Vmax = 32767
AI:107 30108 C RMS Harmonic Voltage, K-Factor Adjusted Vmax = 32767
AI:108 30109 C Voltage RMS THD, Fundamental Reference 100% = 32767
AI:109 30110 C Voltage RMS THD, Total Signal Reference 100% = 32767
AI:110 30111 C Voltage K-Factor 65.535 = 32767

AI:111 30112 C RMS Harmonic Current Imax = 32767
AI:112 30113 C RMS Harmonic Current, K-Factor Adjusted Imax = 32767
AI:113 30114 C Current RMS THD, Fundamental Reference 100% = 32767
AI:114 30115 C Current RMS THD, Total Signal Reference 100% = 32767
AI:115 30116 C Current K-Factor 65.535 = 32767

Table 13.4: Harmonic and Harmonic Summary Register Values

Harmonic and Harmonic Summary values continue on next page.

For technical details on how the Model 1133A measures harmonics and calculates harmonic
summary data, see Section 11.14, in the Functional Description. DNP users should be
able to download any of the Quantities listed in Table A-4 by using the Index value
associated with it. For example, call C-phase, RMS Harmonic Current with index number
111. The measurement resolution is determined by the maximum current divided by 32767.
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Harmonic and Harmonic Summary Register Values, continued.

DNP Modbus Quantity Full Scale
Type:Index Input

Reg.

AI:116 30117 B RMS Harmonic Voltage Vmax = 32767
AI:117 30118 B RMS Harmonic Voltage, K-Factor Adjusted Vmax = 32767
AI:118 30119 B Voltage RMS THD, Fundamental Reference 100% = 32767
AI:119 30120 B Voltage RMS THD, Total Signal Reference 100% = 32767
AI:120 30121 B Voltage K-Factor 65.535 = 32767

AI:121 30122 B RMS Harmonic Current Imax = 32767
AI:122 30123 B RMS Harmonic Current, K-Factor Adjusted Imax = 32767
AI:123 30124 B Current RMS THD, Fundamental Reference 100% = 32767
AI:124 30125 B Current RMS THD, Total Signal Reference 100% = 32767
AI:125 30126 B Current K-Factor 65.535 = 32767
AI:126,
127

30127,
30128

Reserved (2 values) 0
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13.7 Individual Harmonic Voltages and Currents

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

AI:128–227 30129-30228 A Voltage Individual Harmonic Data Vmax=32767
(see note below) ±180deg = ±32767

AI:228–327 30229-30328 A Current Individual Harmonic Data Imax=32767
(see note below) ±180deg = ±32767

AI:328–427 30329-30428 C Voltage Individual Harmonic Data Vmax=32767
(see note below) ±180deg = ±32767

AI:428–527 30429-30528 C Current Individual Harmonic Data Imax=32767
(see note below) ±180deg = ±32767

AI:528–627 30529-30628 B Voltage Individual Harmonic Data Vmax=32767
(see note below) ±180deg = ±32767

AI:628–727 30629–30728 B Current Individual Harmonic Data Imax=32767
(see note below) ±180deg = ±32767

Table 13.5: Individual Harmonic Voltages and Currents

Note
Quantity Value: A Voltage Individual Harmonic Data:
Magnitude [ n ]= DNP [ Type Index + 2n ]
Phase [ n ]= DNP [ Type Index + 2n ];
where n = 1 . . . 50 (where 1 is the fundamental)

For technical details on how the Model 1133A measures harmonics and calculates harmonic
summary data, see Section 11.14.

Examples Remember that magnitudes are actual scaled primary values and the resolution
is determined by dividing the maximum primary value by the Full Scale count. For
example, if the actual primary current is 96.5 Amps, with a maximum (1133A) current
range of 2.5 Amps (CT ratio of 100), then the resolution is 250 ÷ 32767 = 0.0076 Amps.
Phase angles are actual and resolution is determined by dividing ±180 by ±32767 (e.g.
0.0055 degrees)

1. Request the third harmonic magnitude of the A-phase voltage: Value is 232. Calcu-
late the Index value: 226 + 2(3) = 232

2. Request the third harmonic phase angle of the A-phase current: Value is 233. Cal-
culate the Index value: 227 + 2(3) = 233
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13.8 Energy Register Values

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

PIc:0 30729–30730 A Active Energy Delivered Register (Wh) 32-bit integer
PIc:1 30731–30732 C Active Energy Delivered Register (Wh) 32-bit integer
PIc:2 30733–30734 B Active Energy Delivered Register (Wh) 32-bit integer
PIc:3 30735–30736 Total Active Energy Delivered Register (Wh) 32-bit integer
PIc:4 30737–30738 A Active Energy Received Register (Wh) 32-bit integer
PIc:5 30739–30740 C Active Energy Received Register (Wh) 32-bit integer

PIc:6 30741–30742 B Active Energy Received Register (Wh) 32-bit integer
PIc:7 30743–30744 Total Active Energy Received Register (Wh) 32-bit integer
PIc:8 30745–30746 A Apparent Energy Delivered Register (VAh) 32-bit integer
PIc:9 30747–30748 C Apparent Energy Delivered Register (VAh) 32-bit integer
PIc:10 30749–30750 B Apparent Energy Delivered Register (VAh) 32-bit integer

PIc:11 30751–30752 Total Apparent Energy Delivered Register (VAh) 32-bit integer
PIc:12 30753–30754 A Apparent Energy Received Register (VAh) 32-bit integer
PIc:13 30755–30756 C Apparent Energy Received Register (VAh) 32-bit integer
PIc:14 30757–30758 B Apparent Energy Received Register (VAh) 32-bit integer
PIc:15 30759–30760 Total Apparent Energy Received Register (VAh) 32-bit integer

PIc:16 30761–30762 A Reactive Energy Register, Quadrant 1 (VARh) 32-bit integer
PIc:17 30763–30764 C Reactive Energy Register Quadrant 1 (VARh) 32-bit integer
PIc:18 30765–30766 B Reactive Energy Register Quadrant 1 (VARh) 32-bit integer
PIc:19 30767–30768 Total Reactive Energy Register Quadrant 1

(VARh)
32-bit integer

PIc:20 30769–30770 A Reactive Energy Register Quadrant 2 (VARh) 32-bit integer

PIc:21 30771–30772 C Reactive Energy Register Quadrant 2 (VARh) 32-bit integer
PIc:22 30773–30774 B Reactive Energy Register Quadrant 2 (VARh) 32-bit integer
PIc:23 30775–30776 Total Reactive Energy Register Quadrant 2

(VARh)
32-bit integer

PIc:24 30777–30778 A Reactive Energy Register, Quadrant 3 (VARh) 32-bit integer
PIc:25 30779–30780 C Reactive Energy Register Quadrant 3 (VARh) 32-bit integer

Table 13.6: Energy Values
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Energy Register Values, continued

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

PIc:26 30781–30782 B Reactive Energy Register Quadrant 3 (VARh) 32-bit integer
PIc:27 30783–30784 Total Reactive Energy Register Quadrant 3

(VARh)
32-bit integer

PIc:28 30785–30786 A Reactive Energy Register Quadrant 4 (VARh) 32-bit integer
PIc:29 30787–30788 C Reactive Energy Register Quadrant 4 (VARh) 32-bit integer
PIc:30 30789–30790 B Reactive Energy Register Quadrant 4 (VARh) 32-bit integer

PIc:31 30791–30792 Total Reactive Energy Register Quadrant 4
(VARh)

32-bit integer

PIc:32 30793–30794 A Qh Delivered Register 32-bit integer
PIc:33 30795–30796 C Qh Delivered Register 32-bit integer
PIc:34 30797–30798 B Qh Delivered Register 32-bit integer
PIc:35 30799–30800 Total Qh Delivered Register 32-bit integer

PIc:36 30801–30802 A Qh Received Register 32-bit integer
PIc:37 30803–30804 C Qh Received Register 32-bit integer
PIc:38 30805–30806 B Qh Received Register 32-bit integer
PIc:39 30807–30808 Total Qh Received Register 32-bit integer
PIc:40 30809–30810 A Volt-Squared Hour Register 32-bit integer

PIc:41 30811–30812 C Volt-Squared Hour Register 32-bit integer
PIc:42 30813–30814 B Volt-Squared Hour Register 32-bit integer
PIc:43 30815–30816 Total Volt-Squared Hour Register 32-bit integer
PIc:44 30817–30818 A Amp-Squared Hour Register 32-bit integer
PIc:45 30819–30820 C Amp-Squared Hour Register 32-bit integer

PIc:46 30821–30822 B Amp-Squared Hour Register 32-bit integer
PIc:47 30823–30824 Total Amp-Squared Hour Register 32-bit integer
PIc:48 30825–30826 A Volt-Hour Register 32-bit integer
PIc:49 30827–30828 C Volt-Hour Register 32-bit integer
PIc:50 30829–30830 B Volt-Hour Register 32-bit integer

PIc:51 30831–30832 Total Volt-Hour Register 32-bit integer
PIc:52 30833–30834 A Amp-Hour Register 32-bit integer
PIc:53 30835–30836 C Amp-Hour Register 32-bit integer
PIc:54 30837–30838 B Amp-Hour Register 32-bit integer
PIc:55 30839–30840 Total Amp-Hour Register 32-bit integer
PIc:56 30841–30842 Reserved Registers (8) (16 values) 32-bit integer
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Notes on Energy Values For technical details on how the Model 1133A measures energy
data, see Section 11.8

1. Returned values are count values and are scaled in customers application software.

2. Indices in boldface represent 32-bit values, 2 16-bit values each. Little endian means
that the lower-indexed value contains the lower half (16 least-significant bits) of the
32-bit quantity. Example: to find the A Active Energy Delivered 32-bit value, use:
65536 * DNP[729]+ DNP[728]. 32-bit register values are scaled according to the
values of Kp set separately using PSCSV�configuration.

13.9 Trigger Status

DNP Modbus Quantity Full Scale
Type:Index Input Reg.

BI:0 30843–30844 DSP Trigger Status 32-bit bitfield

Table 13.7: Trigger Status Values

Notes:
Bitfield:
AI indicates analog-input point, CT indicates Counter Point, BI indicates Binary Input
Values are Little Endian. See Introduction at the beginning of Appendix A.
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Event Input Voltage Settings

14.1 General Information

This section describes two configurations of the 1133A Event Inputs, and the installation
of resistors to change the Event Input voltage range from 24–240 Vdc to 5 Vdc CMOS level.

14.2 Event Input Specifications

For your convenience, the Event Input specifications are repeated below in Table 14.1.

Part Specification
Type & Number Four, optically-isolated 24-240 Vdc (may be configured

for 5-Vdc logic level)
Connections Pluggable, 8-pole, 5-mm terminal strip, with 4, 2-pole

mating connectors
Isolation 4000 Vrms for 1 minute to chassis
Resolution 1 µs

Table 14.1: Event Input Specifications

14.3 Standard Event Input Voltage, 24-240 Vdc

All of the four event inputs on the 1133A Power Quality / Revenue Standard are configured
for an input voltage range of 24-240 Vdc. For the standard setting NONE of the four
optional resistors need to be installed, i.e. R225, R226, R227, R228 (See Figure 14.1).
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14.4 Optional Event Input Voltage, 5 Vdc, Logic Level

To set up the Event Inputs for a 5 Vdc, follow the instructions below.

WARNING! Do not remove the top cover while power is applied. Hazardous voltages
are present while the power cord is connected. Always disconnect the unit from the input
power source before removal of the top cover.

CAUTION! Use care handling any of the components for static discharge.

1. Set the Line Power switch to OFF position (if so equipped). Disconnect power cord
from rear panel.

2. Remove rack-ears (if so equipped) and remove the top cover using a T-25 driver (4
screws).

3. Carefully remove all connectors attached to the main board. Use special care with
the white antenna cable/connector to the GPS receiver board. The center pin is very
thin and breakable.

4. Remove all of the screws to input connectors attached at the rear panel of the chassis.

5. Remove the two screws to the Memory Board, located near the right-front of the
chassis, and lift out the memory module. Grasp across the narrow side of the memory
board near the connector and pull up.

6. Remove the six screws holding the main board and carefully slide it forward to allow
for release of the RJ serial connectors at the right rear of the chassis.

7. Locate the four resistor positions (R225, R226, R227, R228) near the Event Input
connectors. See Figure 14.1.

8. Clean the solder out of the holes for each of the resistors, and install a 511 Ohm
resistor in each location.

9. Replace all of the components in the reverse order described above, and restore the
unit into service.
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Figure 14.1: Event Input Resistor Settings
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Chapter 15

Accurate CT Calibration for the
Model 1133A

15.1 Overview

The Model 1133A Power Sentinel� offers accuracy in power measurement of 0.025%.
Existing CTs provide accuracy of a few tenths of one percent. How then can the 1133A
actually provide accuracy of 0.025% in the field?

The answer is by calibrating the existing CT’s. By comparing each CT to an accurate
reference CT, traceable to national standards (for example, NIST in the USA), the errors
of the test CT can be determined at several currents and the correction factors entered
into a table in the 1133A. The 1133A uses these correction factors, interpolating between
them based on the measured current, to correct measured power (and current) to the
actual values, in real time, within the instruments stated accuracy.

15.2 Calibration Process

To calibrate the CT’s requires three things: (1) a calibrated reference CT, (2) a source of
high current, and (3) some means of comparison. Each of these will be addressed below.

15.3 Calibrated Reference CT

Arbiter Systems has developed the Model 936A, an accurate, multi-ratio reference
CT suitable for these calibrations, and suitable for calibration by national standards
laboratories at an accuracy which exceeds 0.01% (the present limit of traceability at
NIST). This CT will have ratios of 1200:5, 1000:5, 800:5, and 600:5. It will oper-
ate accurately at currents from 0 to 200% of rating. Using a two-stage, amplifier-aided
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design, this CT should be fundamentally capable of accuracy better than 10 ppm (0.001%).

By using a multi-turn primary through the center of the reference CT, current ratios
of (1200 ÷ N):5, (1000 ÷ N):5, (800 ÷ N):5, and (600/N):5 can be provided as well
(with N equal to the number of turns). By using a multi-turn primary on the CT
under test, ratios of (1000 × M):5, (800 × M):5, and so on can also be provided. And
finally, by using both N turns through the reference CT and M turns through the CT
under test, ratios of (1000 × M ÷ N):5, (800 × M ÷ N):5, can be provided. This al-
lows a wide range of test CT ratios to be calibrated with a single accurate reference artifact.

15.4 Excitation Current Source

For a high current supply required to perform the calibration, consider the Model 935A,
Current Source. This will work on the principle of a CT in reverse, that is, a donut having
a multi-turn primary excited at a reasonable current level (5 to 10 amps maximum). This
device will allow a heavy-gauge winding to be placed through its center, exciting it at the
high currents required (up to 2000 ampere-turns).

While it is possible, and perhaps even desirable on some accounts, to provide a regulated,
solid-state source to drive the excitation coil, this would be very expensive and heavy
considering the powers involved (up to 1000 VA). Due to the accurate ratio-metric
measurement technique to be proposed in the next section, it is not necessary to have the
excitation current be particularly accurate or even stable. Therefore, we can use a much
simpler brute-force design based on a multi-tap autotransformer and Variac to set the
current. The design contemplated will offer settings for input voltage range (100, 120, 200,
220 and 240 Vrms) and output range (100, 50, 20, 10 and 5% of full-scale), and continuous
adjustment from zero to the selected output range. The device would be powered on site
from the ac–mains power.

15.5 Comparison Technique

The most direct method of comparison involves making a measurement using the refer-
ence CT, then using the unknown, and then calculating the ratio correction factor and
phase angle from the data (Figure 15.1). This has the drawbacks that the current source
and measurement device must be substantially more accurate and stable than the desired
measurement result, typically by a factor of 4 or 5. If this were possible, it would greatly
increase the cost and size of the equipment.
A better technique is called nulling (Figure 9-2). In this method, the outputs of the two
CT’s, reference and test, are subtracted electrically by using superposition (Kirchhoffs
law), and the difference (error) measured directly. This subtraction is exact, and
introduces no error. Using a second channel of the same measuring instrument, the
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Figure 15.1: Comparison Technique A

actual secondary current can also be measured, and the ratio correction factor and phase
angle are then determined mathematically. Best of all, if the measuring instrument can
make the two measurements simultaneously, then effects of source variations cancel out.
Furthermore, since the quantity being measured is a small error, equal to at most about
1% of the secondary current, then the accuracy required of the measuring instrument
could be relaxed as well.

The ideal instrument to make this comparison is the Arbiter Systems Model 931A
Power System Analyzer. This instrument samples both of its selected input channels
simultaneously, meeting the requirement stated above. Best of all, measuring the error
current with 0.05% accuracy, the Model 931A is capable of making this comparison at a
level of 5 ppm of the secondary current (0.05% of 1%). This standards-lab performance
can readily be achieved in the field using rugged, portable equipment designed for field
use, operated by service technicians with little or no training in metrology techniques.

Figure 15.2: Comparison Technique B
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15.6 Accessories

This setup will be provided with the necessary accessories to perform the required
calibrations. The cable carrying the high primary current will be AWG 4/0 welding cable,
capable of up to 500 amps current. For applications where the cable can be run through
the center of the test CT, a single long length (about 15m or 50 ft.) of cable will be
provided, allowing for multi-turn setups. To perform a calibration of, for example, a
1000:5 CT at currents up to 2000 amperes, four turns are required through each of the
excitation CT, the test CT, and the reference CT.

For applications where the current must be provided to a bar running through the test
CT, four shorter (3m or 10 ft.) cables will also be provided. The lugged ends of all of the
cables are connected to the primary of the test CT. This would form a single-turn loop,
with each cable carrying 500 of the 2000 amperes of current.

Software will be provided to automate the data gathering and reduction process, using a
serial connection to the Model 931A and prompting the operator to perform the proper
hookup and settings of the other equipment. The data could later be printed out, and it
can be stored in a data file suitable for use when configuring the 1133A, eliminating a
manual step where errors could enter into the process.

Hardware required for connecting the lugged ends of the cables together, completing the
high-current loop, and tools to tighten the hardware to specification, will also be a part of
the kit.

15.7 Selection of the Current Calibration Points

The proper choice of calibration points (test currents) satisfies two criteria: first, the
points chosen should allow complete characterization of the CT; and second, the points
should allow for accurate interpolation. Since CT’s are magnetic devices, they have error
curves, which are smooth and do not have jumps or breakpoints. Usually, either a linear
(1, 2, 3, 4, 5) or logarithmic (0.1, 0.2, 0.5, 1.0, 2.0) progression of the test current values
will provide an accurate characterization of the CT performance.

Many interpolation algorithms do not easily deal with non-linear input progressions, often
yielding bizarre results. The algorithm chosen for the 1133A will operate well with either
logarithmic or linear progression of test points. No algorithm can be expected to yield
acceptable performance if the test points are not spaced out in some logical manner.
For example, the test sequence (0.1, 0.2, 0.3, 10, 15, 20) might seem reasonable for a
device which had relatively large errors at the ends of its range, and small, consistent
errors in the midrange. However, the large hole in the middle is certain to confound
any general-purpose interpolation algorithm with more complex-than-linear interpolation.
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What will confuse the algorithm is the dramatic change in the slope of the x-axis points
at 0.3 and 10. Using points with a relatively predictable and consistent pattern, such as
logarithmic or linear progression, will eliminate this potential problem.

To determine which is the best choice for a particular type of CT, you could characterize
the CT initially using enough points to thoroughly describe its performance. Then, the
points can be plotted on graph paper (or using a spreadsheet program) with log and linear
axes for the current values. Whichever curve appears smoother and more representative
of the CT to the eye is probably the best choice for the calibration point sequence. In
general, logarithmic sequences (1, 2, 5, and 10) emphasize the lower current values and
linear (1, 2, 3, 4, 5) sequences emphasize the higher current values. Where the errors
are changing rapidly at the low end of the current range (usually due to changes in
permeability of the core as a function of current level), a logarithmic progression will
usually work best. When the errors are changing rapidly at the high end of the current
range (usually due to incipient saturation of the core with increasing burden voltage),
then a linear progression might be a better choice (although a reduction in burden will
almost certainly improve overall performance).

15.8 Conclusion

Taking advantage of the full accuracy of the 1133A Power Sentinel requires calibration of
the users CT’s. This paper presents a method to perform these calibrations.

Calibrating existing CT’s requires three extra pieces of equipment: a reference CT, an
excitation current source and a current comparator. Two newly developed products by
Arbiter Systems should provide users with these tools for on site calibrations. The Model
935 Current Source and Model 936 Reference CT are now available for this purpose.
The popular Arbiter Systems Model 931 Power System Analyzer can accept three-phase
primary currents up to 2000 amperes (higher under some conditions), with a transfer
accuracy of 5 ppm and an overall traceable accuracy of 0.01%, or better.
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Appendix A

Working with Ethernet
Connections

A.1 Checking the Computer Network Settings

There are two methods of setting network values in your Windows computer: automat-
ically or manually. To check how the addresses are set up in your machine, select the
following:

1. Select Start > Network and Dial Up Connections > Local Area Connection, or Start
> Settings > Control Panel > Network and Dial Up Connections, then right click on
Local Area Connection.

2. On the Local Area Connection window, click on Properties.

3. Select Internet Protocol (TCP/IP) under the area marked Components checked are
used by this connection, and click on Properties.

4. In the upper settings block, one of the two possible radio buttons will be selected:
Obtain an IP address automatically, or Use the following IP address.

If the Network settings on the computer are set up automatically, then the values will not
be listed in the Internet Protocol (TCP/IP) Properties window. To check the current IP
address values, run ipconfig at the command prompt (DOS prompt) as follows:

1. In Windows 2000, select Start > Programs > Accessories > Command Prompt; in
Windows 98 select Start > Programs > MS-DOS.

2. At the prompt, C:\ > type the word ipconfig. The following values are representative
of a Windows 2000 machine on a local network.
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C:\ >ipconfig
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection
Connection-specific DNS suffix . :ASI
IP address. . . . . . . . . . . :100.101.0.103
Subnet Mask . . . . . . . . . . :255.255.255.0
Default Gateway . . . . . . . . :100.101.0.4

A.2 Setting an IP Address on the Computer

In some situations, it may be better to set up the network values manually. Set the IP
address manually if directly connecting the 1133A to the computer Ethernet card with a
crossover cable or through a hub. Later, you can reset the network values to be set up
automatically when connected to your LAN.

1. Follow steps 1 - 4 above and check the radio button labeled Use the following IP
address.

2. Type in the IP address and subnet mask values that you wish and close the window(s).
A gateway address should not be necessary.

3. Do not use an IP address with the last values higher than 254. It may be a good idea
to set up the computer IP address and that of the 1133A to sequential numbers, like
100.101.102.1 and 100.101.102.2.

4. Click OK and restart your computer.

A.3 Setting an IP Address on the 1133A

Use the RS-232 cable and RJ-11 to DB-9F adapter to set the IP address on the 1133A.

1. Connect the cable and adapter between the computer and the 1133A. Note which
COM port you are connected to on both the computer and the 1133A.

2. Open PSCSV software and connect with the 1133A. Make certain that you have
chosen the correct port on the computer.

3. If necessary, check the COM 1 or 2 settings on the 1133A so that they agree with
those you are using with PSCSV.

4. Log on to the 1133A with Permission to configure.
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5. Choose Connection > Configure > Communication Ports, or click the Configure Ports
button.

6. In the Configure Ports window, select Ethernet and type in the IP address in the
right-hand window named IP Address.

7. Click OK and the address should now be installed. Check this by pressing and
the STATUS/TIME button on the 1133A. If necessary, press and hold the STA-
TUS/TIME button on the 1133A for three seconds to move to the second set of
menus. The new IP address should appear with the subnet mask value.

8. You must restart the 1133A for the new IP address be in effect.
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Appendix B

Using Surge Protectors and
Technical Specifications

B.1 Introduction

1 Today’s data equipment has become extremely vulnerable to a phenomenon known as
voltage and electrical transients. A single IC package can contain over 100,000 memory
bits and more than 5,000 logic gates. The high sensitivity due to the small size of the chips
used in these packages makes them susceptible to quick degradation from voltage surges
and transients. PLC’s, MUX’s, HUB’s, RTU’s, SCADA, and Telemetry equipment are
especially vulnerable to electrical surges because of their low operation voltages. Many of
these components can be damaged beyond repair by an electrical surge as low as 20 volts.

Sources of electrical surges are numerous. The most common is a nearby lightning strike,
which will affect nearby data lines through induction. Industrial transients are also sig-
nificant because they are man made disturbances caused by switching and commuting of
electrical motors. The operation of such devices can cause abrupt shifts in the ground
potential that can generate a current flow through a nearby data-line in order to equalize
the ground potential.

Electrostatic discharge is another form of an electrical surge that can be included in this
group. Although often overlooked, (ESD) can potentially be a very harmful transient to
fragile data equipment. ESD occurs due to two non-conducting materials rubbing together,
causing electrons to transfer from one material to another.

The consequences of electrical surges and transients may be severe. Although the life span
of these electrical phenomenons is very short, the amount of energy that is carried can
be extremely high. A typical transient event can last from a few nanoseconds to several
milliseconds carrying several thousand volts and at least a few hundred amps of current.
These events may cause burnt-line cards, lockups, loss of memory, problems in retrieving

1Citel, Inc. 1515 NW 167th Street, Miami, FL 33169, USA, (800) 248-3548 / (305) 621-0022,
www.citelprotection.com
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data, altered data, garbling . . . etc.

B.2 Grounding

A protection system with a poor ground is the same as having no protection at all. Too
many times proper grounding has been overlooked. Recommended grounds are the utility
company ground, a ground rod, well casings, and cold water pipes that are of continuous
metal. Caution! Sometimes the metal-cold water pipes are repaired and/or extended PVC
piping. The introduction of PVC material renders the cold water pipe ground unacceptable.
A thorough investigation of a cold water pipe ground is important since the PVC repairs
or extensions may be covered by drywall.

Grounds that are unacceptable include sprinkler pipes, PVC pipe, conduit, buried wire,
and any ground that cannot be verified.

Bonding ensures the most effective ground. Bonding ties all of the grounds in the building
together electrically. If there is a rise in ground potential and all of the grounds are bonded,
no damage will occur since it is differential voltage that causes problems.

It is absolutely necessary to make sure that the ground used for the AC power is the same
as the ground used for the data-line surge protectors. A common ground reference must
be achieved for all equipment. All ground wires must be as short as possible and it is
imperative that the ground wire not be coiled or looped. The ground wire must be as
straight as possible; remember that it must be the path of least resistance. Regarding the
diameter of the ground wire, the larger the better. The larger the diameter, the better
electrical conductivity. Finally, the earth ground resistance on which the whole grounding
system relies must be less than 5 ohms.

Lines that typically need protection include incoming central office trunks, lines to off-
premise sites, local area networks and campus environments with multiple buildings. A
good rule of thumb to remember is that all lines entering or exiting a building need pro-
tection. Both ends of the cables between buildings must be protected!
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B.3 Technical Specifications – GPS Surge Suppressor, part
number AS0049000

B.3.1 Electrical Characteristics

� Designed for GPS Protection.

� Frequency Range: 1.2 - 1.6 GHz.

� Allows the passage of tuning voltage below 5 Vac or dc.

� Multi-stage circuitry using a heavy duty gas tube, toroidal inductor and capacitor.

� Response Time: Less than 1 nanosecond.

� Power Handling: 20,000 Amps (8/20 us).

� Insertion Loss: Less than 0.1 dB at 2 GHz.

� Operating Temperature: -40 to 250 F.

B.3.2 Mechanical Characteristics

� Dimensions: (H-W-D): 1 1/2” x 1 3/4” x 2 1/4”

� Finish: Natural aluminum sanding texture.

� F Type Connectors: Female/Female
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Appendix C

IRIG-B Primer

C.1 Introduction

IRIG-B can be subdivided into various forms, including modulated (analog), unmod-
ulated (CMOS/TTL/Level-Shift) and with the IEEE-1344 specification turned ON or
OFF. The Model 1133A transmits only unmodulated IRIG-B, and allows you to control
whether the IEEE 1344 extension is ON or OFF, and to set the time zone to Local or UTC.

C.1.1 Modulated and Unmodulated IRIG-B

Figure C.1 illustrates the primary differences between modulated and unmodulated
IRIG-B. You will notice that the while modulated IRIG-B is distinctive because it has
a sine wave carrier signal of 1 kHz, it is similar to unmodulated IRIG-B since the peak
values of the carrier follow the same form as the digital waveform. IRIG-B is considered
to be pulse-width modulated, in that the information is contained in the percent of time
that the analog peak-to-peak value, or TTL level, is maximum. Notice the three states
in both forms of the IRIG-B waveform (with times in parentheses): IRIG-B Reference (8
ms); IRIG Zero (2 ms); IRIG-B One (5 ms). Reference bits are also placed within each
instance that the time code is transmitted.

The IRIG-B time code consists of 74 bits produced every second, and contain various time,
date, time changes and time quality information of the time signal. Timing information is
divided into logic ones, zeros and reference bits.

There are three functional groups of bits in the IRIG-B time code, in the following order: -
Binary Coded Decimal (BCD), Control Function (CF) and Straight Binary Seconds (SBS).
The BCD group contains only time information including the (daily) hours, minutes and
seconds. The CF group contains year, time quality, leap year, pending leap seconds and
parity. The SBS consists of the total elapsed daily seconds.
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Figure C.1: IRIG-B Waveforms

C.1.2 IRIG-B Type Codes

The Model 1133AB provides IRIG-B that follows one type code: unmodulated (or de-
modulated) IRIG-B. Also, this signal type is further subdivided according to whether the
IRIG-B time code includes the IEEE 1344 extension. The Model 1133A allows you to turn
the IEEE 1344 extensions ON or OFF, the differences depicted in Table C.1.

IRIG-B Type 1344 ON 1344 OFF

Unmodulated, B00X B000 B003

Modulated, B12X B120 B123

Table C.1: IRIG-B Code Designations

C.1.3 IRIG-B IEEE 1344 Extension

As mentioned above, the IEEE 1344 enables extra bits of the Control Function (CF)
portion of the IRIG-B time code. Within this portion of the time code, bits are designated
for additional features, including:

� Calendar Year (2 digits)
� Leap seconds
� Daylight savings
� Local time offset
� Time quality
� Parity
� Position identifiers

To be able to use these extra bits of information, relays, RTU’s and other equipment
receiving the time code must be able to decode them. Consult your equipment manual to
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determine if the IEEE 1344 feature should be turned ON in the Model 1133A. To view
details of the IEEE Std 1344-1995, please check with the IEEE.

NOTE: To obtain a copy of of the IRIG-B 2004 specification, please use the link to a
copy on the Arbiter web site.

http://www.arbiter.com/catalog/timing freq index.php and click on “The complete IRIG-B
specification, PDF” located under the heading, General Timing Information.

C.2 Connecting the IRIG-B Output

The Model 1133A comes equipped with one, high drive, IRIG-B output connector using
screw terminals. Terminal connectors are compatible with twisted pair cabling, in which
the wires are stripped bare, tinned and fixed into the correct screw terminal positions. If
using a coaxial cable, you will want to transition from the two wires (coming from the back
of the 1133A) to something like a BNC connector using a BNC Breakout.1

NOTE: If using a shielded, twisted-pair cable (like Belden 8760), DO NOT connect the
cable shield at the IRIG-B connector on the Model 1133A. Always connect a cable shield
at the receiving equipment (IED) grounding point.

C.2.1 Screw Terminals

Prepare the twisted pair cable by stripping back at least 1/4 inch of the insulation and
any shielding, and tin the bare wire. Tighten the screws down on the wire. Do not ground
the shield to the Arbiter clock.

C.2.2 How Far Can I Run IRIG-B Cabling?

Some important considerations for transmitting IRIG-B over long distances are: (1)
resistive losses in cabling, (2) electromagnetic interference, (3) propagation delays and (4)
installation and maintenance costs.

Additional Information on Using IRIG-B

1. For details on distributing IRIG-B signals over long distances, see application note,
AN101, Distributing Timing Signals in a High-EMI Environment. Download the

1Model 4969 and 4970, Pomona Electronics, 9028 Evergreen Way, Everett, WA 98204, 800-490-2361,
<http://www.pomonaelectronics.com/index.php>
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file:

appnote101.pdf

2. For important considerations about IRIG-B connections, distribution of signals and
accuracy, download the file:

IRIG-B accuracy and connection requirements.pdf

http://www.arbiter.com/ftp/datasheets/.

C.2.3 Synchronizing Multiple IED’s From One Masterclock Output

In many installations, master clock signals (e.g. from the 1133A) are “fanned out” to
a number of devices. This method makes more efficient use of the clock synchronizing
capability since the clock drivers are designed to handle multiple loads. The exact number
of possible loads must be determined from the input impedance of each connected IED.
For example, if the input impedance of the IED is 5 kilohms, determine the device current
(I) drawn as follows:

(C.1) I = V/Z = 5 V olts/5000 Ohms = 0.001 Amps(1mA)

If you were to connect ten of the same IED’s to the same output, then the total current
drawn would be 10 x 0.001 A = 0.01 A (10 mA).

C.2.4 Connecting Unmodulated IRIG-B

To drive multiple loads from one clock timing output, make sure they are wired in
parallel. Some technicians might call this “Daisy-Chaining”, however the idea is
to drive all of these loads in parallel from the single output. It is much simpler
to connect loads to unmodulated IRIG-B than for modulated. This is because all of
the loads are driven at the same voltage and each draws current from the transmission line.

To determine capacity for Unmodulated IRIG-B, follow these steps:

1. determine the number of loads to be connected to a single clock output
2. determine the impedance (or resistance) of each load
3. divide the drive voltage (5 V) by the resistance of each device
4. sum up all the load currents for the total current for one clock output.
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Another method is to determine the lumped impedance of all of the connected IED’s in
parallel. Then, determine the overall current by dividing the drive voltage (5V) by the
computed lumped impedance value. This current should not exceed 250 mA.

C.2.5 Wire Losses

Another factor affecting the available voltage is the resistive losses through the cabling.
Wire has a certain resistivity associated with it that is determined by its metallic composi-
tion, and resistance determined by the diameter and length. For example, single-strand, 22
AWG (bare, enamel-coated) copper wire has a resistance of approximately 19.6 ohms per
1000 feet. To compute the loss we must include both wires in the connection, signal and
return. For coaxial cabling, the resistance of the center conductor is rated differently than
the shield. For a twisted pair, both of them should essentially have the same resistance
per cut length. If we use a twisted pair of 22 AWG (copper as above), then the available
voltage (at 100 mA of current) for 500 feet of wire would be:

(C.2) V pp available = 5.0− I(19.6 wire) = 3.09 V pp

So, you can see that we’ve lost a considerable amount of the drive voltage with 100 mA of
current and 500 feet of 22 AWG twisted pair transmission line. This level should would
most likely be detected by the decoder in most IED’s using CMOS, but not TTL. To
avoid these problems, make your cable runs as short as possible, to use larger diameter
cable, and to carefully distribute the loads.

C.2.6 Cable Delays

Electromagnetic waves travel at the speed of light (C) in free space or vacuum and a
fraction of that through cabling. To compute the speed of a wave in free space is given by
the formula in 7.6.

(C.3) C = 9.84(109) feet/second

Since electromagnetic waves travel slower through any cable, cable manufacturers normally
specify cable with a velocity factor (VF), which is a fraction of the speed of light in
free space, and characteristic of the specific cable. The Velocity Factor for the RG-6
cabling used by Arbiter Systems for GPS antenna connections, is about 83% of C. Most
transmission lines have velocity factors in the range of 65% to 97%. Using these values
you can determine the actual time delay in your cable distribution system and compare
it to your required accuracy. As an example, it would take 840 feet of RG-6 cable (with
a velocity factor of 83%) to delay the signal by one microsecond. For IRIG-B timing
applications, these delays may not be important, compared to other criteria. Otherwise,
you would be forced to compensate for the time delay using another method, such as
advancing the timing output or placing another masterclock at the remote site.
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C.2.7 Solutions

There are many solutions to providing an accurate timing signal in distant locations.
However, the most satisfying solution may not be to string cabling for hundreds of meters.
The costs associated with installing and maintaining cabling over a wide area may be
unsatisfactory. Since the GPS is so pervasive, it may prove to be less costly to install
another clock at a distant location, which would also improve accuracy and provide
redundancy. Before installing cabling over a wide area, be sure to first examine all the
possibilities.
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